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快速上手手冊: WP-8147/8447/8847 

WinPAC-8xx7 或 WP-8x47 為 WP-8147/8447/8847 的簡稱。 
  

重要說明 

1. WP-8x47 的插槽 0 ~ 7 只支援高卡的 I-8K 與 I-87K I/O 模組。 請參考網頁: 

http://www.icpdas.com/en/product/guide+Remote__I_O__Module__and__Unit+Software__Support
__+I-8K_I-87K__Software__Support  

2. WP-8x47 需設定為固定 IP 位址。(不可使用 DHCP) 

3. 如果不使用 WP-8x47 的 LAN2，需將 LAN2 設定為 Disable (請參考附錄 D) 。 

4. 建議使用工業級乙太網路交換器來連接 PAC。 

5. 請將開發好的 .net 程式 與 資料檔存放在  \Micro_SD 內，而不要存放在 \System_Disk 內。因為 

\System_Disk 使用的是 NOR Flash 記憶體，它主要是給 OS、ISaGRAF Driver 與一些必要的 Utility  

與 DLL 存放使用，容量不大。 

 

請勿常常去更新 NOR Flash 記憶體的資料，久了容易損壞。若常常在 \System_Disk 內更新檔案  

(例如: 每 1 ~ 5 秒就更新一次，一天下來就更新了約幾萬次)，資料會容易受損。所以自行開發的

程式與要操作的檔案，最好都存放在 \Micro_SD 內。 

 

免責聲明 

泓格科技股份有限公司，對於因使用本系列產品所造成的任何損害並不負任何法律上的責任。 

本公司保留在任何時候修訂本書而不需通知的權利，並將確實地提供正確且可靠的資訊。泓格科技

股份有限公司無義務對任何因非法、不當使用，而導致的第三方侵權行為承擔任何法律責任。  

 

商標 與 著作權 

本書所提所有公司商標，商標名稱及產品名稱分別屬於該商標或名稱的擁有者所有。 

 

開發軟體 

兩種選項: 

1) ISaGRAF: 3.4x 或 3.5x 版，符合 IEC 61131-3 標準。LD，ST，FBD，SFC，IL 與 FC。 

2) 非 ISaGRAF: Microsoft EVC++4.0 或 VS.NET 2008/2005/2003 (VB.net，C#.net) 。 

 

ISaGRAF 網頁: https://www.icpdas.com/en/product/guide+Software+Development__Tools+ISaGRAF 

ISaGRAF 下載中心: 

https://www.icpdas.com/en/download/index.php?nation=US&kind1=&model=&kw=isagraf 

http://www.icpdas.com/en/product/guide+Remote__I_O__Module__and__Unit+Software__Support__+I-8K_I-87K__Software__Support
http://www.icpdas.com/en/product/guide+Remote__I_O__Module__and__Unit+Software__Support__+I-8K_I-87K__Software__Support
https://www.icpdas.com/en/product/guide+Software+Development__Tools+ISaGRAF
https://www.icpdas.com/en/download/index.php?nation=US&kind1=&model=&kw=isagraf
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技術支援 

請連絡當地的經銷商或 E-mail 問題至 service@icpdas.com 。 

更多關於產品的訊息可至 www.icpdas.com 取得。 

ISaGRAF FAQ : https://www.icpdas.com/en/faq/index.php?kind=280#751 

  
 

著作者: Chun Tsai    編譯者: Janice Hong / Eva Li   

版權所有泓格科技股份有限公司，2009 年 7 月起，保留所有權利。  

 
 

改版紀錄 

下表顯示了修改歷程: 

版本號 發行日期 編輯者 說明 

V2.0 Oct. 2020 Janice 

 更新新網站連結、部分圖片 

 取消 FTP 連結、光碟路徑 

 調整版面、字型 與 改寫語句 

 附錄 I.3 變更適用的串列 (Serial) 觸控驅動程式 

 

mailto:service@icpdas.com
http://www.icpdas.com/home.htm
https://www.icpdas.com/en/faq/index.php?kind=280#751
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參  考  資  料 

ISaGRAF 網路資源: 

ISaGRAF 新發佈的檔案 (例如: I/O library、PAC Driver、Demo 與 文件)，皆可在此網頁找到: 

https://www.icpdas.com/en/download/index.php?nation=US&kind1=&model=&kw=isagraf 
 

ISaGRAF (進階) 使用手冊: 

https://www.icpdas.com/en/download/show.php?num=333  
 

ISaGRAF FAQ:  

https://www.icpdas.com/en/faq/index.php?kind=280#751 
  

WP-8000 (硬體) 手冊: 

https://www.icpdas.com/en/download/show.php?num=461 

 
 

相關產品： 
 

 工業用乙太網路交換器:  

http://www.icpdas.com/en/product/guide+Industrial__Communication+Ethernet__Communication+
Ethernet__Switch 

 

 RS-232 轉 RS-422/485 轉換器 :  

http://www.icpdas.com/en/product/guide+Industrial__Communication+Serial__Communication+
Converter 
 

 電源供應器:  

http://www.icpdas.com/en/product/guide+Accessories+Power__Supplies+Power__Supply 
 

 I-8K/87K 系列 I/O 高卡 

http://www.icpdas.com/en/product/guide+Remote__I_O__Module__and__Unit+PAC__%EF%BC%86
amp;__Local__I_O__Modules+I-8K_I-87K__Series__(High__Profile) 

 

 

 
 

https://www.icpdas.com/en/download/index.php?nation=US&kind1=&model=&kw=isagraf
https://www.icpdas.com/en/download/show.php?num=333
https://www.icpdas.com/en/faq/index.php?kind=280#751
https://www.icpdas.com/en/download/show.php?num=461
http://www.icpdas.com/en/product/guide+Industrial__Communication+Ethernet__Communication+Ethernet__Switch
http://www.icpdas.com/en/product/guide+Industrial__Communication+Ethernet__Communication+Ethernet__Switch
http://www.icpdas.com/en/product/guide+Industrial__Communication+Serial__Communication+Converter
http://www.icpdas.com/en/product/guide+Industrial__Communication+Serial__Communication+Converter
http://www.icpdas.com/en/product/guide+Accessories+Power__Supplies+Power__Supply
http://www.icpdas.com/en/product/guide+Remote__I_O__Module__and__Unit+PAC__%EF%BC%86amp;__Local__I_O__Modules+I-8K_I-87K__Series__(High__Profile)
http://www.icpdas.com/en/product/guide+Remote__I_O__Module__and__Unit+PAC__%EF%BC%86amp;__Local__I_O__Modules+I-8K_I-87K__Series__(High__Profile)
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I/O 模組選型 

WP-8x47 支援 I-8K/I-87K 高卡 I/O 模組 及 RS-485/FRnet 遠端 I/O 模組，請參考  ICP DAS 網站: 

 
 
 
 
 
 
 
http://www.icpdas.com/en/product/guide+Remote__I_O__Module__and__Unit+Software__Support__
+I-8K_I-87K__Software__Support 
 

 
 
 
 
 
 
 
 
 
  

 
 

www.icpdas.com 

http://www.icpdas.com/en/product/guide+Remote__I_O__Module__and__Unit+Software__Support__+I-8K_I-87K__Software__Support
http://www.icpdas.com/en/product/guide+Remote__I_O__Module__and__Unit+Software__Support__+I-8K_I-87K__Software__Support
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規格: WP-8147/8447/8847 
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您也可查看 WP-8x47 Data Sheet: http://www.icpdas.com/en/download/show.php?num=2919 

http://www.icpdas.com/en/download/show.php?num=2919
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第 1 章 典型的工程應用 

1.1 通訊備援 (冗餘) 系統 – 中央與地區控制站 

 可採用 RS-485 或 Ethernet 通訊備援機制與應用。 

 適用型號: XP-8x37-CE6 與 WP-8x47。 

 更多資訊: https://www.icpdas.com/en/faq/index.php?kind=280#751 > FAQ-119。 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
 
 

WinPAC 

https://www.icpdas.com/en/faq/index.php?kind=280#751
http://www.icpdas.com/web/product/download/software/development_tool/isagraf/document/faq/faq119_chinese.pdf
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1.2 備援 (冗餘) 系統 - 搭配 Ethernet I/O 

 若其中一個乙太網路斷線或損毀，備援 (冗餘)  PAC 將會使用另一條網路來處理網路 (Ethernet) 

I/O 與資料交換。 

 掃描 Ethernet I/O 比掃描 RS-485 遠程 I-7000 或 I-87K I/O 更加快速。 

 適用型號: XP-8x37-CE6 與 WP-8x47。 

 更多資訊:  https://www.icpdas.com/en/faq/index.php?kind=280#751 > FAQ-093。 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

https://www.icpdas.com/en/faq/index.php?kind=280#751
http://www.icpdas.com/web/product/download/software/development_tool/isagraf/document/faq/faq093_chinese.pdf
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1.3 備援 (冗餘) 系統 – 搭配 RS-485 I/O 

 若 WP-8x47 的其中一個網路損毀，另一個仍會維持運作。 

 若其中一台 PAC 當機，另一台會接手來控制 RS-485 I/O。 

 PC/HMI 可透過 1 或 2 個 Active IP 來連接此備援 (冗餘) 系統。 

 適用型號: XP-8x37-CE6 與 WP-8x47。 

 更多資訊: 

https://www.icpdas.com/en/faq/index.php?kind=280#751 > FAQ-093、FAQ-125、FAQ-138  

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

https://www.icpdas.com/en/faq/index.php?kind=280#751
http://www.icpdas.com/web/product/download/software/development_tool/isagraf/document/faq/faq093_chinese.pdf
http://www.icpdas.com/web/product/download/software/development_tool/isagraf/document/faq/faq125_chinese.pdf
http://www.icpdas.com/web/product/download/software/development_tool/isagraf/document/faq/faq138_chinese.pdf
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1.4 Modbus Master: RTU, ASCII, RS-232/485/422 

 最多可支援 10 個埠 :  

COM1 ~ COM4 及 COM5 ~ COM14 (若 I-8112iW/ 14W/ 14iW/ 42iW/ 44iW 插於擴充槽 0 ~ 2) 

 可連接到 Modbus PLC 或 M-7000 I/O 或 Modbus 設備 (電力量測器，溫度 PAC ，變頻器…) 

 
 

 
 
 
 
 
 
 
 

 
 
 
 
 

1.5 Modbus Master: TCP/IP 

 每台 WP-8x47 最多可以連接 100 個 Modbus TCP/IP Slave 設備。 

 可連接各類有支持標準 Modbus TCP/IP Slave 通訊協議的設備。 

 更多資訊: https://www.icpdas.com/en/faq/index.php?kind=280#751 > FAQ-113。  
 
 

 
 
 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

https://www.icpdas.com/en/faq/index.php?kind=280#751
http://www.icpdas.com/web/product/download/software/development_tool/isagraf/document/faq/faq113_chinese.pdf
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1.6 Modbus Slave: RTU/TCP  

 Modbus RTU (RS-232/485/422) Slave: 最多可連接 5 個埠 

 Modbus TCP/IP Slave: 最多可支援 32 個連線 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

1.7 與其他 TCP/IP Server 或 UDP Client/Server 設備通訊 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 



快速上手手冊: WP-8147/8447/8847, 2020 年 10 月, 2.0 版                       1-6 

1.8 多重網路人機介面 (Web HMI) – 隨處監控! 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

1.9 傳送攜帶附件檔案的 Email 

 更多資訊:  https://www.icpdas.com/en/faq/index.php?kind=280#751 > FAQ-067 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

https://www.icpdas.com/en/faq/index.php?kind=280#751
http://www.icpdas.com/web/product/download/software/development_tool/isagraf/document/faq/faq067_chinese.pdf
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1.10 資料記錄器 

 
 
 
 
 
 
 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 

1.11 遠程 I/O 應用 

 更多資訊: https://www.icpdas.com/en/faq/index.php?kind=280#751 > FAQ-001、FAQ-050。  

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

藉由 ftp 或 Web HMI 來載入儲存於 WP-8xx7 的 

 Flash Disk 或 microSD 卡 的資料檔案. 

https://www.icpdas.com/en/faq/index.php?kind=280#751
http://www.icpdas.com/web/product/download/software/development_tool/isagraf/document/faq/faq001_chinese.pdf
http://www.icpdas.com/web/product/download/software/development_tool/isagraf/document/faq/faq050_chinese.pdf
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1.12 SMS: 簡訊服務 

 可傳送各國文字 (如: 中文，英文...或其他) 或 傳送/接收純文字 (pure text) 

 更多資訊: https://www.icpdas.com/en/faq/index.php?kind=280#751 > FAQ-111 

 
 
 
 
 
 
 
 
 
 
 
 

 
 
 

 

1.13 當成遠程 I/O 模組的 Modbus 轉換器 

 有 Ethernet port 的 ISaGRAF PAC: 

可用來當成遠程 I/O 模組的 Modbus RTU 與 Modbus TCP/IP 通訊協定轉換器。 

 

 無 Ethernet port 的 ISaGRAF PAC: 

可用來當成遠程 I/O 模組的 Modbus RTU 通訊協定轉換器。 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 

https://www.icpdas.com/en/faq/index.php?kind=280#751
http://www.icpdas.com/web/product/download/software/development_tool/isagraf/document/faq/faq111_chinese.pdf
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1.14 運動控制 

 1 個 I-8091W 可控制 2 軸: X-Y 軸，或 2 軸獨立 

 2 個 I-8091W 可控制 4 軸: X-Y 軸 + 2 軸獨立，或 4 軸獨立 

 Encoder 模組:    

I-8084W: 4-axis，不支持 Z-index 

I-8090W: 3-axis 
I-8093W: 3-axis 

 
 
 
 
 
 
 
 
 
 
 
 
 

1.15 建物應力量測應用 

更多資訊: https://www.icpdas.com/en/faq/index.php?kind=280#751 > FAQ-091、FAQ-128 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
 

https://www.icpdas.com/en/faq/index.php?kind=280#751
http://www.icpdas.com/web/product/download/software/development_tool/isagraf/document/faq/faq091_chinese.pdf
http://www.icpdas.com/web/product/download/software/development_tool/isagraf/document/faq/faq128_chinese.pdf
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1.16 快速 FRnet 遠程 I/O 

 FRnet I/O 的優點: I/O 掃描快速，只需約 3 ms/scan (需依據程式的 PLC 掃描時間，例: 當 ISaGRAF 

PLC 程式的掃瞄時間約為 9 ms 時，則所有的掃描時間是 9 ms，而不是 3 ms。) 

 FRnet I/O 有支援 DI，DO，AI 與 AO 模組。 

 更多資訊: https://www.icpdas.com/en/faq/index.php?kind=280#751 > FAQ-082、FAQ-154 

  
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

1.17 整合 CAN/CANopen 設備與傳感器 

 WP-8x47 最多可支援 10 台 I-7530 (RS-232 轉 CAN 轉換器) (FAQ-086) 

 另外也有支持 I-8123W CANopen master 卡片請參訪 FAQ-145 

 更多資訊: https://www.icpdas.com/en/faq/index.php?kind=280#751 > FAQ-086、FAQ-145 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

https://www.icpdas.com/en/faq/index.php?kind=280#751
http://www.icpdas.com/web/product/download/software/development_tool/isagraf/document/faq/faq082_chinese.pdf
http://www.icpdas.com/web/product/download/software/development_tool/isagraf/document/faq/faq154_chinese.pdf
https://www.icpdas.com/en/faq/index.php?kind=280#751
http://www.icpdas.com/web/product/download/software/development_tool/isagraf/document/faq/faq086_chinese.pdf
http://www.icpdas.com/web/product/download/software/development_tool/isagraf/document/faq/faq145_chinese.pdf
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1.18 VIP 通訊安全 

 可為 Modbus TCP/IP 作安全設定 (VIP: Very Important IP) 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

1.19 ISaGRAF PAC 連接智能電表 

 支援 Modbus 標準通訊協定，應用彈性大，可開多個 RS-485 通訊埠來連接多台 PM-213x 智能

電表。 

 PM-213x 系列為一輕薄短小之三相 (單相) 功能性智慧電表，具備基本電力參數量測、監測及 

通訊功能，與 ISaGRAF PAC 搭配，可應用於各種需求智慧型電力量測的監控系統。 

 更多資訊: https://www.icpdas.com/en/faq/index.php?kind=280#751 > FAQ-129 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

https://www.icpdas.com/en/faq/index.php?kind=280#751
http://www.icpdas.com/web/product/download/software/development_tool/isagraf/document/faq/faq129_chinese.pdf
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1.20 ZigBee 無線通訊應用 

 ISaGRAF PAC 加上 ZT-2550  與 ZT-2551 這兩個無線通訊 轉 RS-232/RS-485 Converter 可以無線 

傳輸，降低佈線成本並可達到遠距離控制 I/O 模組或進行資料收集的目地。 

 更多資訊: https://www.icpdas.com/en/faq/index.php?kind=280#751 > FAQ-110  

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

https://www.icpdas.com/en/faq/index.php?kind=280#751
http://www.icpdas.com/web/product/download/software/development_tool/isagraf/document/faq/faq110_chinese.pdf
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1.21 GPS 應用: ISaGRAF PAC 加上 I-87211W 或 GPS-721 

 WP-8x47、iP-8x47 與 μPAC-7186EG 可支援一個裝在插槽 0 ~ 7 的 I-87211W 模組，或是一個採用 

RS-485 遠程 I/O 的 I-87211W 或 GPS-721 GPS 模組。  

 可用於 自動對時 與 取得當地的經緯度座標。 

 更多資訊: https://www.icpdas.com/en/faq/index.php?kind=280#751 > FAQ-107 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

https://www.icpdas.com/en/faq/index.php?kind=280#751
http://www.icpdas.com/web/product/download/software/development_tool/isagraf/document/faq/faq107_chinese.pdf
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1.22 透過 Ebus 交換資料 

 Ebus (Ethernet 網路) 

每台 ISaGRAF PAC 可使用它的乙太網路連接埠，並透過 Ebus 通訊機制來相互交換資料。當 PC 

藉由乙太網路與 PAC 對話時， PAC 也可以經由同一乙太網路與其他的 PAC 交換資料； 

此方式使得配置更加地靈活與快速。 

 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

1.23 偵測 I-87K 高卡 I/O 之熱插拔 (Hot-Swap) 狀況 

 在 ISaGRAF Workbench 軟體中，您必需正確地將 I/O 卡連結到 "I/O connection" 視窗並選用 

"io_state" 卡來即時的觀察 I/O 的狀態。當您熱插拔 I-87K (高卡) I/O 時，將有訊息顯示在 

ISaGRAF PAC 的控制面板上。 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

http://www.icpdas.com/products/PAC/common_file/application-notes-c.htm#ap-f_ebus
http://www.icpdas.com/products/PAC/common_file/application-notes-c.htm#ap-f_ebus
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1.24 資料庫應用 

 支援 SQL Client 功能可以連接後台的 Microsoft SQL Server (2000 SP3，2005，2008 或相容版本) 來

進行資料的寫入或讀取。 

 一台 PAC  (PAC) 最多可連接 4 台 Server。 

 依據不同的型號， PAC 可支援多國語言，包含: 繁體中文(台灣)、簡體中文、英文、法文、 

德文、義大利文、葡萄牙語、俄語、西班牙語 與其它語言。 

 整合 機械 - 商務 自動化應用，跨越工業與商用領域。 

 更多資訊: https://www.icpdas.com/en/faq/index.php?kind=280#751 > FAQ-135 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

http://www.icpdas.com/products/PAC/common_file/application-notes-c.htm#ap-f_ebus
https://www.icpdas.com/en/faq/index.php?kind=280#751
http://www.icpdas.com/web/product/download/software/development_tool/isagraf/document/faq/faq135_chinese.pdf
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1.25 HART 解決方案 

 ISaGRAF PAC 可支援 I-87H17W 模組來與其他 HART 設備通訊。 

(Driver 版本 - WP-8x47: 1.35 起) 

 ISaGRAF PAC 支援 I-87H17W 插在 PAC 上的 I/O 插槽 (WP-8x47: 插槽 0 ~ 7) ，但不支援 I-87H17W 

插在 RS-485 遠程 I/O 擴充單元上。 

 I-87H17W 有 8 個 AI 通道，可量測 4 ~ 20 mA，也可當成 8-ch 的 HART 通訊串口。 

 更多資訊: https://www.icpdas.com/en/faq/index.php?kind=280#751 > FAQ-136 
 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

https://www.icpdas.com/en/faq/index.php?kind=280#751
http://www.icpdas.com/web/product/download/software/development_tool/isagraf/document/faq/faq136_chinese.pdf
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1.26 3G/4G 無線傳輸應用 

 XP-8x37-CE6 與 WP-8x47 搭配 3G/4G 無線傳輸數據機，可與遠端的 Server 進行資料傳輸應用。 

 更多資訊: https://www.icpdas.com/en/faq/index.php?kind=280#751 > FAQ-143、151、153 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

1.27 連接 DL-100TM485 測量濕度與溫度值 

 更多資訊: https://www.icpdas.com/en/faq/index.php?kind=280#751 > FAQ-156 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

https://www.icpdas.com/en/faq/index.php?kind=280#751
http://www.icpdas.com/web/product/download/software/development_tool/isagraf/document/faq/faq143_chinese.pdf
http://www.icpdas.com/web/product/download/software/development_tool/isagraf/document/faq/faq151_chinese.pdf
http://www.icpdas.com/web/product/download/software/development_tool/isagraf/document/faq/faq153_chinese.pdf
https://www.icpdas.com/en/faq/index.php?kind=280#751
http://www.icpdas.com/web/product/download/software/development_tool/isagraf/document/faq/faq156_chinese.pdf
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第 2 章 軟體安裝 

2.1 步驟 1 – 安裝 ISaGRAF 

使用者需安裝以下兩種軟體，才能進行 ISaGRAF 控制系統的程式設計 。 

http://www.icpdas.com/en/download/show.php?num=368 
 

 A. ISaGRAF Workbench 
 B. ICP DAS Utilities For ISaGRAF 

 

使用者需至少購買一套 ISaGRAF Workbench (ISaGRAF-256 版本 3.4x 或 3.5x ) 並安裝在 PC 上，才能 

進行 ISaGRAF 程式編輯、下載、監看 及 除錯。 

 

軟體需求: 

在安裝 ISaGRAF 作業平台前，您必需先安裝以下任何一種作業系統: 

 
 Windows 95 / Windows 98 / Windows 2000 

 Windows NT Version 3.51 或 Windows NT Version 4.0  

 Windows XP 或 Vista 或 Windows 7 上的 XP Mode (請參考 FAQ-117) 

 

安裝 ISaGRAF 作業平台 

若您使用 Windows Vista 或 Windows 7 (32-bit) 作業系統，請先參考章節 2.1.4。 

若您使用 Windows 7 (64-bit) 作業系統，請先參考章節 2.1.5。 

 
 

自 2020 年起，ICP DAS 不再提供 ISaGRAF Workbench 出貨光碟。請於  ISaGRAF 下載中心 來下載 

軟體並解壓縮 zip 檔。滑鼠雙擊  "ISaGRAF.exe" 來開始安裝程序。   

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

請選擇需安裝的語言。 (建議使用英文版) 

http://www.icpdas.com/en/download/show.php?num=368
http://www.icpdas.com/web/product/download/software/development_tool/isagraf/document/faq/faq117_chinese.pdf
https://www.icpdas.com/en/download/index.php?nation=US&kind1=&model=&kw=isagraf
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安裝完成後, 請點選左下角的 [開始] > [程式集] > [ISaGRAF 3.5] > [Project] 可開啟 ISaGRAF。 

 
 
 
 
 
 
 
 

 
 

2.1.1 保護鎖注意事項: 

您必需安裝 ISaGRAF 軟體所提供的硬體保護鎖 (Dongle: 安裝於電腦的並列埠) 或 USB 保護鎖 

(ISaGRAF 3.51 版起使用)，才能使用 ISaGRAF 所有的功能。請執行 ISaGRAF 的 [Help] > [About] 查看

安裝是否正確，若出現 “Maximum number of IO variables: 32” 表示 ISaGRAF 無法找到保護鎖， 

請確認安裝正確，然後將電腦重新開機，再查看一次。 

 
 

 
 
 
 
 
 
 
 
 
 
 
 

如果仍然出現 “Maximum number of IO variables: 32”，表示保護鎖的驅動程式未安裝成功，請依 

保護鎖型態執行下列步驟。 

 

Dongle 型保護鎖: 

請執行下列驅動程式 (位於 ISaGRAF 安裝目錄)，然後將電腦重新開機:  

 ISaGRAF-80 版本:   \Sentinel5382\setup.exe  

 其他 ISaGRAF 版本:  \Sentinel\setup.exe 

 

USB 型保護鎖: 

1. 安裝 ISaGRAF 軟體後，請先暫時取下 USB 保護鎖，執行 ISaGRAF 安裝目錄裡的 “\Sentinel\ 

SSD5411-32bit.exe” 程式，然後重新開機。 

2. 之後, 執行 ISaGRAF 時, 皆需插上 USB 保護鎖。 

1. 

2. 
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2.1.2 Window 2000 使用者的注意事項: 

如果您在關閉某些 ISaGRAF 視窗時, 出現停滯 20 ~ 40 秒 (沒有反應) 的現象。可能是 Windows 2000 

裡 “CTFMON.EXE” 程式的關係。可先同時按住鍵盤 “Ctrl + Alt + Del” 結束 “CTFMON.EXE” 的處理 

程序，接著為 “ISaGRAF project manager” 建立一個捷徑，並在 “Shortcut” 的設定頁籤中選取  

“Run in separate memory space” 的選項設定。 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

2.1.3 Windows NT 使用者的注意事項: 

在 Windows NT 作業系統下，為了讓 RS-232 通訊能正常運作，必需要在 ISaGRAF 安裝目錄下  

(例如: C:\ISAWIN\EXE\) 找到 “isa.ini” 檔案，並加入一行 “NT=1” 。 
 

可使用任何 ASCII 文字編輯器 (例如 Notepad 或 UltraEdit32 ) 來開啟 “isa.ini”， 找到 [WS001] 標頭  

(應該在檔案的最上方)，在其中加入 ”NT=1” 這行敘述。 

 
[WS001] 
NT=1 
Isa=C: \ISAWIN 
IsaExe=C: \ISAWIN\EXE 
Group=Samples 
IsaApl=c: \isawin\smp 
IsaTmp=C: \ISAWIN\TMP 

 

2. 

 

1. 
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2.1.4 Windows Vista 或 Windows 7 (32-bit) 使用者的注意事項: 

安裝 ISaGRAF 軟體之前，若您使用的是 Windows Vista 或 Windows 7 (32-bit) 作業系統，為了避免 

部分安裝的限制，請先變更使用者帳戶控制設定。 

 

如何關閉使用者帳戶控制? 

 

此設定需具備系統管理員的權限。 

 

1. 請於 [開始] > [控制台] > [使用者帳戶和家庭安全] > [使用者帳戶] > 點選 [開啟或關閉使用者帳戶

控制] 或 [變更使用者帳戶控制設定]。 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

2. 點選後，將出現以下的畫面。 
 

Windows Vista: 

畫面中標示的地方不要打勾，最後點選 “確定” 按鈕。 
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Windows 7: 

將畫面中的橫桿移至 “不要通知”，最後點選 “確定” 按鈕。 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

3. 請重新啟動電腦。 

4. 電腦重新開機後，請參考 章節 2.1 安裝 ISaGRAF 軟體。 
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2.1.5 Windows (64-bit) 使用者的注意事項: 

由於 ISaGRAF Workbench 必需安裝/執行於 Windows 32 位元的作業系統中，因此您可使用以下 

兩種方式來為 ISaGRAF Workbench 3.55 建立合適的安裝環境。若您選用 XP Mode 的方式，僅可 

安裝在 Windows 7 (64-bit) Professional/ Enterprise/Ultimate 的作業系統。若選用 VMware 

Workstation/Player 的方式，則可安裝在任何 Windows 64 位元的作業系統中 (例如: Windows 7/ 

Windows 8) 。 

 

使用 Virtual PC 和 XP Mode: 

1. 請從 Windows Virtual PC 網站 (http://go.microsoft.com/fwlink/?LinkID=160479) 下載 Windows 

Virtual PC 與 Windows XP Mode 的安裝程式。 

2. 滑鼠雙擊 “WindowsXPMode_nn-NN.exe” (此處的 nn-NN 代表語言環境，例如 en-US)，並依照 

安裝精靈的導引完成 Windows XP Mode 安裝。 

3. 滑鼠雙擊 “Windows6.1-KB958559-x64.msu” 安裝 Windows Virtual PC。 

4. 重新啟動電腦。 

5. 請依序點選電腦 [開始] > [所有程式] > [Windows Virtual PC]，開啟 [Windows XP Mode]。 

6. 依照導引精靈完成 Windows XP Mode 的設定。 

注意: 請務必記住安裝過程中提供的密碼，此密碼用來登入虛擬機器。 

7. 請回到 章節 2.1 來安裝 ISaGRAF。  

 

使用 VMware Workstation/Player: 

1. 使用者可在 VMware 網站，下載並安裝 VMware Workstation 10.0 試用版。 

https://my.vmware.com/web/vmware/info/slug/desktop_end_user_computing/vmware_workstation/10_0 

2. 建立虛擬機並安裝 Windows (32-bit) 作業系統。 

3. 於虛擬機中安裝 ISaGRAF Workbench 3.55。 

4. 於虛擬機中安裝 ISaGRAF I/O Library。 

5. 設置虛擬機的相關設定。 

6. 安裝 USB Dongle 驅動程式於虛擬機中。 

詳情請見 https://www.icpdas.com/en/faq/index.php?kind=280#751 > FAQ-174 

 
 
 

2.1.6 使用變數陣列 (Variable Arrays) 的注意事項: 

使用變數陣列必需在 c:\isawin\exe\isa.ini 檔案的最前端，加入此兩行程式碼: 

 
[DEBUG] 
Arrays=1 

 
 

 

http://go.microsoft.com/fwlink/?LinkID=160479
http://go.microsoft.com/fwlink/?LinkID=160479
https://my.vmware.com/web/vmware/info/slug/desktop_end_user_computing/vmware_workstation/10_0
https://www.icpdas.com/en/faq/index.php?kind=280#751
http://www.icpdas.com/web/product/download/software/development_tool/isagraf/document/faq/faq174_chinese.pdf
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2.2 步驟 2 – 安裝 ICP DAS Utilities For ISaGRAF 

請參訪 ISaGRAF 網頁來下載最新版的 "ICP DAS Utilities For ISaGRAF" (io_lib.zip) 。 

http://www.icpdas.com/en/download/show.php?num=368 
   

“ICP DAS Utilities For ISaGRAF” 包含 3 個主要項目:  

 I/O libraries (適用所有 ISaGRAF PAC) 

 Modem_Link utility   
 Auto-scan I/O utility  

 

注意: 

安裝 "ICP DAS Utilities for ISaGRAF" 前，請確認已安裝 ISaGRAF Workbench (請參考 2.1: 步驟 1) 。 

 
 

請執行 setup.exe 並依照安裝精靈的指示，來安裝 ISaGRAF Utilities。 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

http://www.icpdas.com/en/download/show.php?num=368
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第 3 章 安裝 Web HMI 範例程式 

注意: 

1. WP-8x47 需設定為固定 IP 位址。 (不可使用 DHCP) 

2. 如果不使用 WP-8x47 的 LAN2，需將 LAN2 設定為 Disable。 

 

3.1 Web HMI 範例程式列表 

請參訪 ISaGRAF Demo 網頁來下載範例程式。 

http://www.icpdas.com/en/download/show.php?num=1005 
 

範例程式表: 

 

程式名稱 說明 搭配使用的 I/O 模組 

sample Web HMI 範例 無需搭配 I/O 模組 

example1 第 4 章的範例 插槽 0: I-87055W 

wphmi_01 顯示 PAC 的日期與時間 無需搭配 I/O 模組 

wphmi_02 DI 與 DO 範例 插槽 0: I-87055W 

wphmi_03 讀/寫 Long、Float 與 Timer 值 無需搭配 I/O 模組 

wphmi_04 讀/寫 PAC 的字串 (String) 無需搭配 I/O 模組 

wphmi_05 多頁範例: 頁面選單在左方 插槽 0: I-87055W 

wphmi_05a 多頁範例: 頁面選單在上方 插槽 0: I-87055W 

wphmi_06 AI/AO 範例，於 ISaGRAF 的轉換 
插槽 2: I-87024W 

插槽 3: I-8017HW 

wphmi_07 AI/AO 範例，於 PC 的轉換 
插槽 2: I-87024W 

插槽 3: I-8017HW 

wphmi_08 下載 PAC 裡的檔案到 PC  插槽 0: I-87055W 

wphmi_09 於 PC 彈出警報視窗 插槽 0: I-87055W 

wphmi_11 趨勢圖 
插槽 2: I-87024W 

插槽 3: I-8017HW 

wphmi_12 
每隔 50 ms 記錄 I-8017HW 通道 1 ~ 8 的電壓， 

並以微軟 Excel 軟體繪出趨勢圖 

插槽 3: I-8017HW 

插槽 2: I-8024W 

wphmi_13 
每隔 10 ms 記錄 I-8017HW 通道 1 ~ 4 的電壓， 

並以微軟 Excel 軟體繪出趨勢圖 

插槽 3: I-8017HW 

插槽 2: I-8024W 

 
 
 

http://www.icpdas.com/en/download/show.php?num=1005
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3.2 安裝 Web HMI 範例程式的步驟 

3.2.1 步驟 1 – 硬體安裝 

 

A. 請準備一台 WP-8147/8447/8847 PAC，並在插槽 0 插上 I-87055W 模組。 

如果您沒有 I-87055W (8 輸入及 8 輸出的模組)，請使用範例檔 “wphmi_01”，而非 “wphmi_05”，

並依同樣步驟設定。 

 

B. 準備一個 VGA 螢幕、USB 滑鼠 與 乙太網路線，並連接到 WP-8x47。  

(此外，您可使用 PAC 畫面右下方的軟體鍵盤) 

 

C. 啟動 WP-8x47。 

 
 

3.2.2 步驟 2 – 設定網路選項 

 

A. 請參考 附錄 A.3 為 WinPAC 設定一組 固定 IP。 (不可使用 DHCP) 

 

B. 執行 ISaGRAF Driver，勾選 “Web” 頁面的 “Enable Web HMI” 選項，再點選 “Setting” 按鈕。接著，

勾選 “Enable Account Security” 選項，並點選 “Edit” 來設定使用帳號/密碼，再點選 “OK” 離開。 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

注意:   

若沒有勾選 “Enable Account Security”，任何使用者都能輕易地透過網際網路操控您的 PAC ! 

 

1. 

2. 

3. 4. 
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3.2.3 步驟 3 – 下載 ISaGRAF 專案  

若您熟知如何將 “wphmi_05.pia” 回存到 ISaGRAF Workbench 與 如何將專案下載到 PAC，請直接跳到 

3.2.4 節。若不熟悉，進行下列步驟之前，請確認電腦已裝好 ISaGRAF Workbench。( 2.1 & 2.2 節) 

 

請參訪 ISaGRAF Demo 網頁來下載範例程式  (…\isagraf_winpac_demo\wphmi_05) 。 

http://www.icpdas.com/en/download/show.php?num=1005 
 

“wphmi_05” 範例需搭配一個 I-87055W (8 輸入及 8 輸出) I/O 模組。若您沒有 I-87055W，請下載 

“wphmi_01” (…\isagraf_winpac_demo\wphmi_01.pia) 。 

 
 

備份與回存 ISaGRAF 專案的步驟 : 

為了保存檔案，使用者可備份或回存 ISaGRAF 專案。例如: 您可能需要他人來測試專案，或是將 

專案 email 到 service@icpdas.com 尋求技術支持。 

 
 

備份 ISaGRAF 專案 

1. 開啟 “ISaGRAF Project Management” 視窗，滑鼠點選 [Tools]  [Archive]  [Projects]。 

2. 在 [Archive-Projects] 視窗，點選 “Browse” 指定要存放備份專案的目錄位置 (例如: ‘C:\Demo’) 。  

若想減少檔案大小，也可勾選 Compress 選項。 

3. 在  “Workbench” 區，選取要備份的專案名稱。 

4. 點選 “Backup” 即可將檔案備份到指定的目錄位置 (例如: C:\Demo\example1.pia) 。 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

 

 

 

檔案備份位置 

選取欲備份檔案 

勾選以壓縮檔案 

3. 

4. 

2. 

1. 

http://www.icpdas.com/en/download/show.php?num=1005
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回存 ISaGRAF 專案 

請依照上述方式開啟 “Archive Projects” 視窗，並從備份位置中回存 ISaGRAF 專案。  

 

1. 在  “Archive” 區，選取要回存的專案名稱。 

2. 點選 Restore 將專案回存到 ISaGRAF 軟體內。 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

下載 ISaGRAF 專案到 PAC 的步驟 

滑鼠雙擊 “wphmi_05” 以開啟專案，然後點選 “Link setup” 按鈕。 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

1. 
2. 
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點選 “Setup” 並輸入 PAC 的 IP 位址，“Port number” 固定設為 502。 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

請點選 “Debug” 按鈕來下載 “wphmi_05” 專案到 WP-8x47。若有其他程式在 PAC 運行中，請先點選 

“Stop application ” 按鈕停止原先的程式。再點選 “Download” 下載專案到 PAC 。 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

若尚未編譯過程式，請按 “Make 

application code” 按鈕產生編譯碼，

再按 “Debug” 按鈕。 

先停止 PAC 內現存的專案，再下載新的專案。 
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3.2.4 步驟 4 – 下載網頁到 WinPAC 

 

A. 請複製 Demo 目錄裡的所有檔案 (...\isagraf_winpac_demo\wp_webhmi_demo\wphmi_05\ *.* ) 

到 WP-8x47 中 ( \Miscro_SD\Temp\HTTP\WebHMI\ ) 。 

 

範例 “wphmi_05” 需在 WinPAC 的插槽 0 插上一個 I-87055W 模組。若您沒有 I-87055W (8 輸入及 

8 輸出) I/O 模組，請下載 “wphmi_01” 。 

 

B. 一旦修改或重新複製網頁，請執行 “rs_wphmi.exe” 重新設定 Web 伺服器。 

每次修改 WP-8x47 中 \Micro_SD\Temp\HTTP\WebHMI\ 資料夾裡的任何檔案，都必需重新執行 

“rs_wphmi.exe” 。 

 
 
 
 
 
 
 
 
 
 
 
 

3.2.5 步驟 5 – 展示 Web HMI  

 

請執行 Internet Explorer (6.0 或更高版本)，輸入你的 WP-8x47 的 IP 位址。例如:  192.168.1.232   或   

http://192.168.1.232   
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

http://192.168.1.232/
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第 4 章 建立 Web HMI 範例 

本章說明如何建立一個 ISaGRAF 專案 與 Web HMI 頁面。 

WinPAC-8xx7 或 WP-8x47 為 WP-8147/8447/8847/8137/8437/8837 的簡稱。 

 
 
 

重要:  

 

1. WP-8x47 的插槽 0 ~ 7，只支援 I-8K 與 I-87K I/O 高卡模組。 

 

請參考網頁，了解更多支援的模組:  

http://www.icpdas.com/en/product/guide+Remote__I_O__Module__and__Unit+Software__Support__
+I-8K_I-87K__Software__Support 
 

2.  WP-8x47 需設定為固定 IP 位址. (不可使用 DHCP) 。 

 

3. 建議使用工業級乙太網路交換器來連接 PAC。 

 

請參考網頁，了解更多乙太網路交換器:  

http://www.icpdas.com/en/product/guide+Industrial__Communication+Ethernet__Communication+Eth
ernet__Switch 

 
 

若您想使用 ISaGRAF 搭配 EVC++ 4.0 或 VS.net 2008，來設計 WP-8x47 的應用程式，設計方法請參閱 

第 6 章 或 第 7 章。 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

http://www.icpdas.com/en/product/guide+Remote__I_O__Module__and__Unit+Software__Support__+I-8K_I-87K__Software__Support
http://www.icpdas.com/en/product/guide+Remote__I_O__Module__and__Unit+Software__Support__+I-8K_I-87K__Software__Support
http://www.icpdas.com/en/product/guide+Industrial__Communication+Ethernet__Communication+Ethernet__Switch
http://www.icpdas.com/en/product/guide+Industrial__Communication+Ethernet__Communication+Ethernet__Switch
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4.1 撰寫一個簡單的 ISaGRAF 程式 

本章節說明在 ISaGRAF Workbench 撰寫一個簡易的 ISaGRAF 程式，並將此程式下載到 WP-8x47 內 

(插槽 0 插著 I-87055W I/O 模組) 去執行。若您尚未在 PC 上安裝 "ISaGRAF" 與 "ICP DAS Utilities for 

ISaGRAF"，請回到第 2 章。 

 

範例包含 1 個 LD 階梯程式 (“example1.pia” 專案，在 Demo 目錄中 …\isagraf_winpac_demo\) 。 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

變數宣告: 

 

Name Type Attribute 說明 

OUT01 Boolean Output 輸出 1，於 I-87055W，Modbus network address = 1 

OUT02 Boolean Output 輸出 2，於 I-87055W，Modbus network address = 2 

K1 Boolean Input 輸入 1，於 I-87055W，Modbus network address = 11 

K2 Boolean Input 輸入 2，於 I-87055W，Modbus network address = 12 

T1 Timer Internal 
閃爍的週期，預設值為 T#8s 

Modbus network addr = 21 

 
 
 

LD 階梯程式 (LD1): 

 
 
 
 
 
 
 
 

專案名稱 –"example1" 

 
 

專案的群組名稱 ("Test") 

 
 

LD 程式名稱 – "LD1" 
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4.1.1 啟動 ISaGRAF－專案管理 

 

點選 Windows 的 [開始]  [所有程式]  [ISaGRAF 3.5]  [Projects]。 

 
 
 
 
 
 
 
 
 
 
 
 

 
 

4.1.2 建立 ISaGRAF 使用者群組 

 

點選 [Select project group] 再點選 [New group] 按鈕，輸入新的群組名稱 (例如: “Test”)，按 "OK"。 

然後，選擇新建的群組名稱，按 [Select] 開啟群組視窗。 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

1. 

2. 

3. 
4. 

5. 
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4.1.3 建立新的 ISaGRAF 專案 

點選 [Create new project] 按鈕，來建立新的 ISaGRAF 專案，接著在 “Name” 欄位中輸入專案名稱 

“example1”，按 “OK”。 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

如果您想為專案加上註解，請選擇 [Edit] > [Set comment text] 。 

 
 
 
 
 
 
 
 
 
 
 
 
 
 

在 "Project Management" 視窗可看到新的專案名稱，滑鼠雙擊專案名稱來開啟該專案。 

 
 
 
 
 
 
 
 
 
 
 
 
 
 

滑鼠雙擊專案名稱， 

來開啟專案視窗。 
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4.1.4 宣告 ISaGRAF 專案變數 

在撰寫 ISaGRAF 程式前，必需先宣告程式中要使用的變數。 

 

宣告布林變數 

1. 點選 "Dictionary" 按鈕。 

2. 點選 "Booleans" 頁籤，來宣告布林變數。 

3. 滑鼠雙擊空白列，來開啟 "Boolean Variable" 視窗。 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

(以下請參考 4.1 變數宣告) 

4. 如下圖，在 “Name” 欄位輸入變數名稱  (例如: "K1”) 。 

5. 在 "Comment" 欄位加入註解  (例如: "Input 1 in the I-87055W board”) 。 

6. 設定 "K1" 變數的屬性 (例如: "Internal”) 。 

7. 點選 "Store" 按鈕，儲存設定。此時，您已宣告一個布林變數了。 

 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 

1. 
 

2. 
 3. 

 

4. 

 
5. 

 

6. 
 

7. 
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注意:   

請確認所有的變數皆設定了正確的屬性。如需修改，請滑鼠雙擊變數名稱，即可重新設定屬性。 
 

請依照上述類似步驟，來新增布林變數 –"K2"，結果如下圖所示。 

 
 
 
 
 
 
 
 
 
 
 

 
 

快速宣告變數 

此範例需宣告兩個輸出變數 - "OUT1 與 OUT2"，ISaGRAF 提供了一個簡單、快速的方法來宣告這種

連續編號的變數。 
 

1. 點選 "Quick Declaration" 按鈕。 

2. 在 "Numbering" 項目: 

“From” 和 "To" － 請輸入連續順序變數的開始和結束數字 (本例: 1、2) 。 

"Digits" － 請輸入數字需要的位數  (本例: 2，若不足 2 位數會補 “0”) 。 

3. 在 "Name" 欄位，輸入共同的名稱 (本例: "OUT") 。 

4. 設定變數的屬性 (本例:  "Output") 並點選 "OK" 按鈕。 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

1. 

 

2. 
 

3. 
 

4. 
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兩個輸出變數已加入到 "Global Boolean" 視窗，請點選 “Save” 按鈕來儲存設定。 

 
 
 
 
 
 
 
 
 
 
 
 
 
 

宣告計時器變數 (Timer) 

設定此範例的 Timer (T1) 變數:  
 

1. 在 “Global Timers” 視窗點選 "Timers" 頁籤，並滑鼠雙擊空白的資料列。 

2. 在 "Name" 輸入變數名稱 (本例: "T1")，在 "Attribute" 欄位點選變數的屬性 (本例:  "Internal") 。 

3. 設定 "Initial Value" 初始值為 "T#8s"，點選 "Store" 儲存設定。 

4. 點選  "Save" 按鈕存檔，並點選視窗右上角 “X” 關閉視窗。 
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4.1.5 指定變數的 Modbus 網路位址 

若指定了適當的 Modbus 網路位址編號 (Modbus network address)，Web HMI 可與 ISaGRAF 專案相互

交換變數值。Web HMI 能識別 1 ~ 1024 的 Modbus 編號，而使用 SCADA 軟體可以讀/寫 WP-8x47 裡 

1 ~ 8191 的 Modbus 編號。 

 

若沒指定 Modbus 編號的變數，則 Web HMI、SCADA 軟體 或 HMI 設備無法辨識使用。 

 

有關指定 Modbus 網路位址的詳細說明，請參考 ISaGRAF 進階手冊 - 第 4.1 及 4.2 節。 

(下載檔案: http://www.icpdas.com/en/download/show.php?num=333 ) 

 

1. 點選 “Dictionary” 按鈕。 

2. 點選 [Tools] > [Modbus SCADA addressing map]。 

3. 選擇 [Options] > [Decimal] (十進制)，否則預設會顯示十六進制的位址。 

4. 點選位址 “00001”，再滑鼠雙擊 “OUT01” 變數，設定其 Modbus 位址為 1。 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
 
 
 
 
 
 
 

1. 

2. 

3. 

4. 

5. 

http://www.icpdas.com/en/download/show.php?num=333
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請依照同樣步驟指定 OUT02 (位址=2)、K1 (位址=11)、K2 (位址=12) 與 T1 (位址=21) 的 Modbus 位址，

結果如下面視窗所示。  

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

非常重要:  

若使用長整數 (Long integer)、浮點數 (Float) 或 計時器 (Timer) 變數，則會用掉兩個 Modbus 編號。 

 

關於 Modbus 網路位址的詳細說明，請參考 ISaGRAF 進階使用手冊 - 第 4.2 節。  

(下載檔案: http://www.icpdas.com/en/download/show.php?num=333 ) 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

在此視窗顯示的 Modbus 位址編號

固定為十六進制格式。 

http://www.icpdas.com/en/download/show.php?num=333
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4.1.6 建立 LD 程式 - "LD1" 

ISaGRAF 在每一個 PLC scan cycle 會執行每個程式一次。首先執行 “begin” 區域的程式，再執行 

“Sequential” 區域，最後執行 “End” 區域的程式。如下圖所示。 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

點選 "Create New Program" 按鈕，將顯示 "New Program" 視窗。接著，輸入程式名稱 (例如: "LD1") 並

選擇程式語言 "Quick LD: Ladder Diagram"，確認 "Style" 欄裡選擇 "Begin:  Main Program"。如果 

需要，您也可在 "Comment" 欄加上註解。 

 
 
 
 
 
 
 
 
 
 
 
 
 
 

現在您的專案裡有一個程式了，滑鼠雙擊 “LD1” 來開始進行程式編寫。 

 
 
 
 
 
 
 
 
 
 
 
 

掃描所有輸入 

‘Sequential’ 區域作業 

‘begin’ 區域作業 

‘End’ 區域作業 

重新更新所有輸出 

ISaGRAF 
Cycle 
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4.1.7 編輯 "LD1" 程式 

 

在 LD1 程式編輯畫面，請點選 "Edit" 選單中的 "Insert Rung"。 

 
 
 
 
 
 
 
 
 
 
 
 
 
 

或者，點選 "F2 (Contact On The Left)" 按鈕，將會顯示於如下的畫面。 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

接下來要編輯第一行，請點選左方的 "Contact"，並點選 "Cut" 按鈕來刪除它。 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

點選左方的 "Contact"，並 

點選 "Cut" 來刪除它。 
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再點選 "F6 (Block on the left)" 按鈕，於左方插入一個方塊。 

 
 
 
 
 
 
 
 
 
 
 
 
 
 

接下來要指定方塊的內容，滑鼠雙擊方塊，來開啟 "Function Block" 視窗。 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

選取 "BLINK" 方塊，並點選 "OK"。若要查看該方塊的說明，可點選 "Info" 按鈕。 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Move the cursor to the first contact and 
then click on “cut” to delete it 

滑鼠雙擊方塊內的任一區域 

點選 "Info" 可查看功能說明。 

1. 

2. 
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滑鼠雙擊  “CYCLE” 參數的左方，於下拉選單選擇 “Timer”，並雙擊 “T1” 來指定變數。 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

滑鼠雙擊右方的 "coil"，於下拉選單選擇  "Boolean"，並雙擊 "OUT1" 來指定變數。 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

1. 

2. 

3. 

1. 
2. 

3. 
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至此，您已完成了 LD1 程式，請點選 "Save" 來儲存設定，並關閉此視窗。 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

4.1.8 連接 I/O 

在 4.1.4 節已宣告了 “OUT01” 與 “OUT02” 變數為 “Output” 屬性，而 “K1” 與 “K2” 為 “Input” 屬性。 

這些 “input” 與 “output” 變數必需對應到 PAC 上的 I/O 通道，才可進行運作。 

 

請點選 “I/O connection” 按鈕，接著滑鼠雙擊第一個 Slot (即 Slot 0)，請確認 I-87055W 模組已插在 

WinPAC 的插槽 0，選取右下角 “Equipments”，再雙擊 “I_87055: 8 CH. DI & 8 CH. DO”，並點選 “OK”。 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

2. 

1. 

點選 “Note” 可查閱此

I/O 設備的說明。 
3. 

4. 
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如果您沒有 I-87055W 模組，您可以點選按鈕 “Real /Virtual board”，切換成以虛擬的方式指定 I/O

的連接。 

  
 
 
 
 
 
 
 
 
 
 
 

接著要將 Input 變數 “K1” 和 “K2” 連接到 “i_87055” 板卡的通道 1 與 2，點選 “DI8” 再雙擊右邊的 

通道 1，再點選 “Connect” 2 次，來連接 “K1” 和 “K2” 並點選 “Close” 關閉視窗。 

  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

1. 
2. 

3. 

4. 
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請用同樣方法，連接 Output 變數 “OUT01” 和 “OUT02” 到 [DO8] 的通道 1、2，再點選 “Save” 按鈕 

儲存並離開。 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

重要注意:   

 

1. 在 I/O connection 視窗，Slot 0 ~ 7 是保留用來對應到 WinPAC 上使用的 I/O 模組。 

請使用 Slot 8 (以上) 來加入其他的 I/O 功能。 

 

2. 所有屬性為 “Input” 與 “Output” 的變數都必需連結到 I/O 功能板卡，才能確保程式編譯成功。 

只有屬性為 “Input” 與 “Output” 的變數才會顯示在 "I/O Connections" 視窗，所以本範例只顯示 

2 個布林 Output 變數 - OUT01，OUT02，以及 2 個布林 Input 變數 – K1 與 K2。 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



快速上手手冊: WP-8147/8447/8847, 2020 年 10 月, 2.0 版                       4-17 

4.2 編譯及模擬程式 

為了讓所有的 ISaGRAF 程式都能在 PAC 上正常運作，ISaGRAF 的編譯選項必需選擇 "ISA86M: TIC 

Code For Intel" 選項，詳細步驟如下所示。 

 

首先，滑鼠點選 "Make"  選單上的 "Compiler Options"。 

 
 
 
 
 
 
 
 
 
 
 

 

請確認您已正確地選取如下圖 3 個選項，並點選 “OK" 鍵完成編譯選擇。 

 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

注意: 使用變數陣列時，不可勾選 "Optimizer" 的第  2、7、8  與  9 個選項。 

 建議只勾選第 1 個 "Run two optimizer passes" 選項即可。 

 
 
 
 

1. 

2. 

6. 

請確認您已選取此 3 項。 

3. 

4. 

5. 
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編譯專案 ! 

選擇適當的編譯選項後，請點選 "Make application code" 按鈕開始編譯程式，若編譯過程沒有 

出現任何錯誤訊息，恭喜您，您已經成功地完成了一個 ISaGRAF 程式。 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

若程式在編譯過程中出現錯誤訊息，請點選 "Continue" 按鈕檢視錯誤訊息，並回到專案編輯畫面 

更正錯誤，並重新編譯。 

 
 

模擬專案 ! 

編譯成功後，您可先在 PC 上點選 "Simulate" 按鈕，來模擬專案並檢視程式的運作 (無需 PAC) 。 

 
 
 
 
 
 
 
 
 
 
 

接著，會出現 "I/O Simulator"、"ISaGRAF Debug Programs" 與 "ISaGRAF Debugger" 視窗。如果 I/O  

變數沒有出現在模擬視窗，只需點選 "Options" 選單的 "Variable Names" 選項，即可顯示名稱。 
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在 "ISaGRAF- Debug programs" 視窗中雙擊 "LD1"，可見到程式模擬的狀態。 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

執行模擬 

當您開啟 "LD1" 後，可看到輸出點 “OUT01” 每 8 秒閃爍一次。程式執行時，您可以調整 "T1" 變數

來改變閃爍的間隔值: 

 

1. 請點選 "Dictionary" 按鈕開啟 "ISaGRAF Global Variables" 視窗。 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

2. 點選 "Timer" 標籤，雙擊 “T1” 區塊。 

  
 
 

點選 “X” 可關閉模擬 
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輸入新值 “T#4000ms” (表示為 4000 微秒)，並點選 “Write”。然後，“OUT01” 將會每 4 秒閃爍 

一次。 

 
 
 
 
 
 
 
 
 
 
 

接著模擬 “K1” 與 “K2” 輸入點，請直接點選 “K1” 與 “K2” 按鈕即可。 

 
 
 
 
 
 
 
 
 
 
 

若要結束程式模擬，請關閉 “Debugger” 視窗。 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

點選 X 可離開程式模擬。 
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4.3 下載與執行專案 

有兩種方式可下載專案到 PAC ，一是使用乙太網路線，一是使用 RS-232 連接線，在此介紹使用

RS-232 連接線的方式。(關於使用乙太網路線的方式，請參考 3.2.3 節) 

 
 

連接硬體 

請依照下圖連接好硬體，並確認 “Modbus RTU Slave Port” 是設為 COM3 (參考附錄 A.2)，否則只能

以 Ethernet 方式下載。 

 

RS-232 的接腳圖: 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

注意: WP-8147 沒有 COM3，只有 WP-8447/8847 有 COM3。 

 
 

以下將說明如何使用 RS-232 連接線，將 ISaGRAF 程式下載到 PAC。若您想使用 Ethernet 網路線，  

請參閱 3.2.3 節。 
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設定通訊參數 

首先，在 "ISaGRAF Programs" 視窗，滑鼠點選 "Link Setup" 按鈕。 

 
 
 
 
 
 
 
 
 
 
 
 

在 "PC-PLC Link parameters" 視窗，請設定適當的通訊參數。 

 

 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

WP-8x47 的 RS-232 通訊參數 必需 和連接的電腦設定相同的序列通訊參數值。 

WP-8x47 的 COM3 (RS-232) 預設參數如下 : 

 
 
 
 
 
 
 

此外，請參閱附錄 A.2 設定 COM3 為 Modbus RTU Slave 埠。 

 
 

1. 

2.  

3.  

4. 

填寫 PAC 的站號 ; 預設 1。 

選擇 PC 的 COM 編號。 
點選它來設定 PC 的通訊參數。 

請使用和 PAC  相同的通訊參數 (預設

為 19200, N, 8, 1, No flow control)。 

Baudrate:  19200 

Parity: none 

Format: 8 bits, 1 stop 

Flow control: none 



快速上手手冊: WP-8147/8447/8847, 2020 年 10 月, 2.0 版                       4-23 

測試通訊 

將程式下載到 PAC 之前，請確定您的電腦與 PAC 的通訊正常。請點選 "ISaGRAF - Programs" 視窗的 

"Debug" 按鈕，來進行確認。 

 
 
 
 
 
 
 
 
 
 
 

若 PC 和 PAC  正常通訊，您可在 “Debugger” 視窗看到 PAC 內正在運行的專案名稱。 

 
 
 
 
 
 
 
 
 
 
 

若在 “Debugger” 視窗中出現 "Disconnected"，則表示 PC 和 PAC  並未連線成功。 

 

最常導致連線失敗的原因，是兩端的通訊埠沒有接好 或 通訊參數未設定正確。請檢查兩端接線，

並參考上一節修改  "Serial Link Parameters" 視窗內的 COM Port 參數。 

 

下載專案前，如果 PAC 裡已有程式，請先點選 "Stop application" 按鈕停止該程式。 

 
 
 
 
 
 
 
 
 
 

接著，就可開始下載 “Example1” 專案到 PAC 中。 

 

 

 

 

PC 上的專案名稱。 

PAC 內正在運行的專案名稱。 
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開始下載 

點選 "ISaGRAF - Debugger" 視窗的 "Download" 按鈕。 

 
 
 
 
 
 
 
 
 
 

接著，選擇編譯選項 "ISA86M:  TIC Code For Intel"。 

 
 
 
 
 
 
 
 
 
 
 
 

按下 “Download” 按鈕，即開始下載程式 到 WP-8x47，您可見到下載進度。 

 
 
 
 
 
 
 
 

下載成功後，視窗顯示如下: 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

若沒出現 “ISA86M: TIC code fort Intel”， 

表示編譯選項設定時沒有勾選 “ISA86M: 

TIC code for Intel”，請參考 4.2 節，勾選 

該選項，並再次編譯程式。 

點選 “X” 可停止 PC 與 PAC 的通訊。 
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執行 LD 程式 

使用者可在 ISaGRAF 程式運行時，觀察  I/O 的即時狀態。方法是，點選 “ISaGRAF – Debug programs" 

的 “I/O connection" 按鈕，來開啟 "I/O Connections" 視窗，您可設定 I-87055W 模組的 DI 通道 1、2

為開/關 (ON/OFF)，並查看 “K1” 或 “K2”  是否即時更新狀態 (TRUE/FALSE) 。 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

另外，點選 “Dictionary” 按鈕，也可檢視布林 (Boolean) 與 計時器 (Timer) 變數的即時狀態。 
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另外，開啟 "Quick LD Program" 視窗，也可查看 LD 程式執行的即時狀態。 
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4.4 設計網頁 

完成 ISaGRAF 專案並下載到 WP-8x47 後，接著為 ISaGRAF 專案設計網頁。如果您尚未實作第 3 章 

“Web HMI 範例程式安裝”，請練習一次以熟悉步驟。 

 

本手冊使用微軟的 “Microsoft Office FrontPage 2003” (或更新版本) 來建立網頁，您可以選擇自己 

熟悉的網頁編輯軟體或工具來完成網頁。 

 

您可參考 WP-8x47 Demo 目錄裡已完成的範例，最好能實作一次以更加了解設計重點。 

下載 Demo:  http://www.icpdas.com/en/download/file.php?num=5495 

WP-8x47 Demo 目錄: ...\isagraf_winpac_demo\wp_webhmi_demo\example1\ 

 
 

4.4.1 步驟 1 – 複製 Web HMI 範例頁面 

這個 Web HMI 範例頁面置於 WP-8x47 Demo 目錄: 

   ...\isagraf_winpac_demo\wp_webhmi_demo\sample\ 
 

請複製範例資料夾 “sample” 到你的電腦，並重新命名，例如: “example1”。 

本 Web HMI 範例包含下列 2 個資料夾、3 個 DLL 檔案與 4 個 HTM 檔案 : 

 

./img/  (預設圖片檔資料夾 - *.jpg、*.bmp、*.gif ) 

./msg/  (預設訊息檔資料夾 - wincon.js 和 xxerror.htm) 

 

whmi_filter.dll (3 個 DLL 檔案) 

login.dll 
main.dll 

 

index.htm (預設首頁) 

login.htm (Web HMI 歡迎頁面) 

menu.htm (切換菜單頁面，一般在 IE 瀏覽器的左邊) 

main.htm (登入成功的首頁) 

 

使用者可將自己的圖片檔放在 “user_img” 資料夾，將自訂的 Java Script 檔或 CSS 檔放在 “user_msg” 

資料夾，其他的資料夾名稱是不被 WinPAC Web HMI 接受的。 

 

“index.htm” 檔是網路伺服器的預設首頁檔，使用者請勿修改。當使用者由 IE 瀏覽器造訪 WP-8x47，

“index.htm” 會在 1 到 2 秒間重新指引到 “login.htm” 檔。 

 

使用者可以修改 “login.htm”、“menu.htm” 與 “main.htm” 檔案以符合自己的需求，本範例只修改 

“main.htm” 檔案。 

http://www.icpdas.com/en/download/file.php?num=5495
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4.4.2 步驟 2 – 建立 Main.htm 

 

請執行 Microsoft Office FrontPage 2003 (或更高版本) 並開啟 “main.htm”。 

 

請點選到 “設計” 頁面。 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

請依下圖，點選 [插入] > [圖層]，插入一個 “Layer2” 圖層物件。 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

點選此 3 項以顯示不同的工作頁面。  

物件的 ID  – “Layer2” 
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在 “Layer2” 內點選滑鼠一下，然後按 [插入] > [圖層]，插入一個新圖層並輸入 “K1” 。 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

依照相同方式，在 “Layer3” 的下方，再插入一個 “Layer4” 圖層物件，如下圖所示。 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

1. 

2. 

在 “Layer2” 裡面新增一個

圖層，並輸入 “K1”。 

3. 

請將 “Layer4” 放置在 “Layer3” 下方。 

在 Layer2 內新增一個

圖層，並輸入 “K1”。 
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接著，要在 “Layer4” 裡插入一張圖片，檔名為 “./img/big_Tcircle_red0.jpg”。請點選 [插入] > [圖片] > 

[從檔案]，並切換到圖檔目錄 (此例為 “example1/img/”) 來選擇圖片。 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

選取檔案後，結果視窗如下。 

 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

1. 點選在 “Layer4” 內。 

2. 插入一個圖檔。 

1. 

2. 

Layer2 Layer3 

Layer4 

Layer1 
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請依相同方式，插入一個 “Layer5” 物件、一個文字為 “K2” 的 “Layer6” 與 一個文字為  “OK” 的 

“Layer7” 。“K1” 是用來顯示 I-87055W 的第一個 Input，而 “K2” 用來顯示第二個 Input。 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

依相同方式，再插入 “OUT01” 與 “OUT02”，OUT01 使用 “./img/circle_blue0.jpg” 圖檔，OUT02 使用 

“./img/cmd0.jpg” 圖檔。OUT01 用來顯示 I-87055W 的第一個 Output，而 “OUT02” 用來控制與顯示

第二個 Output。 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

1. 

Layer5 1. 點選此處，插入 “Layer5”。 

2. 依前述步驟，在 “Layer5” 圖層裡，

插入“Layer6” 與 “Layer7” 圖層。 Layer6 

2. 

Layer7 

Layer11 

Layer12 

Layer13 

Layer8 

Layer9 

Layer10 
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接著，請插入一個圖層 “Layer14”，並在其內插入文字為 “T1 = xxx ms” 的 “Layer15”，同時，在 

“Layer15” 下方再插入兩個空圖層 “Layer16” 及 “Layer17”。 “T1” 用來顯示 ISaGRAF 專案程式裡 

計時器變數的值。 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

請點選 “Save” 按鈕，儲存此頁面。 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Layer14 

Layer15 

Layer17 
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4.4.3 步驟 3 – 加入 Main.htm 的控制碼 

 

點選 “程式碼” 頁籤來檢視網頁的 HTML 編碼，一個有效語法的 HTML 文件，包含下列幾個基本 

物件。 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
 

請找到 <body> 區塊，修改下列程式碼 :  

 
 

 

 

 

 

<!-- Caption --> 

<font color="blue" size="4">    

<div style="position: absolute; width: 353px; height: 24px; z-index: 1; left: 73px; top: 12px" id="layer1"> 

This is a Web HMI sample page !</div> 

</font>   

 

 

 

 

<html> 
 
<title>Your Title here</title> 
 
<head> 
 
<SCRIPT LANGUAGE="JavaScript"> 
 
</SCRIPT> 
 
</head> 
 
<body> 
 
</body> 
 
</html> 
 

“body” 區塊主要用來描述此頁面的動作 

JavaScript 程式碼一般放在 “head” 區塊 

請參閱第 5 章，以了解詳細的 Web HMI 程式碼。 

Caption 區:  Layer1  

所有 Layer 都以 <div> 開頭，以 </div> 結束 
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<div style="position: absolute; width: 102px; height: 93px; z-index: 2; left: 75px; top: 52px" id="layer2"> 

<div style="position: absolute; width: 44px; height: 24px; z-index: 1; left: 3px; top: 10px" id="layer3"> 

K1</div> 

<div style="position: absolute; width: 58px; height: 46px; z-index: 2; left: 1px; top: 38px" id="layer4"> 

<img   name= “B11”  border="0" src="img/big_Tcircle_red0.jpg" width="43" height="41"></div> 

<p>&nbsp;</div> 

 
 
 
 
 
 
 
<div style="position: absolute; width: 101px; height: 93px; z-index: 3; left: 241px; top: 51px" id="layer5"> 

<div style="position: absolute; width: 47px; height: 26px; z-index: 1; left: 6px; top: 4px" id="layer6"> 

K2</div> 

<div style="position: absolute; width: 92px; height: 35px; z-index: 2; left: 7px; top: 38px" id="layer7"> 

 

<font  id=“font_B12” color=“blue” size=“3”> 

<b  id=“B12”> OK </b> 

</font> </div> 

 

<p>&nbsp;</div> 

 
 
 
 
 
 
 
 
 
<div style="position: absolute; width:82px; height:79px;z-index:4; left:71px; top:168px" id="layer8"> 

<div style="position: absolute; width: 60px; height: 31px; z-index: 1; left: 3px; top: 6px" id="layer9"> 

OUT01</div> 

<div style="position: absolute; width: 37px; height: 31px; z-index: 2; left: 6px; top: 42px" id="layer10"> 

<img  name=“B1”  border="0" src="img/circle_blue0.jpg" width="19" height="20"></div> 

<p>&nbsp;</div> 

  

 
 
 
 
 
 

K1 區: Layer2 到 Layer4 

請在 “<img” 之後插入文字: name= “B11”  

K2 區: Layer5 到 Layer7 

請將 “OK <div>” 修改為: 

<font  id=“font_B12” color=“blue” size=“3”> 

<b  id=“B12”> OK </b> 

</font> </div> 

OUT01 區: Layer8 到 Layer10 

 

請在 “<img” 之後插入文字: name= “B11”  
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<div style="position: absolute; width:100px; height:100px; z-index: 5; left:242px; top:164px" 

id="layer11"> 

<div style="position: absolute; width: 71px; height: 31px; z-index: 1; left: 4px; top: 8px" id="layer12"> 

OUT02</div> 

<div style="position: absolute; width: 61px; height: 48px; z-index: 2; left: 5px; top: 45px" id="layer13"> 

<img  style=“cursor:hand” name=“B2”  onclick="ON_OFF(form_B2, form_B2.B2, boolean_val[2])"  

border="0" src="img/cmd0.jpg" width="50" height="40"></div> 

 

   

 

 

 

 

<form name="form_B2" method="post" action="./main.dll"> 

    <input name="BEGIN" type="hidden"> 

    <input name="B2"    type="hidden" value="0"> 

    <input name="END"   type="hidden"> 

  </form> 

 

<p>&nbsp;</div> 

  
 
 
 
 
 
 
 
 
 
 
 
 

<div style="position: absolute; width: 181px; height: 90px; z-index: 6; left: 374px; top: 162px" 

id="layer14"> 

<div style="position: absolute; width: 119px; height: 28px; z-index: 1; left: 4px; top: 7px" id="layer15"> 

 

 T1 = <b id="T1">xxx ms</b></div> 

 

 

 

<div style="position: absolute; width: 98px; height: 28px; z-index: 2; left: 4px; top: 45px" id="layer16"> 

 

   

 

OUT02 區: Layer11 到 Layer13 

 

請在 “<img” 之後插入: 

Style=“cursor:hand” name=“B2”  onclick="ON_OFF(form_B2, form_B2.B2, boolean_val[2])" 

請插入: 

  <form name="form_B2" method="post" action="./main.dll"> 

    <input name="BEGIN" type="hidden"> 

    <input name="B2"    type="hidden" value="0"> 

    <input name="END"   type="hidden"> 

  </form> 

T1 區: Layer14 到 Layer17 

 

請將 “T1 = xxx ms </div>” 修改為:  

T1 = <b id="T1">xxx ms</b></div> 
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<form name="form_L21" method="post" action="./main.dll"> 

    <input name="BEGIN" type="hidden"> 

    <input name="L21" type="text" size="8" value="xxx">  

    <input name="END" type="hidden"> 

  </form> 

 

&nbsp;</div> 

 
 
 
 
 
 
 

 
<div style="position: absolute; width: 67px; height: 33px; z-index: 3; left: 106px; top: 44px" 
id="layer17"> 
 
  <input type="button" value="Enter" onclick="Check_L21( )"> 
 
&nbsp;</div> 
<p>&nbsp;</div> 
 
 
 
 
 
 

到此為止，<body>   </body> 區塊的程式碼已經修改完成。 

 

請在 “Layser17” 插入: 

<input type="button" value="Enter" onclick="Check_L21( )"> 

請在 “Layer16” 插入下列程式碼: 

<form name="form_L21" method="post" action="./main.dll"> 

    <input name="BEGIN" type="hidden"> 

    <input name="L21" type="text" size="8" value="xxx">  

    <input name="END" type="hidden"> 

  </form> 
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接著，請找到 “head” 區塊，依下圖修改 “head” 區塊內的程式碼 : 

 

// variable to record object's blink state，0: not blink，1: blink，For example: 

// ********************************* 
var B12_blink=0;  // init as 0: not blink 
// ********************************* 
 
// function to blink object 
var blink_step=0; 
function blink_obj() 
{ 
  if(blink_step==1) 
  { 
    blink_step=0; 
     
    // display your object here 

    // blink B12，For example: 

    // ********************************* 
    if(B12_blink==1) 
    { 
      B12.innerText="Error !" ;   
      font_B12.color="red"; 
    } 
    // ********************************* 
  } 
  else 
  { 
    blink_step=1; 
 
    // un-display your object here 

    // blink B12，For example: 

    // ********************************* 
    if(B12_blink==1) 
    { 
      B12.innerText="" ; 
      font_B12.color="red"; 
    } 
    // ********************************* 
  } 

  setTimeout("blink_obj()"，blink_period);    

} 
 
 
 

本範例當 K2=True，會閃爍 “Error !” 字樣，

此 3 區塊的程式碼，請去除加在前面的註解

記號 //，變成如本頁所列。 
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請找到 function Check_L21()，並去除註解記號。function Check_L21() 是用來檢查輸入的 T1 值並 

將它傳到 PAC。 

 
 

// form sample，to check value of L21 & then post val to controller 

// For example: 
// ************************************************************** 
 
function Check_L21() 
{ 
  var val=form_L21.L21.value; 
  if(val>12000 || val<4000) 
  { 
    alert("T1's value should be in the range of 4000 to 12000"); 
    return; 
  } 
  Check(form_L21);  // post value to the controller 
} 
 
// ************************************************************** 

 
 
 

另外，找到 function refresh_data() 並加入下列程式碼 : 

 

// To refresh displayed data，this function is called by IE about every 1.5 sec later 

 
function refresh_data() 
{ 
  B1.src = "./img/circle_blue" + boolean_val[1] + ".jpg"; 
  B2.src = "./img/cmd" + boolean_val[2] + ".jpg"; 
 

  B11.src = "./img/big_Tcircle_red" + boolean_val[11] + ".jpg"; 
 

  if(boolean_val[12]==0) 
  { 
    B12.innerText="Ok"; 
    font_B12.color="blue"; 
    B12_blink=0; 
  } 
  else 
  { 
    B12_blink=1; 
  }   
  T1.innerText=timer_val[21] + " ms"; 
} 
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現在，所有程式碼已經修改完成，請儲存檔案。 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

您可以點選 “預覽” 視窗來模擬執行狀態。 
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4.4.4 步驟 4 – 下載 Web HMI 頁面到 PAC 

 

方法類似 3.2 節的下載步驟，若您尚未實作第 3 章 “安裝 Web HMI 範例程式”，請您盡快練習一次

以熟悉操作方式。然後，啟動 PAC 來操作下列步驟。 

 
 

設定 Web 選項 

1. 執行 ISaGRAF Driver - “isaWinPAC”。 

2. 在 “Web” 頁面上勾選 “Enable Web HMI” 選項，並點選 “Setting” 按鈕。 

3. 勾選 “Enable Account Security”，並點選 “Edit” 設定 “使用帳號” 與 “密碼”，最後點選 “OK”。 

 

注意:  如果沒有勾選 “Enable Account Security”，任何人都能透過 IE 瀏覽器輕易的操控您的 PAC。 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

接著，請複製 “example1” 目錄內的所有檔案到 ISaGRAF PAC 裡: 

 

複製下列檔案: 

<您的電腦>: 資料夾\example1\ *.*   

 

到下列位置:  

<ISaGRAF PAC>: Micro_SD\Temp\HTTP\WebHMI\  

1. 

2. 

3. 4. 
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一旦修改或重新複製網頁，請執行 “rs_wphmi.exe” 重新設定 Web 伺服器。每當 WP-8x47 目錄 

\Micro_SD\Temp\HTTP\WebHMI\ 裡的任何檔案有修改，都必需重新執行 “rs_wphmi.exe” 。 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

展示 Web HMI: 

請執行 IE 瀏覽器 (6.0 或更高版本)，並輸入 WP-8x47 的 IP 位址。 

例如:   192.168.1.232    或  http:// 192.168.1.232 
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如果網頁有任何問題，您可以啟用下列視窗的偵錯功能，每次網頁有錯時皆會顯示錯誤訊息。 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

有錯誤時，請確認 ISaGRAF 專案是否已確實下載至 PAC  (請參閱 第 4.3 或 3.2.3 節)?   

另外，ISaGRAF 變數是否設定了正確的 Modbus 網路位址編號 (請參閱 第 4.1.5 節)? 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

勾選此項，並點選 “OK”。 
雙擊此處可顯示錯誤訊息視窗。 

目前執行的 ISaGRAF 專案名稱列於此處。 
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第 5 章 Web HMI 設計基礎 

重要:  

1. WP-8x47 的 插槽 0 ~ 7 只支援高卡的 I-8K 與 I-87K I/O 模組。請參考網頁，了解更多支援的模組:  

http://www.icpdas.com/en/product/guide+Remote__I_O__Module__and__Unit+Software__Support__
+I-8K_I-87K__Software__Support 

2. WP-8x47 需設定為固定 IP 位址 (不可使用 DHCP) 。 

 

注意:   

1. 本章描述 Web HMI 的基本程式設計。我們不會將重點放在 HTML 上，如果您想知道更多有關

HTML 的程式設計，最好的辦法是 “買一本 HTML 相關的著作”，書店裡有許多這類型的好書。 

2. Web HMI 只支援基本的 HTML 標籤，並不支援 ASP、PHP、JSP 或其他網頁伺服器語言。 

3. 請不要在 Web HMI 中使用 <frameset>  </frameset>、<frame> </frame>。 

4. 物件名稱、ID 編號、編碼、變數名稱和功能名稱都是字母大小寫有別的!  

例如: refresh_data( ) 和 Refresh_data( ) 是不相同的。 

5. WP-8x47 Demo 目錄裡提供了 10 個以上的 Web HMI 範例，請參考 3.1 節。 

 
 

5.1 Web HMI  的基本檔案 

Web HMI 的基本檔案包括 2 個資料夾、3 個 DLL 檔和 4 個 htm 檔，如下所列: 
 

 ./img/  (預設圖片檔 - *.jpg、*.bmp、*.gif ) 

 ./msg/  (預設訊息檔 - wincon.js 和 xxerror.htm) 
 

 whmi_filter.dll (3 個 DLL 檔) 

 login.dll 
 main.dll 
 

 index.htm  (預設首頁) 

 login.htm  (Web HMI 歡迎頁面) 

 menu.htm  (切換菜單頁面，一般在 IE 瀏覽器左邊) 

 main.htm  (登入成功的首頁) 
 

使用者可以將自己的圖片檔放在 “user_img” 資料夾，將自訂的 Java Script 檔或 CSS 檔放在 

“user_msg” 資料夾，其他的資料夾名稱是不被 WinPAC Web HMI 接受的。 

 

“index.htm” 檔是網路伺服器的預設首頁檔，使用者請勿修改。當使用者由 IE 瀏覽器造訪 WP-8x47，

“index.htm” 會在 1 到 2 秒間重新指引到 “login.htm” 檔。 

 

使用者可以修改 “login.htm”、“menu.htm” 與 “main.htm” 檔案以符合自己的需求。 

 

http://www.icpdas.com/en/product/guide+Remote__I_O__Module__and__Unit+Software__Support__+I-8K_I-87K__Software__Support
http://www.icpdas.com/en/product/guide+Remote__I_O__Module__and__Unit+Software__Support__+I-8K_I-87K__Software__Support
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5.2 Login.htm  

Login.htm 是使用者造訪網頁時的第一個歡迎頁面，可以修改自訂。以下是 login.htm 的基本程式碼。 

 
 

<html> 

<head> 

 

<title>Login</title> 

 

<meta http-equiv=pragma content=no-cache>    

 

<meta http-equiv="Content-Type" content="text/html; charset=UTF-8" > 

 

<script language="JavaScript"> 

var random_val=123; 

function get_random_val() 

{ 

  var rightNow = new Date();   

  random_val += 323456789*rightNow.getMinutes() +  

                         107654321*(rightNow.getTime()%1000); 

  setTimeout("get_random_val()"，197); // repeat call 

} 
 

//check if username and possword are empty 

function validate(fm)  

{ 

  setKey(fm); 

  return true; 

}  
 

//Embed key whille submitting 

function setKey(fm) 

{    

  var rightNow = new Date();   

  cookieVal = random_val+rightNow.getTime(); 

  fm.key_.value = cookieVal;   

}     

</script> 
 

</head> 

 

此行僅供 “Login.htm” 使用，請勿在其他頁面使用，

例如: “menu.htm”、“main.htm” 和 其他 .htm 頁面。 

請在此指定編碼語系。例如: 

英文: UTF-8 

繁體中文: big5 

簡體中文: gb2312 

或其他語言 
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<body onload="get_random_val()"> 

 

<div style="position: absolute; width: 332px; height: 34px; z-index: 5; left: 147px; top: 27px" 

id="layer1"> 

Welcome !</div> 

 

 

<div style="position:absolute; width:122px; height:38px; z-index:4; left: 171px; top: 95px;"  

id="layer2"> 

 

 

 

  <form name="form1" action="./login.dll" method="post"> 

     <input type="hidden" name="key_"> 

     <input type="submit" name="Submit" value="  Enter  " style="cursor:hand" onClick="return 

validate(this.form)">            

  </form> 

 

</div> 

  

</body> 

 

 

<!-- To ensure no-cache work --> 

<head> 

<meta http-equiv=pragma content=no-cache>    

</head> 

 

</html> 

 
 
 
 
 
 
 

以上為 login.htm 的基本程式碼。您可以自行插入更多圖像與文字，但是必需保留這些基本程式碼。 

 
 
 
 

 

Login.htm 一開始必需先呼叫 get_random_val( )， 

這是 Login.htm 的切入點。 

您的標題可放於此 

“form1” 是必需的 

您可修改 “Enter”，例如: 改為 “請進”，但需同時

配合修改本頁面開頭的語系設定 “charset”。 

此程式碼只供 “Login.htm” 使用，請勿應用到 

其他頁面，例如: “menu.htm”、“main.htm” 和 

其他 .htm 頁面。 
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5.3 Menu.htm  

注意: 

若您想了解詳細的多重頁面應用，WP-8x47 的 Demo 目錄裡有 2 個範

例: ...\isagraf_winpac_demo\wp_webhmi_demo\  wphmi_05 和 wphmi_05a 

“wphmi_05” 的切換菜單選項在左方，而 “wphmi_05a” 的在上方。 

 

“Menu.htm” 定義 Web HMI 的頁面選單，特別是多重頁面的應用。頁面選單只能放在左方或上方。 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

在左方: 

可以調整寬度與捲軸。 

寬度 

在上方: 

可以調整高度與捲軸。 

高度 
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以下為 menu.htm 的基本程式碼: 

 
<!-- top_or_left=1, scrolling=0, width=60, resize=1 --> 

 
 
 
 

<html> 

<head> 

<title>Title1</title>    

 

 

<meta http-equiv="Content-Type" content="text/html; charset=UTF-8" > 

 

<SCRIPT LANGUAGE="JavaScript" src="./msg/wincon.js"></SCRIPT>    

<SCRIPT LANGUAGE="JavaScript"> 

 

function start1() 

{ 

  A_11(); 

} 

 
function refresh_data() 

{ 

  if(run_at_pc==1) return;  

} 

 

</SCRIPT> 

</head> 

<body onload="start1()"> 

 
<!-- Logout button --> 

<form name="form_logout" method="post" action="./login.dll"> 

  <input style="cursor:hand" name="CMD" type="submit" value="Logout" onClick="return 

logout(this.form)"> 

</form> 

</body> 
</html> 
 
 
 
 
 
 

第一列並非註解，是用來定義頁面選單 : 

top_or_left: 位置。1: 在上方；0: 在左方 

scrolling: 捲動。1: 是；0: 否 

width: 菜單框架的寬度，0 – 999 (單位: 像素) 

resize: 調整大小。1: 是；0: 否 

請在此設定語系，例如 : 

 英文:  UTF-8 

 繁體中文: big5 

 簡體中文: gb2312 

 或其他語系 

本行在 menu.htm、main.htm 和

其他多重頁面都是必須的。 

start1( ) 是 menu.htm 的切入點 

form_logout 是登出按鈕 
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5.4 Main.htm  

 

5.4.1 一個簡單的 Main.htm 範例 

 

在製作複雜的 main.htm 之前，請先看一個簡單的 main.htm 範例，此範例只做一件事: 在成功登入

網頁時顯示 “Hello !” 訊息。 

 
 
<html> 

<head> 

<title>Title1</title> 

<meta http-equiv="Content-Type" content="text/html; charset=UTF-8" >   

 

<SCRIPT LANGUAGE="JavaScript" src="./msg/wincon.js"></SCRIPT>   

 

 

 

 

<SCRIPT LANGUAGE="JavaScript"> 

show_scroll_word(200,"Hello，Welcome to the Web HMI Sample !");   

 

 

function refresh_data() 

{ 

} 

 

</SCRIPT> 

</head> 

 

 

<body onLoad="init()"> 

 

 

<font color="blue" size="4">    

<div style="position: absolute; width: 353px; height: 24px; z-index: 1; left: 73px; top: 12px" id="layer1">   

Hello !</div> 

</font>    

 

 

</body> 

</html> 

 
 
 

在此處設定您的語系，例如: 英文: UTF-8、繁體中文: big5、

簡體中文: gb2312，或其他語系。 

此行在 menu.htm、main.htm 和其他多重頁面是必須的。 

呼叫 show_scroll_world( )可在 IE 瀏覽器底部顯示移動 

文字，200 表示 200 微秒，可以調整，例如: 500 微秒。 

當 IE 收到來自控制器的資料，會自動呼叫 refresh_data( ) 來

更新資料，依通訊品質不同而每隔 1.25 到 5 秒更新一次。 

init( ) 是 main.htm 與其他多重頁面的切入點。 

版面設計物件以 “<div>” 標籤開頭，以 “</div>” 標籤結尾， 

此處只顯示訊息 “Hello !”。 
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您可以在 WP-8x47 Demo 目錄裡找到 main.htm 檔案，並取代上述的 main.htm 檔案 。 

...\isagraf_winpac_demo\wp_webhmi_demo\sample   

 

然後，下載到 PAC  (請參閱 4.4.4 節)，當您成功登入時可以看到如下畫面。 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

如果您拔除電腦或 PAC 的 Ethernet 網路線，大約 10 秒鐘，會出現如下圖的斷線訊息 “Communication 

is temporary break now !”，再插回網路線，大約 10 到 45 秒會自動恢復通訊。 

 

 
 

如果斷訊超過 120 秒，會顯示下列訊息，請關閉再重開 IE 瀏覽器，再次登入。 

 

 
 
 
 
 

此處會顯示移動文字，因為有 

呼叫 show_scroll_world( )。 
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5.4.2 更多關於 refresh_data( ) 功能與動態資料 

注意: 程式碼、變數名稱與功能名稱的字母大小寫是不相同的， 例如: refresh_data( ) 是正確的， 

而 Refresh_data( ) 是不正確的。 

 

refresh_data( ) 功能必需一直放在 main.htm 和其他多重頁面中，當 IE 收到來自 PAC 的資料，會 

自動呼叫 refresh_data( ) 來更新資料，依通訊品質不同而每隔 1.25 到 5 秒更新一次。 

 

refresh_data( ) 通常用來更新動態資料，例如: ISaGRAF 專案中布林、整數、計時器、浮點數等變數

的值。 

 

要讓 IE 瀏覽器能接收 ISaGRAF 專案的資料，必需設定互不相同的 Modbus 網路位址編號 (請參閱 

4.1.5 節) 。Web HMI 只接收 1 到 1024 範圍的網路位址編號，資料若無網路位址編號 (No. = 0) 或 

編號不在許可範圍內 (1 ~ 1024)，IE 瀏覽器則無法接收該資料。 

 

main.htm 與其他多重頁面可以使用下列變數陣列存取 ISaGRAF 的資料 (注意大小寫不同)，[] 括號內

為對應的網路位址編號，例如: boolean_val[2] 表示 ISaGRAF 資料中網路位址編號指定為 2 的布林 

資料的值。 

 
 
 
 
 
 
 
 
 
 
 
 

接收 long integer (32-bit 整數) 值時，請使用 get_long_val( ) 功能，例如: get_long_val(11)、

get_long_val(13)、get_long_val(15) 。 

 
 
 
 
 

注意:  

ISaGRAF 專案的 long integer、timer 和 float 變數的網路位址編號必需佔用 2 個位址。  

(請參閱 ISaGRAF 進階手冊 - 4.2 節: http://www.icpdas.com/en/download/show.php?num=333 )  

 

這表示，如果您指定 Real 或 Timer 或 Integer 變數 (都是 32-bit 值，大於 32767 或小於 -32768) 的 

網路位址為 11，則下一個位址 12 不能再指定給任何 ISaGRAF 變數，必需從位址 13 開始指定。 

boolean_val ISaGRAF 的 boolean 值 

word_val ISaGRAF 的 word 值，-32768 ~ +32767 

float_val ISaGRAF 的 real 值， 例如: 1.234, -0.456E-02 

timer_val ISaGRAF 的 timer 值，單位: ms，最大 = 86399999 (< 1 天) 

string_val ISaGRAF 的 message 值，最大字串長度 255 

get_long_val(  ) ISaGRAF 的長整數值，-2147483648 ~ +2147483647 

http://www.icpdas.com/en/download/show.php?num=333
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5.4.2.1 顯示動態 Boolean 資料 
 

範例程式: whmi_02 與 whmi_05 (請參閱 3.1 節) 

再回頭來看 refresh_data function，如果要使用動態布林值，必需加入下列程式碼。 

 
… 
function refresh_data() 
 
 
{ 
  B1.src = "./img/circle_blue" + boolean_val[1] + ".jpg" ; 

} 
… 
 
<body onLoad="init()"> 
… 
 
<div style="position: absolute; width: 214px; height: 53px; z-index: 2; left: 102px; top: 79px"> 

<img name="B1" src="img/circle_blue0.jpg"></div> 

 
… 
</body> 
 
 
 
 

5.4.2.2 顯示動態 Float、Word、Timer 資料 
 

範例程式: wphmi_01、wphmi_03 與 wphmi_05  (請參閱 3.1 節) 

如果要顯示動態 float 值，必需使用下列程式碼。 

 
… 
function refresh_data() 
{ 
  F21.innerText = float_val[21] ; 
} 
… 
 
 

<body onLoad="init()"> 
… 
 
 
<div style="position: absolute; width: 214px; height: 53px; z-index: 2; left: 102px; top: 79px"> 

<b  id="F21"> xxxx </b> </div> 
 

… 
</body> 
 

在此定義圖片物件 “B1” 的動作， 

若 boolean_val[1]=1，“B1” 顯示 “img/circle_blue1.jpg” 圖片。 

若 boolean_val[1]=0，“B1” 顯示 “img/circle_blue0.jpg” 圖片。 

 

定義圖片物件 “B1” 的版面配置 (或位置)，使用 “<div>” 和 

“</div>” 標籤。 

在此宣告圖片物件 “B1”，使用 “img” 標籤 及 name= “B1”  src= …   

以 “src=” 定義 B1 的初始值。 

在此定義文字物件 “F21” 的動作， 

顯示 Word 資料請使用 “word_val[ ]”， 

顯示 Timer 資料請使用 “timer_val[ ]”， 

例如: F21.innerText = timer_val[21] + “  ms”; 

定義文字物件 “F21” 的版面配置 (或位置)， 

使用 “<div”   “</div>” 標籤。 

在此宣告文字物件 “F21”，使用 “<b” 標籤、id=”F21” 

和 “</b>” 標籤，F21 的初始值為 “xxxx”。 
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5.4.2.3 顯示動態 Long Integer 資料 

 

範例程式: wphmi_03 與 wphmi_05  (請參閱 3.1 節) 

如果要顯示動態 long integer (32-bit 格式) 值，必需使用下列程式碼。  
 

 
… 
function refresh_data() 
{ 
  L11.innerText = get_long_val(11) ; 
} 
… 
<body onLoad="init()"> 
… 
<div style="position: absolute; width: 214px; height: 53px; z-index: 2; left: 102px; top: 79px"> 
<b  id="L11"> xxx </b> </div> 
 
… 
</body> 
 
 
 
 
 
 

5.4.2.4 顯示動態 String 資料 

 

如果要顯示動態 string 值 (最長 255)，必需使用下列程式碼。  

 
… 
function refresh_data() 
{ 
  S31.innerText = string_val[31] ; 
} 
… 
 
<body onLoad="init()"> 
… 
 
<div style="position: absolute; width: 214px; height: 53px; z-index: 2; left: 102px; top: 79px"> 
<b  id="S31"> empty </b> </div> 
 
… 
</body> 
 
 
 
 
 
 

在此定義文字物件 “L11” 的動作 

定義文字物件 “L11” 的版面配置 (或位置)， 

使用 “<div” 與 “</div>” 標籤。 

在此宣告文字物件 “L11”，使用 “<b” 標籤、id=”L11” 與 

“</b>” 標籤，L11 的初始值為 “xxx”。 

在此定義文字物件 “S31” 的動作 

定義文字物件 “S31” 的版面配置 (或位置)， 

使用 “<div” 與 “</div>” 標籤。 

在此宣告文字物件 ““S31”，使用 “<b” 標籤、id=” “S31” 與 

“</b>” 標籤，“S31 的初始值為 “xxx”。 
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5.4.2.5 觸發 Boolean 物件的閃爍動作 

 

範例程式: wphmi_02 與 wphmi_05 (請參閱 3.1 節) 

 

當布林的值改變時，有的應用需要顯示一個閃爍的提醒訊息，例如:  當 boolean_val[12] 為 False，

表示正確而顯示 “OK”，當 boolean_val[12] 為 True，表示錯誤而顯示 “Error !”，使用者可能想要 

閃爍 “Error !” 訊息來吸引注意力。 

 

下列程式碼可做到這個閃爍動作。 

 
… 
var blink_period=500;   
 

setTimeout("blink_obj()"，blink_period);     

 
var B12_blink=0;   // init as 0:not blink 
var blink_step=0; 
 
function blink_obj() 
{ 
  if(blink_step==1) 
  { 
    blink_step=0; 
     
    if(B12_blink==1) 
    { 
      B12.innerText="Error !" ;   
      font_B12.color="red"; 
    } 
     
  } 
  else 
  { 
    blink_step=1; 
 
    if(B12_blink==1) 
    { 
      B12.innerText="" ; 
      font_B12.color="red"; 
    } 
 
  } 

  setTimeout("blink_obj()"，blink_period);    

} 
 
 
 
 
 

閃爍週期，單位: ms 

閃爍步驟 1: 

顯示 “Error !” ，紅色字型。 

閃爍步驟 2: 

顯示 “” (空白)，紅色字型。 

設定 timer 來控制閃爍動作 

1: 閃爍, 0: 不閃爍 
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…function refresh_data() 
{ 
 
  if(boolean_val[12]==0) 
  { 
    B12.innerText="Ok"; 
    font_B12.color="blue"; 
    B12_blink=0; 
  } 
  else 
  { 
    B12_blink=1; 
  }   
} 
… 
 

<body onLoad="init()"> 
… 
<div style="position: absolute; width: 214px; height: 53px; z-index: 2; left: 102px; top: 79px"> 
 

<font  id=”font_B12” color=”blue” size=”3”> 
 
<b  id="B12">OK</b>  
 
</font> 
 
</div> 
… 
</body> 
 
 

5.4.2.6 Float 值以固定的小數位數顯示 

 

範例程式: wphmi_06 與 wphmi_07 (請參閱 3.1 節) 
 

float_str1 (para1, para2) function 可以將 float 值轉換為小數位數固定的 string 值，並指定 “.” 小數點

記號後面的固定位數。 
 

para1 是要被轉換的 float 值，例如: 1.234567 

para2 是小數點記號 “.” 後面的位數，0 ~ 6 

例如:  float_str1(1.234567, 3)，傳回 “1.234” 

          float_str1(1.234567, 2)，傳回 “1.23” 

 
… 
function refresh_data() 
{ 
  F21.innerText = float_str1( float_val[21], 3) ; 
} 
 

在此定義文字物件 “B12” 的版面配置(或位置)，使用 

“<div” 與  “</div>” 標籤。 

“<font>“ 與 “</font>” 標籤用來控制字型的顏色與大小。 

在此宣告文字物件 “B12”，使用 “<b” tag、id=”B12” 與 

“</b>” 標籤，B2 的初始值是 “OK”。 

在此定義文字物件 “B12” 的動作。 

若 boolean_val[12]=0，不閃爍。 

若 boolean_val[12]=1，閃爍。 

將網路位址編號 21 的 float 值轉換為  

“.” 小數點後有 3 位數的 string 值。 
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5.4.3 發送資料到 PAC  

前一節 (5.4.2 節) 說明了如何取得與顯示來自 PAC 的資料，本節著重於如何將資料發送到 PAC ， 

換句話說，就是要透過 IE 瀏覽器控制 PAC。 

 

要在 ISaGRAF 專案中設定一個 boolean/ word/ long integer/ float/ timer/ string 變數的新值，需要在

main.htm 或其他多重頁面中加入 “form” 物件，如下: 

 
 
 
 
 
<form  name="form_L21"  method="post"  action="./main.dll"> 

  <input  name="BEGIN"  type="hidden"> 

  <input  name="L21"  type="text"  size="8"  value="xxx">  

  <input  name="END"  type="hidden"> 

</form> 

 
 
 
 
 
 
 

用來控制 PAC 資料的 “<input>” 名稱必需依循下列格式，字母後面的數字必需在 1 到 1024 之間，

這個數字用來指向 ISaGRAF 專案中相同數字的 Modbus 網路位址編號的變數名稱。 

 
 
 
 
 
 
 
 
 
 
 

注意:  

ISaGRAF 專案中的 long integer、timer 和 float 變數，其網路位址編號需佔 2 個位址編號。 

(參閱 “ISaGRAF 進階使用手冊” - 4.2 節: http://www.icpdas.com/en/download/show.php?num=333) 

 

這表示，如果您指定網路位址編號 = 11 給 Real 變數 (或 Timer 或 integer 都是 32-bit 值 – 大於 32767

或小於 -32768)，那麼下一個位址 12 就不能再指定給任何 ISaGRAF 專案變數，而必需從 No.=13 來

指定。 

 
 

B 指向 ISaGRAF 的 boolean 資料，例如: B5, B109 

W 指向 ISaGRAF 的 word 資料 (-32768 ~ +32767)，例如: W9, W1001 

L 指向 ISaGRAF 的 long integer 資料 (-2147483648 ~ +2147483647), 如: L21 

 “L” 同時也指向 ISaGRAF 的 timer 資料 

F 指向 ISaGRAF 的 real 資料，例如: F13, F235 

S 指向 ISaGRAF 的 message 資料，例如: S18 

此 form 的名稱；method 一定要用 “post”；action 一定要用“./main.dll” 

 

在 form 裡，第一個 “<input>”，

名稱必需是 “BEGIN”(大寫)，

type 必須是 “hidden”。 

在 form 裡，最後的 “<input>” 名稱必需

是 “END” (大寫)，type 必須是 “hidden”。 

在“BEGIN” 與 “END” 中間的所有 “<input>” 就是

要發佈到控制器的資料。 

http://www.icpdas.com/en/download/show.php?num=333
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5.4.3.1 發送 Boolean 值到 PAC  
 

 

A. 以圖片發送 

… 
function ON_OFF (form_obj, obj, current_boo_value) 
{ 
  if(current_boo_value==0)   
  { 
    flag = confirm("turn ON?"); 
    if(flag) obj.value=1; 
  }  
  else 
  { 
    flag = confirm("turn OFF?"); 
    if(flag) obj.value=0; 
  } 
  if(flag) 
  { 
   if(GetUserID(form_obj)==true) form_obj.submit(); 
  }  
} 
function refresh_data() 
{ 
  B2.src = “img/cmd” + boolean_val[2] + “.jpg” ; 
} 
… 
 

<body onLoad="init()"> 
… 
 

<div style="position: absolute; width:100px; height:100px; z-index: 5; left: 242px; top: 164px" > 
 
 
 
 

<img style="cursor:hand" name="B2"  onclick="ON_OFF(form_B2, form_B2.B2, boolean_val[2])"   
src="img/cmd0.jpg"> 
 
 
 
 
 
 

 

<form name="form_B2" method="post" action="./main.dll"> 

    <input name="BEGIN"  type="hidden"> 

    <input name="B2"     type="hidden" value="0"> 

    <input name="END"    type="hidden"> 

</form> 

</div> 

… 
</body>

範例程式: vphmi_02  與  vphmi_05  

ON_OFF function 是將當前的布林值發送到 PAC。 

第一個參數是 “form” 的名稱。 

第二個參數是 form 裡面 “<input>” 的名稱。 

最後的參數是目前的布林值。 

顯示目前布林圖片，此例:   

0: 顯示 “img/cmd0.jpg” ; 1: 顯示 “img/cmd1.jpg” 

此處以“<div” 及 “</div>” 標籤定義圖片物件 

“B2” 的版面配置 (或位置)。 

當進入圖片區時，“cursor:hand” 會將滑鼠指標顯示為手的圖片物件 (名稱: "B2")。 

當滑鼠點選時, “onclick” 會呼叫 ON_OFF( )， 

第一個參數是 “form” 的名稱，此例為 “form_B2”。 

第二個參數是 form 裡面“<input>” 的名稱，此為 “form_B2.B2” 

最後的參數是目前布林值，此為 boolean_val[2]。 Form 的名稱 

Form 裡面 “<input>” 的名稱，此例為 “B2”，因為它在 “form_B2” 裡， 

所以定義為 “form_B2.B2”。 
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B. 以按鈕發送 
 

function ON_(form_obj, obj) 
{ 
  flag = confirm("turn ON?"); 
  if(flag)  
  { 
    obj.value=1; 
    if(GetUserID(form_obj)==true) form_obj.submit(); 
  } 
} 
function OFF_(form_obj, obj) 
{ 
  flag = confirm("turn OFF?"); 
  if(flag)  
  { 
    obj.value=0; 
    if(GetUserID(form_obj)==true) form_obj.submit(); 
  } 
} 
function refresh_data() 
{ 
  B2.src = "img/big_Tcircle_red" + boolean_val[2] + ".jpg" ; 
} 
… 
 

<body onLoad="init()"> 
… 
<div style="position: absolute; width: 56px; height:40px; z-index: 5; left: 82px; top: 69px" > 
<img name="B2" src="img/big_Tcircle_red0.jpg"> 
</div> 
 

<div style="position:absolute; left:85px; top:124px; width:42px; height:27px;"> 
<input type="button" value="ON" style="cursor:hand" onClick="ON_(form_B2, form_B2.B2)">  
 
 
 
 

<form name="form_B2" method="post" action="./main.dll"> 

    <input name="BEGIN"      type="hidden"  value="">  

    <input name="B2"        type="hidden"  value="1"> 

    <input name="END"       type="hidden"  value="">  

</form> 

</div> 

 
 
<div style="position:absolute; left:85px; top:166px; width:47px; height:31px"> 
<input type="button" value="OFF" style="cursor:hand" onClick="OFF_(form_B2, form_B2.B2)"> 
</div> 
… 
</body> 
 

“ON_”  function 用於當布林值為 “True”，將值發送到控制器。 

“OFF_” function 用於當布林值為 “Fasle”，將值發送到控制器。 

此處以 “<div” 及 “</div>” 標籤定義圖片物件 “B2” 的版面配置(或位置)。 

顯示目前的布林圖片，此例中: 

0: 顯示 “img/big_Tcircle_red0.jpg” 

1: 顯示 “img/ big_Tcircle_red1.jpg” 

以此按鈕呼叫 ON_( ),  第一個參數是 form 的名稱，此例為 “form_B2”; 

第二個參數是 form 裡“<input>”的名稱, 此為 “form_B2.B2” 

以此按鈕來呼叫 OFF_( ). 第一個參數是 form 的名稱，此例為 “form_B2”; 

第二個參數是 form 裡“<input>”的名稱，此為 “form_B2.B2”。 

Form 裡面“<input>”的名稱，此例為“B2”，因為它在 “form_B2” 裡， 

所以定義為 “form_B2.B2”。 

範例程式: vphmi_02 與 vphmi_05  
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5.4.3.2 發送 Word、Long、Float、Timer 及 String 的值到 PAC  

… 
function Check(form_obj) 
{  
  flag = confirm("Are you sure?");  
  if(flag) 
  { 
    if(GetUserID(form_obj)==false) { return false; }   
    form_obj.submit(); 
    return true;  
  } 
  else 
  {  
    return false;  
  } 
} 
 

 
function refresh_data() 
{ 
  L15.innerText=get_long_val(15);    
  F17.innerText=float_val[17];    
} 
… 
 

<body onLoad="init()"> 
… 
 

<div style="position: absolute; width: 195px; height: 25px; z-index: 2; left: 45px; top: 52px" > 

L15 = <b id="L15">xxxx</b></div> 

<div style="position: absolute; width: 196px; height: 29px; z-index: 3; left: 45px; top: 82px" > 

F17 = <b id="F17">xxxx</b></div> 
 

<div style="position:absolute; left:47px; top:131px; width:204px; height:60px"> 

  <form name="form1" method="post" action="./main.dll"> 

    <input name="BEGIN"  type="hidden"  value="">  

    <input name="L15"    type="text"    value="Enter long val (L15)"> 

    <input name="F17"    type="text"    value="Enter float val (F17)"> 

    <input name="END"    type="hidden"  value="">  

  </form> 

</div> 

 

 

<div style="position:absolute; width:74px; height:31px; left: 234px; top: 150px;"> 

  <input type="button" style="cursor:hand" onClick="return Check(form1)"  value="Enter"> 

</div> 

… 
 

</body> 

 

範例程式:  

wphmi_03,  wphmi_04, wphmi_05,  

wphmi_06 與 wphmi_07 

Check( ) 可用來發送任一 “form”。 

在此顯示動態值: 

若資料為 word，請使用 word_val[  ] 

若資料為 timer，請使用 timer_val[  ] 

若資料為 string，請使用 string_val[  ] 

當滑鼠點選按鈕，就會呼叫 

Check( ) 把資料發送到控制器。 

當滑鼠進入按鈕區，“cursor:hand” 

會將滑鼠鍵頭會顯示為手的形狀。 

輸入 “form1” 裡面的文字 L15 和 F17，若資料為 timer，

請使用 “L”，為 word 請用 “W”，為 string 請用 “S”。 

此處以“<div”  “</div>” 標籤定義文字物件

“L15” 和 “F17” 的版面配置(或位置)。 
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5.5 多重頁面 (multi-pages) 

WP-8x47 的 Web HMI 支援多重頁面應用，請參閱第 3 章: – 範例 “wphmi_05”。 

 
 

5.5.1 Level2 與 Level3 頁面 

 

多重頁面的名稱可以是 html 檔的任何有效檔名， 

如: “page2.htm”、“kitchen.htm”、“u2-page4.htm”。 

 

若以 “u2-” 檔名開頭，就稱為 Level2 頁面，如: “wphmi_05” 裡的 “u2-Page4.htm”。 

若以 “u3-” 檔名開頭，就稱為 Level3 頁面，如: “wphmi_05” 裡的 “u3-time.htm”。 

 

什麼是 Level2 頁面? 即，使用者需以中 (middle) 或高 (high) 優先權登入才能存取的頁面，而要存取

Level3 頁面，則必需以高優先權登入。頁面名稱沒有 “u2-” 和 “u3-” 就稱為 Level1 頁面，任何人 

登入成功就能執行該頁面，例如: “main.htm”。 

 

其他多重頁面的規則幾乎與 “main.htm” 的規則相同 (請見 5.4 節) 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

注意:   

如果沒有勾選 “Enable Account Security”， 

任何人都能透過 IE 操控您的 PAC ! 

1. 

2. 

3. 4. 
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5.5.2 切換頁面 

 

請看下列範例 “wphmi_05” 的 “menu.htm”、“goto_R_page( )” function 可以用來切換頁面。 

 

<!-- top_or_left=0 ，scrolling=0 ，width=110 ，resize=1 --> 

 
<html> 
<head> 
<title>Title1</title>    
<meta http-equiv="Content-Type" content="text/html; charset=big5" > 
<SCRIPT LANGUAGE="JavaScript" src="./msg/wincon.js"></SCRIPT>    
 
<SCRIPT LANGUAGE="JavaScript"> 
function start1() 
{ 
  A_11(); 
} 
function refresh_data() 
{ 

  if(run_at_pc==1) return;  // if simulate at the PC，just return 

  … 
} 
</SCRIPT> 
</head> 
<body onload="start1()"> 
 
<!-- Logout button --> 
<form name="form_logout" method="post" action="./login.dll"> 
  <input style="cursor:hand" name="CMD" type="submit" value="Logout" onClick="return 
logout(this.form)"> 
</form> 
<br/> 
<br/> 
 
<!-- Goto main.htm --> 

<A style="cursor:hand" onClick="goto_R_page('main.htm')">第 1 頁</A> 

<br/> 
<br/> 
 
<!-- Goto kitchen.htm --> 
<A style="cursor:hand" onClick="goto_R_page('kitchen.htm')">Kitchen</A><br/> 
<br/> 
<br/> 
 
 
 
 
 

切換到 “main.htm” 頁面。 

切換到 “kitchen.htm” 頁面。 

當滑鼠進入按鈕區，“cursor:hand” 

會將滑鼠箭頭顯示成手的形狀。 
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5.6 網路安全防護 

有幾種方式可以經由乙太網路來存取 WP-8x47 內的資料。 

 

1) 使用 Modbus TCP 通訊協定，port 編號 502 (ISaGRAF 與其他 HMI 用此方式) 

2) 使用 FTP (例如: 在 IE 瀏覽器網址輸入 “ftp://10.0.0.103”) 

3) 使用 Telent (例如: 在 PC 開啟一個 “command” 視窗，輸入 “telnet 10.0.0.103”) 

4) 使用 Web Server (WinPAC 的 Web HMI 用此方式) 

 

為了安全考量，請在 ISaGRAF Driver 視窗的 Web 頁面，取消勾選選項 2、3 的功能，如下: 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

並點選 Settings... 按鈕來設定 Web HMI 的 Username 及 Password。 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

點選以關閉功能 

點選以設定使用者

名稱及密碼。 
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關於方法 1，您最多可開放 8 組 IP  位址，讓 ISaGRAF 或其他 HMI 可透過 Modbus TCP 通訊協定 

來存取 WP-8x47，如下圖。 

 

請在 ISaGRAF IO 連結視窗連結 “vip” 功能，並輸入允許連到 PAC 的 IP。若無使用 “vip” 功能，表示

任何遠端 IP 都可透過 Modbus TCP/IP 通訊協定連進來 PAC，若使用 “vip” 功能，但沒設定 IP (都為 

“N/A”)，則沒有任何 TCP 裝置可以連進來。 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

若您修改了 I/O 連結設定，請再次編譯您的 ISaGRAF 專案並下載到 PAC 中。 



快速上手手冊: WP-8147/8447/8847, 2020 年 10 月, 2.0 版                       6-1 

第 6 章 使用 VB.net 2008 程式來讀/寫 ISaGRAF 變數 

重要: 

請將開發好的 .net 程式 與 資料檔存放在  \Micro_SD 內，而不要存放在 \System_Disk 內。因為 

\System_Disk 使用的是 NOR Flash 記憶體，它主要是給 OS、ISaGRAF Driver 與一些必要的 Utility 與 

DLL 存放使用，容量不大。 

 

而且，請勿常常去更新 NOR Flash 記憶體的資料，久了容易損壞。若常常在 \System_Disk 內 

更新檔案 (例如: 每 1 ~ 5 秒就更新一次，一天下來就更新了約幾萬次)，資料會容易受損。所以 

自行開發的程式 與 要操作的檔案，最好都存放在 \Micro_SD 內。 

 

本章以 Visual Studio .NET 2008 開發工具建立一個範例程式的方式來說明，範例: 

 

Demo 目錄 : ...\isagraf_winpac_demo\vb.net_2008_demo 

wp_vb01: 數位 I/O 範例，搭配 I-87055W 模組 (於插槽 0) 。  

wp_vb02: 類比 I/O 範例，搭配 I-87024W (插槽 1) 與 I-8017HW (插槽 2) 模組。 

wp_vb03: 讀/寫 ISaGRAF Internal Integer，Timer 及 Real 變數 (無需 I/O 模組) 。 

 

對應的專案範例檔名: "wp_vb01.pia"，"wp_vb02.pia"，"wp_vb03.pia" (同目錄) 

 
 

 

6.1 建立新專案 

1. 開啟微軟 Visual Studio .NET 2008 軟體，點選 [File] > [New Project] 
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2. 點選 [Smart Device] > [.NET frame work 2.0] > [Smart Device Project]，在下方輸入專案名稱 (本例: 

project1)，然後按 “OK”。 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

3. 點選 [Device Application] > [Windows CE] > [.NET Compact Framework Version 2.0]，然後點選 

“OK”。 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

1. 

2. 

3. 

4. 

5. 

1. 

2. 

3. 

4. 



快速上手手冊: WP-8147/8447/8847, 2020 年 10 月, 2.0 版                       6-3 

6.2 加入專案參考 

“QuickerNet” library 包含了所有模組的 Function，在程式裡使用 “Quicker” 關鍵字之前，您必需在 

應用程式的參考清單裡加入參考: “QuickerNet.dll”。 

 

1. 滑鼠右鍵點擊 “Solution Explorer” 視窗裡的專案名稱， 

選擇 “Add Reference …” 

 

2. 點選 “mscorlib”，按 “OK”。 (“mscorlib” 出現在 .NET 的

Component Name 區) 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

3. 點選 “Browse” 頁籤，“搜尋位置” 請切換到 WP-8x47  的 Demo 目

錄: ...\isagraf_winpac_demo\vb.net_2008_demo\wp_vb01\vb01\，選擇 “QuickerNet.dll”，按 

“OK”。 

 
 
 
 
 
 
 
 
 
 

 
 
 
 

 

滑鼠右鍵 
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4. 加入 “mscorlib” 及 “QuickerNet.dll” 後，請雙擊專案的 “My Project”，並點選 “References” 確認

是否已加入 “QuickerNet.dll”。 

 
 
 
 
 
 
 
 
 

 
 

 
 
 
 
 

 

5. 以滑鼠右鍵點選 “Form1.vb”，選擇 “View Code”，在第一、二行插入 “Option Explicit On” 與 

“Imports Quicker” (如下圖) 。 

 
 
 
 
 
 
 
 
 
 
 

 
 
 

接著您就可以在您的 VB 表格中設計所需的物件與動作了。 

 
 
 
 
 
 
 
 
 
 
 
 

 

滑鼠雙擊 

1. 

2. 

滑鼠雙擊 
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6.3 編譯應用程式 

程式撰寫完成後，請依下列步驟建置(build)一個應用。 

 

1. 請記得隨時按下 “Save All” 按鈕來存檔。 

 
  
 
 
 
 
 
 
 
 

2. 編譯 (即建置) 此專案，下方的 “Error List” 視窗會列出建置結果。 

 
 
 
 

 
 
 
 
 
 
 
 
 
 
 

3. 在下列資料夾中，可以找到執行檔: 

 

 <您的 VB.net 專案資料夾> \bin\Release\ <project_name>.exe 

 請將此執行檔複製到 PAC 的 \System_Disk\ISaGRAF\ 目錄下來執行。 

 
 

注意:  使用者可複製 VB.net 的執行檔到其他目錄下執行，但是要同時複製 “QuickerNet.dll”、

“Quicker.dll” 與 “Mscorlib.dll” 檔  3 個 DLL 檔案，否則執行會有錯誤。 

 

例如: 若要在 \Micro_SD\ 目錄下執行 project1.exe，則該目錄必需有下列檔案，即 

“project1.exe”、“QuickerNet.dll”、“Quicker.dll” 與 “Mscorlib.dll” 檔 (可在 PAC 的 

“\System_disk\ISaGRAF\” 目錄下取得此 3 個 DLL 檔案。 
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6.4 QuickerNET.DLL  

本節著重在 QuickerNET.DLL 的 function 應用 與 範例說明，有許多的 function 可用來讀/寫資料 

從/到 ISaGRAF PAC 。 

 

QuickerNET.DLL 的 function 可以分為兩大類:  

 

1. 數位 讀/寫 Function 

2. 類比 讀/寫 Function 

 
 

6.4.1 數位 (Digital) 讀/寫 函式 

  

■ UserSetCoil 
 

說明:  

用來設定 Boolean 值，到指定 Modbus 位址的 Boolean 變數。 

 

語法:  

UserShare.UserSetCoil ( iUserAddress As System.UInt16, iStatus As byte)  

 

參數:  

iUserAddress: 指定變數的 Modbus 位址 (1 ~ 8191) 

iStatus: 設定變數的狀態 (iStatus = 1 表示 True；iStatus = 0 表示 False) 

 

回傳值:  

無 

 

範例:  

‘ 設定 Modbus 網路位址 “1” 的 output 變數為 True。 

UserShare.UserSetCoil (Convert.ToUInt16(1), 1)  
 

範例程式 :  

Demo 目錄:  ...\isagraf_winpac_demo\vb.net_2008_demowp_vb01 
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■ UserGetCoil 

 

說明:  

用來讀出指定 Modbus 位址的 Boolean 變數值。 

 

語法:  

UserShare.UserGetCoil ( iUserAddress As System.UInt16, ByRef iStatus As byte)  

 

參數:  

iUserAddress : 指定變數的 Modbus 位址 (1 ~ 8191) 

iStatus : 取得變數的狀態 (iStatus = 1 表示 True；iStatus = 0 表示 False) 

 

回傳值:  

無 

 

範例:  

‘ 取得 Modbus 位址 “1” 的變數狀態。  

Dim iStatus As Byte  
UserShare.UserGetCoil(Convert.ToUInt16(1), iStatus)  
 

範例程式 :  

Demo 目錄:  ...\isagraf_winpac_demo\vb.net_2008_demowp_vb01 
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6.4.2 類比 (Analog) 讀/寫 函式 

■ UserSetReg_short ■ UserSetReg_long ■ UserSetReg_float 

 

說明:  

用來設定 16-bit short integer、32-bit long integer 及 32-bit float 值，到指定 Modbus 位址的變數。 

 

語法:  

UserShare.UserSetReg_Short (ByVal iUserAddress As System.UInt16, ByRef iStatus As Integer) As 
Byte 
 

UserShare.UserSetReg_Long (ByVal iUserAddress As System.UInt16, ByRef iStatus As Integer) As 
Byte 
 

UserShare.UserSetReg_Float (ByVal iUserAddress As System.UInt16, ByRef iStatus As Single) As 
Byte 

 

參數:  

iUserAddress: 指定變數的 Modbus 位址編號 (1 ~ 8191) 

iStatus: 設定 short / long integer 或 float 值 

 

範例:  

‘ 設定 long 值 “1234567”，到 Modbus 位址 “1” 的變數。 

UserShare.UserSetReg_long (Convert.ToUInt16(1), Convert.ToInt32(1234567))    
 

‘ 設定 short 值 “-1234”，到 Modbus 位址 “3” 的變數。 

UserShare.UserSetReg_short (Convert.ToUInt16(3), Convert.ToInt16(-1234))    
 

‘ 設定 float 值 “2.174”，到 Modbus 位址 “4” 的變數。 

UserShare.UserSetReg_float (Convert.ToUInt16(4), Convert.ToSingle(2.174))    
 

範例程式:  

Demo 目錄:   

1. 讀/寫 類比 I/O: ...\isagraf_winpac_demo\vb.net_2008_demowp_vb02 

2. 讀/寫 internal long integer、Timer 及 Real (浮點數) 的

值: ...\isagraf_winpac_demo\vb.net_2008_demowp_vb03 

 
 

注意:  ISaGRAF 專案中，long integer、timer 及 real 變數必需佔用 2 個網路位址編號。  

(參閱 “ISaGRAF 進階使用手冊” - 4.2 節: http://www.icpdas.com/en/download/show.php?num=333) 

http://www.icpdas.com/en/download/show.php?num=333
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■ UserGetReg_short ■ UserGetReg_long ■ UserGetReg_float 

 

說明:  

用來讀出指定 Modbus 位址的 16-bit short integer、32-bit long integer 及 32-bit float 的值。 

 

語法:  

UserShare. UserGetReg_Short (ByVal iUserAddress As System.UInt16, ByRef iStatus As Integer) As 
Byte 
 
UserShare. UserGetReg_Long (ByVal iUserAddress As System.UInt16, ByRef iStatus As Integer) As 
Byte 
 
UserShare. UserGetReg_Float (ByVal iUserAddress As System.UInt16, ByRef iStatus As Single) As 
Byte 

 

參數:  

iUserAddress: 指定變數的 Modbus 位址 (1 ~ 8191) 

iStatus: 取得 short / long integer 或 float 值 

  

範例:  

Dim float_val As Single 
Dim short_val As Int16 
Dim long_val As Int32 
  

‘ 取得 Modbus 位址 “7” 的 float 變數值。 

UserShare.UserGetReg_float (Convert.ToUInt16(7), float_val)  
 

‘取得 Modbus 位址 “9” 的 long 變數值。 

UserShare.UserGetReg_long (Convert.ToUInt16(9), long_val)  
 

‘取得 Modbus 位址 “11” 的 short 變數值。 

UserShare.UserGetReg_short (Convert.ToUInt16(11), short_val)  
 

範例程式:  

Demo 目錄:   

1. 讀/寫 類比 I/O: ...\isagraf_winpac_demo\vb.net_2008_demowp_vb02 

2. 讀/寫 internal long integer、Timer 及 Real (浮點數) 的

值: ...\isagraf_winpac_demo\vb.net_2008_demowp_vb03 

 

注意:  ISaGRAF 專案中，long integer、timer 及 real 變數必需佔用 2 個網路位址編號。  

(參閱 “ISaGRAF 進階使用手冊” - 4.2 節: http://www.icpdas.com/en/download/show.php?num=333)   

http://www.icpdas.com/en/download/show.php?num=333
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第 7 章 使用 EVC++ 程式來讀/寫 ISaGRAF 變數 

重要: 

請將開發好的 .net 程式 與 資料檔存放在  \Micro_SD 內，而不要存放在 \System_Disk 內。因為 

\System_Disk 使用的是 NOR Flash 記憶體，它主要是給 OS、ISaGRAF Driver 與一些必要的 Utility 與 

DLL 存放使用，容量不大。 

 

而且，請勿常常去更新 NOR Flash 記憶體的資料，久了容易損壞。若常常在 \System_Disk 內 

更新檔案 (例如: 每 1 ~ 5 秒就更新一次，一天下來就更新了約幾萬次)，資料會容易受損。所以 

自行開發的程式 與 要操作的檔案，最好都存放在 \Micro_SD 內。 

 
 

使用者可撰寫 EVC++ 4.0 應用程式來讀/寫 ISaGRAF 變數，透過本章介紹的 function 可讀/寫 

boolean、word、long 及 float 值。 

 

設計時所需的 標頭檔 與 函式庫 為 “WinConAgent.h” 與 “Quicker.lib”。您可在 PC 上的 WP-8x47 

Demo 目錄內 (..\isagraf_winpac_demo\evc++_lib\) 找到檔案。 

 

執行時需要的 DLL 為 “Quicker.dll” (PAC 目錄: \System_Disk\isagraf\) 。 

 

請將編譯成功的執行程式檔，複製到 WinPAC 的目錄: \System_Disk\isagraf\ 並執行。 

 
 



快速上手手冊: WP-8147/8447/8847, 2020 年 10 月, 2.0 版                       7-2 

寫入 boolean 值 : 

 

unsigned char UserSetCoil(unsigned short iUserAddress, unsigned char iStatus); 

 

 iUserAddress: 1 ~ 8191  (ISaGRAF 專案中，變數的網路位址編號) 

 iStatus:    0: 寫入 boolean 值 False；1: 寫入 boolean 值 True 

 

 例如:   

  UserSetCoil(100, 1)  // 將 True 值寫入位址編號 “100” 的變數 

 
 

寫入 word 或 float 或 long 值 : 

 

 

 iUserAddress:  1 ~ 8191  (ISaGRAF 專案中，變數的網路位址編號) 

 iStatus:   long 型態的指標，用來儲存要寫入的資料 

 iDType 0: 資料型態為 word  

  1: 資料型態為 float  

  2: 資料型態為 long  (ISaGRAF 裡 Timer 值的型態: long，單位: ms) 

 例如: 

  float   float_val; 

  long   word_val，long_val; 

  long   *temp_val; 
 

  // 把 word_val (-32768 ~ +32767) 寫入網路位址編號 1 的 ISaGRAF 變數 

  word_val = -20000 ; 
  temp_val = (long *)(&word_val); 
  UserSetReg(1, temp_val, 0); 
 

  // 把 float_val 寫入網路位址編號 2 的 ISaGRAF 變數 

  float_val = 1.2345 ; 
  temp_val = (long *)(&float_val); 
  UserSetReg(2, temp_val, 1); 
 

  // 把 long_val 寫入網路位址編號 4 的 ISaGRAF 變數 

  long_val = 12345678 ; 
  temp_val = (long *)(&long_val); 
  UserSetReg(4, temp_val, 2); 
 
 

unsigned char UserSetReg(unsigned short iUserAddress, long *iStatus, unsigned char iDType); 
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讀出 boolean 值 : 

 

 

 iUserAddress: 1 ~ 8191  (ISaGRAF 專案中，變數的網路位址編號) 

 iStatus:    0: 布林為 False；1: 布林為 True 

 

 例如:   

  unsigned char bVal; 

  UserGetCoil(5, &bVal)  // 把布林值寫入網路位址編號 5 

 
 

讀出 word 或 float 或 long 值 : 

 

 

 iUserAddress: 1 ~ 8191  (ISaGRAF 專案中，變數的網路位址編號) 

 iStatus:   long 型態的指標，用來儲存回傳的資料 

 iDType 0: 資料型態為 word  

  1: 資料型態為 float  

  2: 資料型態為 long  (ISaGRAF 裡 Timer 值的型態: long，單位: ms) 

 例如: 

  float   float_val; 

  long   word_val，long_val; 

  long   ret_val; 
 

       // 取得網路位址編號 10 的 ISaGRAF 變數 word_val (-32768 ~ +32767) 

  UserGetReg(10, &ret_val, 0); 
  if ( ret_val>=0  &&  ret_val<=32767 )  word_val = ret_val; 
  else  word_val = ret_val  |  0xFFFF0000; 
 

  // 取得網路位址編號 11 的 ISaGRAF float 變數 

  UserGetReg(11, &ret_val, 1) ; 
  float_val = *(float *) (&ret_val) ; 
 

  //取得網路位址編號 13 的 ISaGRAF long 變數 

  UserGetReg(13, &ret_val, 2) ; 
  long_val = ret_val ; 
 

注意:  ISaGRAF 專案中，long integer、timer 及 real 變數必需佔用 2 個網路位址編號。  

(參閱 “ISaGRAF 進階使用手冊” - 4.2 節: http://www.icpdas.com/en/download/show.php?num=333) 

unsigned char UserGetCoil(unsigned short iUserAddress, unsigned char *iStatus); 

unsigned char UserGetReg(unsigned short iUserAddress, long *iStatus, unsigned char iDType); 

http://www.icpdas.com/en/download/show.php?num=333
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第 8 章 使用 InduSoft 專案來讀/寫 ISaGRAF 變數 

注意: 

 

如果 HMI 程式運作不順或通訊遲緩，請參閱附錄 F。 

WinPAC-8xx7 (或 WP-8x47) 為 WP-8147/8447/8847 的簡稱。 

WinPAC-8xx6 (或 WP-8x46) 為 WP-8146/8446/8846 的簡稱。 

 

重要:  

 

1. WP-8x47/8xx6 需設定為固定 IP 位址。 (不可使用 DHCP) 

2. 建議使用工業級乙太網路交換器 NS-205/208 或 RS-405/408 來連接 PAC。 

3. 詳細資料，請參考網站上的 “ISaGRAF 進階使用手冊”: 

http://www.icpdas.com/en/download/show.php?num=333 

4. WinPAC-8xx6 可支援 InduSoft 與 ISaGRAF 同時運行於 PAC 中。 

 
 
 
 

 PAC 同時執行 InduSoft 與 ISaGRAF 的簡單範例: 

 

步驟 1: 建立新的 ISaGRAF 專案 

 

本範例使用 WP-8xx6 + I-87055W DI/DO 模組 (插槽 0) + I-87024W AO 模組 (插槽 2)，以及一個 internal 

變數，ISaGRAF 變數定義如下: 

 
 

變數型態 名稱 網路位址編號 說  明 屬性 

Boolean DI_1 1 87055W DI 點 1 Input 

Boolean DO_1 11 87055W DO 點 1 Output 

Integers AO_1 21 87024W AO 點 1 Output 

Integers Internal 31 內部變數 Internal 

 
 

若您不熟悉 ISaGRAF 設定步驟，請參閱本手冊 4.1 節到 4.3 節。 

 

並設定 I/O 的連接，如下圖:  

 
 

http://www.icpdas.com/en/download/show.php?num=333
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設定 I/O 的連接，如下圖:  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
要與 InduSoft 交換的 ISaGRAF 變數，必需宣告其 Modbus “網路位址”，方法如下:  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

請存檔並編譯此 ISaGRAF 專案，然後

下載到 PAC ，若不熟悉步驟，請參閱

本手冊 4.1 節到 4.3 節. 
 
 
 
 
 
 
 
 
 
 
 

2. 

可使用空的 LD 程式 1. 

3

. 

1. 

2. 

3. 

設定編號為十進位 

“Decimal” 
 

本範例請設定 

編號 1   給 DI_1 

編號 11 給 DO_1 

編號 21 給 AO_1 

編號 31 給 Internal 
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步驟 2: 建立 InduSoft 專案 
 

1. 開啟 “InduSoft Web Studio”，點選 [File] > [New]。  

2. 出現 “New” 視窗，請點選 “Project” 頁籤，在 “Project name” 欄位輸入要建立的專案名稱， 

在 “Product type” 項目選擇 “Windows Embedded Lite” ，按 “OK” . 

3. 出現 “Project Wizard” 視窗，請選擇 “Template” 的 “Empty Application”，“Resolution” 的 “320 x 

240” 及 “Shared Tags” 的 “None”。  

4. “Project Explorer” 視窗出現您的新專案 (如下圖) 。 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

1. 

2. 

3. 

4. 
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定義應用標籤 
 
點選功能表 [Insert] > [Tag]。 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
出現 “New Tag” 視窗。 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
本範例使用一個 DI/DO 模組 I-87055W，一個 AO 模組 I-87024W 與一個 internal 變數，變數定義 

如下，請一一建立下列標籤。 
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建立主螢幕  

1. 點選 “Project Explorer” 視窗的 “Graphics” 頁籤。 

2. 再以滑鼠右鍵點選 “Screens” 的 “Insert” ，會出現 “Screen Attributes” 視窗。 

3. 設定螢幕屬性，如: 大小 “Size”，位置 “Location”，執行屬性 “Runtime Properties” 與背景圖 

“Background Picture” 等，按 “OK” 可開始編輯螢幕。 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

4. 點選 “Text” 文字按鈕，在主螢幕上要放文字標籤的位置點選一下，輸入 “87055W_DI_1”。 

5. 再次以同樣方式點選 “Text” 按鈕，輸入 “#” (“#” 表示顯示 1 位數，“####” 表示顯示 4 位數，

“######” 表示顯示 6 位數)，然後點選 “Text Data Link” 按鈕。 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

2. 滑鼠右鍵點選 “Screen” 

，再點選 “Insert”。 

1. 點選 “Graphics” 

3. 設定螢幕屬性 

4. 點選 “Text” 加入標籤 

“87055W_DI_1”。 

5. 點選 “Text” 加入 “#” 標籤, 然後點選  

“Text Data Link”。“#”  表示顯示 1 位數 

“####” 表示顯示 4 位數。 
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6. 滑鼠雙擊 “#” 物件，出現設定視窗，在 “Tag/Expression” 欄位輸入 “DI”。 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 

重複前述步驟，建立其他物件，最後點選主功能表的 “Save” 按鈕，將此螢幕存檔為 “MainPage.scr”。 

(點選 [File] > [Save As HTML] 讓遠端工作站使用一般瀏覽器就可看到本螢幕。)  

 
 

注意: 輸出物件，如 87024W_AO_1 及 87055W_DO_1，“Text Data Link” 的 “Input Enabled” 設定， 

必需如下圖所示。 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

主螢幕建立完成，如下圖所示。 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

勾選此項, 表示使用者可在

程式執行時輸入物件值。 
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建立 Modbus TCP 工作區 
 

1. 點選 “Project Explorer” 視窗的 “Comm” 頁籤。 

2. 以滑鼠右鍵點選 “Drivers” 資料夾，選擇 “Add/Remove drivers”。 

3. 在開啟的 “Communication Drivers” 視窗，選擇 “MOTCP” DLL，按 “Select”，最後點選 “OK” 關閉

此視窗。 
 
 

            
 
 
 
 
 
 
 
 
 
 
 
 
 
 
   

 
 
 
 
 
 
 
 
 
 
 
 
展開 “Drivers” 資料夾，以滑鼠右鍵點選 “MOTCP” 資料夾，並選擇 “Insert”。 
 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 

1. 

2. 

3. 選擇 “MOTCP” DLL 

3. 
4. 

5. 
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出現一個 Modbus TCP 工作區 “MOTCP001.DRV”，請如下圖填入您相對應的資料. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

資料 

型態 

語法 

範例 
說  明 

0X 0X:1 Coil 狀態: 使用 Modbus 命令 01，05，15 來讀寫 

1X 1X:5 Input 狀態: 使用 Modbus 命令 02 來讀出 

3X 3X:4 Input Register: 使用 Modbus 命令 04 來讀出 

4X 4X:5 Holding Register: 使用 Modbus 命令 03，06，16 來讀寫 

FP FP:1 
浮點數值 (Holding Register):  

使用兩個連續 Holding Registers 來讀寫 

DW DW:2 
32-bit 整數值 (Holding Register):  

使用兩個連續 Holding Registers 來讀寫 

工作區 初始位址的有效範圍: 依設備而不同 

 

“127.0.0.1:502:1” 的意義: 

“127.0.0.1” 近端主機 IP 位址，表示資料傳輸

到同一控制器。“502” 是 Modbus TCP/IP 的 

埠號，最後的 “1” 是 PAC 的站號 (Net-ID)。 

1X:0 讀取 “Boolean” 資料 

0X:0 寫入 “Boolean” 資料 

3X:0 讀取 “short integer” 資料 (16-bit integer, Word: -32768 ~ +32767) 

4X:0 寫入 “short integer” 資料 (16-bit integer, Word: -32768 ~ +32767) 

DW:0 讀寫 “long integer”  資料 (32-bit integer, Double Word) 

FP:0 讀寫 “floating point” 資料 (32-bit REAL) 

 

其他詳細資料請參考下表. 
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請依下表資料插入下列 4 個 Modbus TCP 工作區:  
 

DRV 名稱 MOTCP001.DRV MOTCP002.DRV MOTCP003.DRV MOTCP004.DRV 

Description DI DO AO Internal 

Station 127.0.0.1:502:1 

Header 1X:0 0X:0 4X:0 3X:0 

Tag Name DI DO AO Interior 

Enable Read when Idle 1   1 

Enable Write on Tag Change  1 1  

Address 1 11 21 31 

 
以上項目設定完成，請點選鍵盤 “Ctrl + F4” 來關閉所有內部視窗並儲存所有檔案。 
 
 
 
專案設定 
 

選擇 [Project] < [Viewer] 開啟 “Project Settings” 視窗，將 “Startup screen” 項目設定為 

“MainPage.scr”，然後按 “OK” 關閉視窗。 
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網頁客戶端: Web Thin Clients 
 
選擇 [Project] < [Web] 開啟 “Project Settings” 視窗，在 “Data Server IP Address” 填入 PAC 正確的 

IP 網址，按 “OK”. 
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下載與執行專案 
 
點選 [Home] > [Connect] 開啟 “Remote Management” 視窗，在 “Target Station” 的 “Network IP” 輸入

您 PAC 的正確 IP 位址，按 “Connect”. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
在通訊正常下，點選 “Project” 頁籤，按 “Download” 按鈕。下載完成後，按 “RUN” 按鈕來執行專案。 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

輸入 PAC 的 IP 網址 

 

“Install system files” 按鈕可更新 PAC 的 InduSoft firmware 至 PC 目前的 

版本，點選按鈕之前，請確認 PAC 目錄下 (\System_Disk\InduSoft\path) 

的檔案不是唯讀的 (Read Only)，才能更新。 
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規劃 WinPAC 的網頁路徑 

 

執行 WinPAC Utility 並修改網頁路徑為 “\System_Disk\InduSoft\Demo_01\Web”，點選 “Setting” 及 

“Save and Reboot” 來完成規劃。 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

遠端實測您的專案 

 

開啟 IE 瀏覽器，輸入 WinPAC 的 IP 網址，例如: “http://10.0.0.80/MainPage.html”。 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

http://10.0.0.80/MainPage.html
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第 9 章 範例程式 與 FAQ 

WinPAC-8xx7 或 WP-8x47 為 WP-8147/8447/8847 的簡稱。 

 

請參考 “ISaGRAF 進階手冊”，瞭解更詳細的資訊: 
http://www.icpdas.com/en/download/show.php?num=333 
 
範例程式: (isagraf_winpac_demo.zip) 
http://www.icpdas.com/en/download/show.php?num=1005  
 
FAQ:  
https://www.icpdas.com/en/faq/index.php?kind=280#751 
 
 

9.1 線上支援 

如有任何疑問，您可以寫信至電子郵件信箱: service@icpdas.com. 

 

線上支援 - ISaGRAF 標準功能 與 功能方塊: 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

http://www.icpdas.com/en/download/show.php?num=333
http://www.icpdas.com/en/download/show.php?num=1005
mailto:service@icpdas.com
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線上支援 - ICP DAS 新增功能 與 功能方塊: 
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 線上支援 - ICP DAS 新增 I/O 模組 與 I/O 複合設備: 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

線上支援 - ISaGRAF 程式語言: 
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9.2 安裝 ISaGRAF 程式範例 

您可在網頁下載下列檔案: 
 

ISaGRAF (進階) 使用手冊: 
http://www.icpdas.com/en/download/show.php?num=333 
 
範例程式: (isagraf_winpac_demo.zip) 
http://www.icpdas.com/en/download/show.php?num=1005  
 
FAQ:  
https://www.icpdas.com/en/faq/index.php?kind=280#751 
 
 

範例程式列表 : 
 

專案名稱 說明 I/O 模組 (備註) 

example1 Web HMI 人機頁面 簡單範例  

slot 0: I-87055W 
wp_vb01 

WP-8x47 的 VB.net 2008 demo 01:  

DI/DO 範例，請參考第 6 章。 

wp_vb02 
WP-8x47 的 VB.net 2008 demo 02:  

AI/AO 範例，請參考第 6 章。 

slot 1: I-87024W 
slot 2: I-8017HW 

wp_vb03 
WP-8x47 的 VB.net 2008 demo 03:  

讀/寫 long integer、float 及 Timer，請參考第 6 章。 

wpdmo_01 WinPAC demo_01: PAC 內，從 File 讀/寫 float 值。 
FAQ-060 

wpdmo_02 WinPAC demo_02: PAC 內，從 File 讀/寫 long integer 值。 

wpdmo_03 依時間間隔輸出，如 SYSDAT_R、SYSDAT_W、SYSTIM_R、SYSTIM_W (ST+QLD) 

wpdmo_04 WinPAC demo_04: 使用者自訂 Modbus 通訊協定 (不使用 "Mbus") 

wpdmo_05 指定事件發生數秒後觸發某動作。 (英 FAQ-017) slot 0: I-87055W 

wpdmo_06 使用 Message 陣列 - MsgAry_r 、MsgAry_w 

wpdmo_07 轉換 float 值為 string，使用 real_str 與 rea_str2 

wpdmo_08 PID 控制  (參考文件)  

wpdmo_09 儲存 (備份) boolean / long integer 值至 (從)  檔案 

wpdmo_10 儲存 (備份) boolean / long integer 值至 (從)  EEPROM 

wpdmo_11 以 \Micro_SD 為目錄，每隔 10 秒儲存 3 個值至 3 個檔案，每個月改變檔名。 

wpdmo_14 Retain variable: Retain_b、Retain_N、Retain_f、Retain_t  (FAQ-074) 

http://www.icpdas.com/en/download/show.php?num=333
http://www.icpdas.com/en/download/show.php?num=1005
http://www.icpdas.com/web/product/download/software/development_tool/isagraf/document/faq/faq060_chinese.pdf
http://www.icpdas.com/web/product/download/software/development_tool/isagraf/document/faq/faq017.pdf
https://www.icpdas.com/en/download/show.php?num=2807
http://www.icpdas.com/web/product/download/software/development_tool/isagraf/document/faq/faq074_chinese.pdf
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專案名稱 說明 I/O 模組 (備註) 

wpdmo_16 以 \Micro_SD 為目錄，每隔 1 分鐘儲存 3 個值至 1 個檔案，每天改變檔名。 

wpdmo19 
當警告發生，傳遞 UDP 字串到 PC，Time_Gap 為 1 秒  

(使用變數陣列)  
slot0: I-87055W 

(見 ISaGRAF 手冊 

 - 第 19.2 節) 
wpdmo19a 3 秒後傳遞 UDP 字串到 PC，Time_Gap 為 250 ms  

 (wpdmo19a 較佳) wpdmo19b 

wpdmo_20 透過 UDP/IP 從遠端 PC 或 PAC 接收字串 

wpdmo_21 使用 "com_MRTU" 來 停止/啟動 Modbus RTU Slave 埠 

wpdmo_22 PWM I/O 範例 (WinPAC 脈寬調整，最小 2 秒) slot 0: I-8055W 

wpdmo_23 使用 COMOPEN、COMSTR_W，每秒傳遞時間字串到 COM3: RS-232。(FAQ-059) 

wpdmo_24 當發生警報 1 ~ 8，傳遞字串到 COM3 slot 0: I-87055W 

wpdmo_26 
移動 WP-8x47 插槽 1 的 I-8091W 的 X 軸時脈 

(見 ISaGRAF 手冊 - 第 18 章) 

slot 1: I-8091W 
 

wpdmo_27 運動控制:  x 軸  slot 1: I-8091W 
slot 2: I-8090W 

(見 ISaGRAF 手冊 

- 第 18 章) 

wpdmo_28 運動控制 :  x-y 軸 

wpdmo_29 當給予 CMD 時，移動到絕對位置 

wpdmo_30 
WP-8x47 (10.0.0.102) 連結 2 個 I-8KE8 乙太網路擴充單元 + 

I/O 模組，一個是 10.0.0.108，一個是 10.0.0.109。 
FAQ-042 

wpdmo_31 
WP-8x47 (10.0.0.2) 連結 1 個 I-8KE8 乙太網路擴充單元 +  

I/O 模組 (10.0.0.109) 。 

wpdmo_32 
設定 WP-8x47 為 TCP/IP Client 並連結到其他 TCP/IP server  

(1 個連接)  

slot 0: I-87055W 

(見 ISaGRAF 手冊 

- 第 19.3 節) wpdmo_33 同 Wpdmo_32，但當事件持續超過 3 秒時，才傳遞訊息。 

wpdmo_36 從 Modbus RTU 設備讀出實數值。 
FAQ-047、075 

wpdmo_37 將實數值寫到 Modbus RTU 設備。 

wpdmo_38 使用 Modbus 函式 6 來寫 16 個位元到設備。 FAQ-046、075 

wpdmo_39 WP-8x47 + I-8172W 連接 FRnet I/O 模組。 FAQ-082 

wpdmo_41 
使用 COM3 連接 1: M-7053D + 2: M-7045D (MBRTU 格式，baud=9600) 

(見 ISaGRAF 手冊 - 第 21 章) 

wpdmo_42 使用 COM3 連接 1: M-7053D 來讀取 DI 計數值 (MBRTU 格式，baud=9600) 

http://www.icpdas.com/web/product/download/software/development_tool/isagraf/document/faq/faq059_chinese.pdf
http://www.icpdas.com/web/product/download/software/development_tool/isagraf/document/faq/faq042_chinese.pdf
http://www.icpdas.com/web/product/download/software/development_tool/isagraf/document/faq/faq047_chinese.pdf
http://www.icpdas.com/web/product/download/software/development_tool/isagraf/document/faq/faq075_chinese.pdf
http://www.icpdas.com/web/product/download/software/development_tool/isagraf/document/faq/faq046_chinese.pdf
http://www.icpdas.com/web/product/download/software/development_tool/isagraf/document/faq/faq075_chinese.pdf
http://www.icpdas.com/web/product/download/software/development_tool/isagraf/document/faq/faq082_chinese.pdf
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專案名稱 說明 I/O 模組 (備註) 

wpdmo_43 COM3 連接 1: M-7017R + 2: M-7024 (MBRTU 格式，baud=9600) 

wpdmo_44 COM3 連接 1: M-7017RC，Current input，+/- 20mA，4-20mA (Modbus 格式) 

wpdmo_45 COM3 連接 1: M-7019R (設定為 T/C K-type input) (MBRTU 格式，baud=9600) 

wpdmo_46 使用 COM3 連接 1: M-7080 (MBRTU 格式，baud=9600) 

wpdmo_48 VB.net 2005 範例 - "MBTCP_demo" (FAQ-051) 

wpdmo_50 非線性轉換，例如: 給 P 值，求 V 值 (P，V 的關係列於檔案) 

wpdmo_51 使用 str_real 函式，從檔案讀取 10 個實數，共 10 列，每列 1 個實數。 

wpdmo_52 Msg_F 函式範例。  

wpdmo_53 Msg_N 函式範例。 

wpdmo_54 使用 msg_f 函式，從檔案讀取 20 個實數，共 4 列，每列 5 個實數。(FAQ-060) 

wpdmo_55 使用 msg_n 函式，從檔案讀取 20 個整數，共 2 列，每列 10 個整數。 

wpdmo56 保存 17 個實數到檔案中，共 2 列，每列 10 個實數。 

wpdmo56a 保存 2 個布林 + 17 個實數到檔案，2 列，每列 10 個實數。 

wpdmo56b 保存 25 個整數到檔案中，2 列，每列 10 個整數。 

wpdmo56c 保存 2 個布林 + 25 個整數到檔案，2 列，每列 10 個實數。(FAQ-060) 

wpdmo56d 保存 17 個實數 + 2 個布林 + 10 個整數到 2 個檔案，每列 10 個值。 

wpdmo56e 保存超過 255 個實數、255 個布林、255 個整數到 2 個檔案，最多 1024 個值。 

wpdmo_61 透過 UDP 主動資料回報到 PC。PAC =10.0.0.103，PC=10.0.0.91 

wpdmo_62 使用乙太網路埠發送 email (不附加檔案，寄給一個收件者)  FAQ-067、071、 

072 或 077 wpdmo_63 發送可夾帶附件的 email 給一個收件者 

wpdmo64a 使用乙太網路對多台 PAC 做時間校正。 

64a: 工作站 1001；64b: 工作站 1002 wpdmo64b 

wpdmo65a 每分鐘記錄溫度到檔案一次，每天將記錄檔以 email 寄出。 
slot 2: I-87018z 

FAQ-067、071、 

072 或 077 wpdmo65b 同 wdmo_65a，但增加時間校正與發出報告給 PC。 

wpdmo_66 
每 20 ms 記錄 I-8017HW Ch. 1 ~ 4 的電壓，並將記錄檔以

email 寄出。 

slot 2: I-8024W 
slot 3: I-8017HW 

Wpdmo_70 FRnet 應用: Port0，FR-2057 (addr=4)、FR-2053 (addr=8) 
slot 1: I-8172W  

FR-2057、FR-2053 

http://www.icpdas.com/web/product/download/software/development_tool/isagraf/document/faq/faq051_chinese.pdf
http://www.icpdas.com/web/product/download/software/development_tool/isagraf/document/faq/faq060_chinese.pdf
http://www.icpdas.com/web/product/download/software/development_tool/isagraf/document/faq/faq060_chinese.pdf
http://www.icpdas.com/web/product/download/software/development_tool/isagraf/document/faq/faq067_chinese.pdf
http://www.icpdas.com/web/product/download/software/development_tool/isagraf/document/faq/faq071_chinese.pdf
http://www.icpdas.com/web/product/download/software/development_tool/isagraf/document/faq/faq072_chinese.pdf
http://www.icpdas.com/web/product/download/software/development_tool/isagraf/document/faq/faq077_chinese.pdf
http://www.icpdas.com/web/product/download/software/development_tool/isagraf/document/faq/faq067_chinese.pdf
http://www.icpdas.com/web/product/download/software/development_tool/isagraf/document/faq/faq071_chinese.pdf
http://www.icpdas.com/web/product/download/software/development_tool/isagraf/document/faq/faq072_chinese.pdf
http://www.icpdas.com/web/product/download/software/development_tool/isagraf/document/faq/faq077_chinese.pdf
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專案名稱 說明 I/O 模組 (備註) 

wpdmo71a 
CAN 應用: COM4 連接 I-7530  與 CANopen 設備 (ID = 1，8DI、8DO、4AO、8AI) 。

(FAQ-086) 

wpdmo71b 類似 wdmo_71A，但連接 2 個 I-7530，一個連接 COM5，一個連接 COM6。 

wpdmo71c COM4 連接 I-7530 與 CAN 設備，來取得字串 (也包含 float 或 integer 資料) 

wpdmo71d 類似 wdmo_71c，但連接 2 個 I-7530，一個連接 COM5，一個連接 COM6。 

wpdmo71e COM5 連接 I-7530 與 CANopen 設備；COM6 連接 I-7530 與 CAN 設備。 

wpdmo72a 
新的 WP-8x47 可熱插拔 備援 (冗餘) 系統:  

搭配 RU-87P4 + I-87K I/O (不連接 Touch HMI) 

wpdmo72b 
同 wpdmo72a，但設定 COM1 為 Modbus RTU Slave 埠，來連接一台 RS-232  

觸控螢幕 (Touch HMI)   

wpdmo72c 
新的 WP-8x47 備援 (冗餘) 系統 (Ethernet I/O) : 

搭配 I-8KE8-MTCP I/O 模組 (不連接 Touch HMI) 

wpdmo74a 求實數平均值 
FAQ-099 

wpdmo74b 求整數平均值   

wpdmo75 在插槽 0 使用 I-8088W (8-ch，PWM output) slot 0: I-8088W 

wpdmo75b 
經由 WP-8x47 的 COM2: RS485 連接 I-87088W (I-7088) 

(addr=1、baud=115200) 
I-87088W (I-7088) 

Wpdmo_76 SMS : 使用 COM4 連接 GTM-201-RS232 GTM-201-RS232 

wpdmo77a 使用 eth_udp、eth_send( )、eth_recv( ) 來傳送 / 接收 UDP byte  

wpdmo77b 使用 eth_tcp、eth_send( )、eth_recv( )  來傳送 / 接收 TCP byte  

wpdmo78 
WP-8x47 (COM2: Modbus Master) 連接 M-7011 (ID=1，

baud=9600) 來取得 AI、DI  
M-7011 

wpdmo79a 應用 1: Modbus RTU Master (中央站) 

FAQ-119 

wpdmo79b 應用 1: Modbus RTU Slave (地區站 1)，需設定 ID 為 1 

wpdmo79c 應用 1: Modbus RTU Slave (地區站 2)，需設定 ID 為 2 

wpdmo80a 應用 2: Modbus TCP Master (中央站) 

wpdmo80b 
應用 2: Modbus TCP Slave (地區站 1)，需設定 ID 為 1，

LAN1=192.168.1.178；LAN2=192.168.1.179 

wpdmo80c 應用 2: Modbus TCP Slave (地區站 2)，也需設定 ID 為 1，

http://www.icpdas.com/web/product/download/software/development_tool/isagraf/document/faq/faq086_chinese.pdf
http://www.icpdas.com/web/product/download/software/development_tool/isagraf/document/faq/faq099_chinese.pdf
http://www.icpdas.com/web/product/download/software/development_tool/isagraf/document/faq/faq119_chinese.pdf
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專案名稱 說明 I/O 模組 (備註) 

LAN1=192.168.1.180；LAN2=192.168.1.181 

wpdmo81 使用 Aver_N 與 Aver_F 來計算連續平均值 (FAQ-120) slot 1: I-8017HW 

wphmi_01 WinPAC Web HMI 人機範例 01: 顯示 PAC 的日期與時間。 

wphmi_02 WinPAC Web HMI 人機範例 02: DI 與 DO 範例程式 slot 0: I-87055W 

wphmi_03 WinPAC Web HMI 人機範例 03: 讀/寫 Long、float 與 Timer 的值。 

wphmi_04 WinPAC Web HMI 人機範例 04: 讀寫 PAC 的 String 值。 

wphmi_05 WinPAC Web HMI 人機範例: 多重頁面範例 

05: 選單在左 ;  05a: 選單在上  
slot 0: I-87055W 

wphmi05a 

wphmi_06 WinPAC Web HMI 人機範例: AIO 範例 

06: 於 ISaGRAF 中運算 ; 07: 於 PC 中運算 

slot 2: I-87024W 
slot 3: I-8017HW wphmi_07 

wphmi_08 WinPAC Web HMI 人機範例 08: 將 PAC 的檔案下載到 PC。 
slot 0: I-87055W 

wphmi_09 WinPAC Web HMI 人機範例 09: 於 PC 自動顯示警告視窗。 

wphmi_11 趨勢線範例 
slot 2: I-87024W 
slot 3: I-8017HW 

wphmi_12 
每 50ms 記錄 I-8017HW 通道 1 ~ 8 的電壓，並繪製 M.S.Excel 

趨勢圖。 
I-8017HW 

wphmi_13 
每 10ms 記錄 I-8017HW 通道 1 ~ 4 的電壓，並繪製 M.S.Excel 

趨勢圖。 

 
 

http://www.icpdas.com/web/product/download/software/development_tool/isagraf/document/faq/faq120_chinese.pdf
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回存 ISaGRAF 範例程式 

回存 ISaGRAF 範例程式之前，強烈建議您建立一個 “ISaGRAF 專案群組”，並將所有的範例程式都 

儲存在裡面，例如: 建立 “Demo” 專案群組。 

 

點選 [Select project group] 按鈕，並點選 [New group]，再輸入您要的群組名稱。 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

接著，要將範例程式回存到建立的專案群組中。在 "ISaGRAF Project Management" 視窗點選  

[Tools] > [Archive] > [Projects]  。 
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接著出現 "Archive Projects" 視窗，點選 "Browse" 按鈕選擇範例程式的所在位置，並點選 “OK”。 

(WP-8x47 Demo 目錄: \isagraf_winpac_demo) 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

滑鼠選取 Archive 欄位裡顯示的所有檔案，並點選 “Restore” 按鈕，將所有範例程式回存到 ISaGRAF 

Workbench.。 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

1. 
 

2. 
 

3. 
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9.3 FAQ: 常見問題表 

 

FAQ:  
https://www.icpdas.com/en/faq/index.php?kind=280#751 
 
 

FAQ 問題列表: 

 

編號 中文 ISaGRAF Ver.3 FAQ 

016 
若 DI 量測點在切換 OFF 到 ON (或 ON 到 OFF) 過程中，有短暫的訊號跳動現象，該如何來

編程? 

018 ISaGRAF-256 軟體是否有 I/O 點數的使用限制? 

020 如何在 ISaGRAF 內搜尋某一變數名稱? 

021 有時在關閉 ISaGRAF 視窗時會卡住約 20 ~ 40 秒，如何解決? 

024 如何將 AI / AO 的 4 ~ 20 mA 值 或 0 ~ 10 V 值，轉換成工程應用值?  

030 如何直接取得 I/O 插槽上 (0 ~ 7)，溫度模組的溫度值 (攝氏/華氏)? 

031 如何直接取得 I-7000 及 I-87K 遠程溫度模組的溫度值 (攝氏/華氏)? 

038 如何啟用 I-7188EG 或 I-7188XG 的 COM3 成為 Mobus RTU Slave 埠? 

039 如何使用變數陣列? 

040 如何從 PAC 面板上啟用 I-8x37 的 COM3: RS232/485 為 Modbus RTU Slave 埠? 

041 如何將 圖控/HMI/上位機 連接到單一 IP 地址的備援 (冗餘) 系統?  

046 如何使用 Modbus 函式 6 來寫 16 個 Bit 到 Modbus RTU 設備? 

047 如何對 Modbus RTU Slave 設備 讀/寫 實數資料? 

049 如何使用 “Mbus_R” 與 “Mbus_R1” 方塊，直接取得 M-7000 溫度模組的溫度值 (攝氏/華氏)? 

050 如何連接 M-7000 系列 Modbus RTU I/O?  

051 如何使用 PC 上的 VB.net 2005 程式，並透過 Modbus TCP/IP 與 ISaGRAF PAC 連接? 

052 如何使用 PC 上的 VB 6.0 程式，並透過 Modbus TCP/IP 與 ISaGRAF PAC 連接? 

055 
如何連接 I-7018Z 量測 6 個 4 ~ 20 mA 的電流輸入值 與 4 個 Thermo-Couple 溫度輸入值， 

並顯示在 PC 的 VB 6.0 程式上?  

057 如何在 ISaGRAF PAC，每 0.01 秒記錄 I-8017H 的 1 ~ 4 個電壓值至 User 配置的 RAM 內， 
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058 
如何在 I-8437-80 或 I-8837-80，每 0.05 秒記錄 I-8017H 的 1 ~ 4 個電壓值至 S256/S512 內，

可連續記錄 1 ~ 10 分鐘，並可在 PC 上使用 M.S. Excel 開啟記錄檔，來看 1 ~ 4 條趨勢圖?  

059 常用的 COM Port 函式技巧，來讀寫 RS-232/422/485  

060 如何在 WinPAC/XPAC 內，讀/寫 File 資料?  

061 如何連接 RS-485 遠程 I-7000 與 I-87K 到 ISaGRAF PAC? 

062 如何規劃備援 (冗餘) 系統? (採用 Ethernet I/O) 

063 
為何我的 RS-485 遠程 I-7000 與 I-87K Output 模組，在 RS-485 通訊線斷線後，沒有啟動 

Wacthdog 讓輸出通道設為安全輸出值 (Safe Value)?  

065 泓格科技提供穩定且有效率的 主動訊號採集 與 資料回報系統。 

066 如何使用 RS-232/485 通訊埠，來接收設備主動傳過來的數值資料? 

067 如何使用 uPAC-7188EG 或 iP-8447/8847 來發送可夾帶附件的 Email? 

067 如何使用 uPAC-7188EG 或 iP-8447/8847 來發送可夾帶附件的 Email? 

068 為何 ISaGRAF PAC  會發生一直重啟 (Reset) 或當機的現象? 如何刪除應用程式? 

070 如何自動對多台 ISaGRAF PAC 進行時間校正 與 記錄運作狀態?   

071 應用例: 使用 WinPAC/XPAC 每分鐘記錄 10 個溫度值，記錄完一天後，用 Email 發出記錄檔。  

072 應用例: 使用 WinPAC/XPAC 每 20 ms 記錄一筆電壓/電流值，可連續記錄 1 ~ 10 分鐘， 

073 
為何 ISaGRAF 程式內用的 i_7017 方塊，讀到 I-7017 模組的輸入值，是正常值的 2 倍大 或  

變成負值?   

074 如何使用 ISaGRAF 新的可保存變數 (Retain Variable)，它的優點是什麼?   

075 為何我的 ISaGRAF 程式，無法正確連上其它廠牌的 Modbus Slave 設備?   

077 
應用例: 使用 μPAC-7186EG 每秒記錄一筆電壓/電流值，可連續記錄 1 ~ 10 分鐘，完成後用

Email 發出記錄檔。 

080 應用例: 使用 μPAC-7186EG 每分鐘記錄 10 個溫度值，記錄完一天後，用 Email 發出記錄檔。 

081 如何在 ISaGRAF PAC 內使用 I-87017W-A5 來量測  +/- 150VDC ? 

082 簡化 FRnet 快速遠程 I/O 的程式設計方法。   

083 如何設定 ISaGRAF Ethernet PAC 的 TCP 回收時間?   

084 應用例: 具經濟效益的可熱插拔備援 (冗餘) 系統 - μPAC-7186EG 或 I-8437-80 + RU-87P4/8。   

086 
如何使用 uPAC-7186EG 或 iP-8447/8847 連接一個 (或多個)  I-7530，來讀取或控制 CAN 及 

CANopen 設備 與傳感器? 

087 當七段顯示器出現 Err00、Err02、Err03、Err90 和 E.0001 訊息時，代表什麼意思?   

 
 



快速上手手冊: WP-8147/8447/8847, 2020 年 10 月, 2.0 版                       9-13 

編號 中文 ISaGRAF Ver.3 FAQ 

088 

功能變更:  

從新版 Driver 起，μPAC-7186EG、I-8xx7 和 I-7188EG/XG 搭配 S256/512 或 X607/708 不再 

支持舊的可保存變數 (Retain variable)，請改用功能較好、新的可保存變數方式。 

089 為何我的 μPAC-7186EG 無法更新驅動程式 和 ISaGRAF 應用程式?   

090 如何在 ISaGRAF PAC 內使用 I-7017Z?   

092 如何啟用 μPAC-7186EG、I-7188EG/XG 的 COM2 或 COM3 成為 Modbus RTU Slave 埠?   

096 新增 Modbus RTU/ASCII 功能方塊，來一次讀取最多 24 個 Word 或最多 384 個 Bit。  

097 
如何在 XP-8xx7-CE6 沒有接滑鼠與 VGA 顯示器的情況下，使用 USB 隨身碟來更改它的 IP 

位址、站號 與 Modbus RTU 設定? 

098 應用例: 使用 COM Port 的函式，讀/寫 Modbus RTU 設備。  

099 如何編寫一個每固定時間  (或 PLC scan) 取樣，並取整數或實數平均值的功能方塊? 

100 如何使用 I-8084W (4/8 通道 Counter 或 8 通道 frequency)?  

101 
如何使用 MBUS_XR 或 MBUS_XR1 方塊，一次讀取 Modbus RTU/ASCII 設備的 Word (最多

120 個)、長整數 (最多 60 個) 或 實數 (最多 60) (只適用 WP-8x47)?  

104 為何我的 PC/ISaGRAF 無法正常連上 ISaGRAF PAC?  

105 如何使用 I-8088W (或 I-87088W、I-7088) 來控制 8 個 PWM 輸出?  

107 
如何使用 ISaGRAF PAC 與 GPS 模組 (GPS-721 或 I-87211W)，並透過衛星訊號來進行自動 

時間校正 與 取得目前位置的經緯度座標?  

109 如何使用 ISaGRAF PAC與 I-87211W，並透過 Ebus校正區域網路上所有 ISaGRAF PAC的時間?  

111 如何使用 GTM-201-RS232 發送各別國家文字的簡訊?  

112 如何使用 ISaGRAF 來編程 I-8093W (3 軸高速 Encorder 輸入模組)?  

113 在 ISaGRAF PAC 內使用 Modbus TCP/IP Master 來連接 Modbus TCP/IP Slave 裝置。  

114 列印 ISaGRAF PDF 文件時，如何避免印出亂碼?  

115 
如何開發 ISaGRAF 與 eLogger HMI 專案，並應用在 XP-8xx7-CE6 PAC? 

(2020 年起，eLogger 不支援 CE5.0 PAC)  

117 如何在 Windows Vista 或 Windows 7 中安裝 ISaGRAF?  

119 如何實現中央控制站 與 地區控制站 之間的通訊備援機制?  

120 如何使用 Aver_N 與 Aver_F 來計算連續平均值 (或稱移動平均值)?  

121 如何建立與移除 ISaGRAF 開發環境?  

124 ISaGRAF 專業版 PAC  (XP-8xx7-CE6-PRO) 的 Web HMI 應用範例 – 使用 FrontPage  

125 XP-8xx7-CE6 備援 (冗餘) 系統，可搭配 iDCS-8000、ET-7000 或其它 Modbus TCP Slave 設備。   

126 
如何使用 WP-8847 連接 ET-7018Z 與 ET-7044D，並使用 InduSoft、VS2008 C# .NET 與 VB .NET

來開發 HMI?  
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編號 中文 ISaGRAF Ver.3 FAQ 

128 如何使用 ISaGRAF PAC 加上 I-87113DW 模組 (已停產)，來連接差阻式傳感器?  

129 如何使用 ISaGRAF PAC 連接 ICP DAS 電力表 – PM-2133 與 PM-2134?  

132 使用 I-8094F/8092F/8094 執行馬達控制運動。 

133 如何在 ISaGRAF PAC 內使用 UDP 或 TCP 來收取 (或發送) 廣播資料封包 或 一般資料封包?   

135 如何寫 ISaGRAF WinCE PAC 的應用程式，去讀/寫 MicroSoft SQL Server 的資料?   

136 HART 應用: ISaGRAF PAC 搭配 I-87H17W 模組。  

138 如何設計一個 XP-8xx7-CE6 備援 (冗余) 系統 (搭配 I-87K8、Modbus I/O 或其它 I/O)?   

139 如何安裝使用 ISaGRAF 3.55 Demo 版 與 使用限制?   

140 如何透過 Modbus TCP 讓 PC 端的 InduSoft HMI 與 ISaGRAF PAC 進行通訊?   

141 如何啟動快閃記憶體 (Flash memory) 的防寫功能? (適用: iP-8xx7/ μPAC-7186EG/ I-8xx7)   

142 如何保護你的 ISaGRAF 程式，讓盜用者無法使用?   

143 如何讓 ISaGRAF WinCE PAC 撥接 GPRS 上網，來傳送資料?   

144 新增 Modbus RTU/ASCII/TCP 方塊 - “Mbus12w”，來一次寫出 1 ~ 12 個 Word。   

147 如何使用 VPD-130 經由 RS-485 讀取 μPAC-7186EG 的系統日期/時間?   

149 如何讓 ISaGRAF WinCE PAC 播放聲音?   

151 如何使用 FTP Client 功能，上傳資料檔至遠端 PC 的 FTP Server?  

152 如何使用 ISaGRAF PAC 操作 IR-210/IR-712 紅外線遙控模組?  

153 
如何使用 3G/2G 無線技術，讓 ISaGRAF PAC 跟遠方的 Modbus TCP Server 或 FTP Server 進行

通訊?  

154 如何使用 ISaGRAF PAC 操作 FRnet AI/AO 模組?  

156 如何使用 ISaGRAF PAC 連接 DL-100TM485，來測量濕度與溫度值?  

157 如何使用 ISaGRAF PAC 連接 DL-100T485 溫溼度計?  

159 如何使用 ISaGRAF PAC 與 tGW-700 系列產品 (Modbus TCP 轉 RTU/ASCII 閘道器)?  

161 ISaGRAF 可在 For 迴圈使用大量的 Modbus 方塊 (Mbus_AR 與 Mbus_AW) 。 

162 如何使用 ISaGRAF PAC 傳送事件 (Event) 資料? 

163 為何 ISaGRAF PAC 的 Ethernet 無法連線且 Power LED 和 L1 LED 指示燈一直閃爍? 

165 如何使用 ISaGRAF PAC 來控制 tM 系列 與 LC 系列 Modbus I/O? 

166 ISaGRAF WinCE PAC 排程控制 - Schedule Control  

167 在 ISaGRAF WinCE PAC 內開發屬於自己的 C-function 與 C-function Block。  

168 如何寫 ISaGRAF 程式來複製/刪除一個目錄內的所有檔案? 

169 如何在 ISaGRAF PAC 上使用 I-87028UW/CW, I-87024UW/CW 模組? 

171 ISaGRAF PAC 如何使用 "Mbus_RW" 功能方塊，讓監控 Modbus 設備更容易? 
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編號 中文 ISaGRAF Ver.3 FAQ 

172 如何從檔案內讀取多個字串給 ISaGRAF 程式使用? 

173 為何無法使用 Web 瀏覽器來連上 ET-7000 模組的設定網頁? 

174 如何在 VMware Workstation/Player 中建立 ISaGRAF Ver. 3.55 開發環境? 

175 如何使用 ISaGRAF PAC 測試 Ethernet/Internet 連線? 
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第 10 章 使用 C#.net 2008 程式來讀/寫 ISaGRAF 變數 

重要: 

請將開發好的 .net 程式 與 資料檔存放在  \Micro_SD 內，而不要存放在 \System_Disk 內。因為 

\System_Disk 使用的是 NOR Flash 記憶體，它主要是給 OS、ISaGRAF Driver 與一些必要的 Utility 與 

DLL 存放使用，容量不大。 

 

而且，請勿常常去更新 NOR Flash 記憶體的資料，久了容易損壞。若常常在 \System_Disk 內 

更新檔案 (例如: 每 1 ~ 5 秒就更新一次，一天下來就更新了約幾萬次)，資料會容易受損。所以 

自行開發的程式 與 要操作的檔案，最好都存放在 \Micro_SD 內。 

 
 

本章使用 Visual Studio .NET 2008 開發工具，並建立一個範例程式來說明，範例程式可在 WP-8x47 

的 Demo 目錄中找到。 

 
WP-8x47 CD-ROM: ...\isagraf_winpac_demo\CSharp.net_2008_demo\ 

wp_CSharp01: 數位 I/O 範例，搭配 I-87055W 模組 (於 Slot 0) 

wp_CSharp02: 類比 I/O 範例，搭配 I-87024W (Slot 1) 與 I-8017HW (Slot 2) 

wp_CSharp03: 讀/寫 ISaGRAF internal integer、timer 及 real 變數 (無需 I/O 模組) 

 

對應的專案範例檔名: "wp_vb01.pia"、"wp_vb02.pia”、"wp_vb03.pia" (同目錄) 

 

 

10.1 建立新專案 

 

4. 開啟微軟 Visual Studio .NET 2008 軟體，並在選單列上點選 [File] > [New Project] 。 
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5. 點選 [Smart Device] > [.NET frame work 2.0] < [Smart Device Project]，在下方輸入專案名稱 (例如: 

project1)，然後按 “OK”。 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

6. 點選 [Device Application] > [Windows CE] > [.NET Compact Framework Version 2.0]，然後按 “OK”。 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
  

1. 
 

2. 
 

3. 
 

4. 
 

5. 
 

1. 
 

2. 
 

3. 
 

4. 
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10.2 加入專案參考 

“QuickerNet” library 包含了所有模組的 Function，在程式裡使用 “Quicker” 關鍵字之前，您必需在 

應用程式的參考清單裡加入參考: “QuickerNet.dll”。 

 

1. 滑鼠右鍵點擊 “Solution Explorer” 視窗裡的專案名稱， 

選擇 “Add Reference …” 
 

2. 點選 “mscorlib”，按 “OK”。 (“mscorlib” 出現在 .NET 的

Component Name 區) 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

3. 點選 “Browse” 頁籤，“搜尋位置” 請切換到 WP-8x47  的 Demo 目錄:  \isagraf_winpac_demo\ 

CSharp.net_2008_demo\wp_CSharp01，選擇 “quickernet.dll”，按 “OK”。 

 
 
 
 
 
 
 
 
 
 

 
 
 
 
 
 
 

滑鼠右鍵 
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4. 加入 “mscorlib” 及 “QuickerNet.dll” 後，會顯示在 “Solution Explorer” 視窗。 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

5. 以滑鼠右鍵點選 “Form1.cs”，選擇 “View Code”，將游標移到最上方，在第一個區段中加入 “using 

Quicker;” 。  

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

接著，就可以在 C# 表單中設計所需的物件與動作了。 

 
 
 
 
 
 
 
 
 
 
 
 
 

滑鼠右鍵 



快速上手手冊: WP-8147/8447/8847, 2020 年 10 月, 2.0 版                       10-5 

10.3 編譯應用程式 

程式撰寫完成後，請依下列步驟建置 (build) 一個應用。 

 

1. 請記得隨時按下 “Save All” 按鈕來存檔。 

 
 

 
 
 
 
 
 
 
 

2. 編譯 (即建置) 此專案，“Error List” 視窗會列出建置結果。 

 
 

 
 
 
 
 
 
 
 
 

 
 
 
 

3. 在下列資料夾中，可以找到執行檔: 

 

 <您的 C# .net 專案資料夾> \bin\Release\ <project_name>.exe 

 請將此執行檔複製到 PAC 的 \System_Disk\ISaGRAF\ 目錄下來執行。 

 
 

注意:  使用者可複製 C#.net 的執行檔到其他目錄下執行，但是要同時複製 “QuickerNet.dll”、

“Quicker.dll” 與 “Mscorlib.dll” 檔  3 個 DLL 檔案，否則執行會有錯誤。 

 

例如: 若要在 \Micro_SD\ 目錄下執行 project1.exe，則該目錄必需有下列檔案，即 

“project1.exe”、“QuickerNet.dll”、“Quicker.dll” 與 “Mscorlib.dll” 檔 (可在 PAC 的 

“\System_disk\ISaGRAF\” 目錄下取得此 3 個 DLL 檔案。 
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10.4 QuickerNET.DLL  

本節將著重在 QuickerNET.DLL 的 function 應用與範例說明，有許多的 function 可用來 讀/寫資料 

從/到 ISaGRAF PAC。 

 

QuickerNET.DLL 的 function 可以分為兩大類: 

1. 數位 讀/寫 Function 

2. 類比 讀/寫 Function 

 
 
 
 
 
 

10.4.1 數位 (Digital) 讀/寫函式 

  

■ UserSetCoil 
 

說明: 

用來設定 Boolean 值，到指定 Modbus 位址的 Boolean 變數。 

 

語法: 

 
UserShare.UserSetCoil(ushort iUserAddress, byte iStatus) 

 

參數:  

iUserAddress: 指定變數的 Modbus 位址 (1 ~ 8191) 

iStatus: 設定變數的狀態 (iStatus = 1 表示 True；iStatus = 0 表示 False) 

 

回傳值: 

無 

 

範例:  

//設定 Modbus 位址 “1” 的 output 變數為 True。 

UserShare.UserSetCoil(Convert.ToUInt16(1), 1);  
 

範例程式 :  

WP-8x47 Demo 目錄: \isagraf_winpac_demo\CSharp.net_2008_demo\wp_CSharp01 
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■ UserGetCoil 

 

說明: 

用來讀出指定 Modbus 位址的 Boolean 變數值。 

 

語法:  

 
UserShare.UserGetCoil(ushort iUserAddress, out byte iStatus) 

 

參數:  

iUserAddress: 指定變數的 Modbus 位址 (1 ~ 8191) 

iStatus: 取得變數的狀態 (iStatus = 1 表示 True，iStatus = 0 表示 False) 

 

回傳值: 

無 

 

範例:  

//取得 Modbus 位址 “1” 的變數狀態。 

byte iStatus;  
UserShare.UserGetCoil(Convert.ToUInt16(1), out iStatus);  
 

範例程式 :  

WP-8x47 Demo 目錄: \isagraf_winpac_demo\CSharp.net_2008_demo\wp_CSharp01 
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10.4.2 類比 (Analog) 讀/寫函式 

 

■ UserSetReg_short ■ UserSetReg_long ■ UserSetReg_float 

 

說明: 

用來設定 16-bit short integer、32-bit long integer 及 32-bit float 值，到指定 Modbus 位址的變數。 

 

語法:  
 

UserShare.UserSetReg_Short(ushort iUserAddress, out int iStatus) 
 

UserShare.UserSetReg_Long(ushort iUserAddress, out int iStatus) 
 

UserShare.UserSetReg_Float(ushort iUserAddress, out float iStatus) 
 

 

參數 :  

iUserAddress: 指定變數的 Modbus 位址編號 (1 ~ 8191) 

iStatus: 設定 short / long integer 或 float 值 

 

範例:  

//設定 long 值 “1234567”，到 Modbus 位址 “1” 的變數。 

int temp1=1234567; 
UserShare.UserSetReg_long (Convert.ToUInt16(1), out temp);    
 

//設定 short 值 “-1234”，到 Modbus 位址 “3” 的變數。 

int temp2= -1234; 
UserShare.UserSetReg_short (Convert.ToUInt16(3), out temp2);    
 

//設定 float 值 “2.174”，到 Modbus 位址 “4” 的變數。 

float temp3=2.174; 
UserShare.UserSetReg_float (Convert.ToUInt16(4), out temp3);    
 

範例程式 :  

WP-8x47 Demo 目錄:   

1. 讀/寫 類比 I/O: \isagraf_winpac_demo\CSharp.net_2008_demo\wp_CSharp02 

2. 讀/寫 internal long integer、Timer 及 Real (浮點數) 的值: 

\isagraf_winpac_demo\CSharp.net_2008_demo\wp_CSharp03 
 

注意:  ISaGRAF 專案中，long integer、timer 及 real 變數必需佔用 2 個網路位址編號。  

(參閱 “ISaGRAF 進階使用手冊” - 4.2 節: http://www.icpdas.com/en/download/show.php?num=333) 

 
 
 

http://www.icpdas.com/en/download/show.php?num=333
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■ UserGetReg_short ■ UserGetReg_long ■ UserGetReg_float 

 

說明: 

用來讀出指定 Modbus 位址的 16-bit short integer、32-bit long integer  及 32-bit float  的值。 

 

語法:  
 

UserShare.UserGetReg_Short(ushort iUserAddress, out int iStatus) 
 
UserShare.UserGetReg_Long(ushort iUserAddress, out int iStatus) 

 
UserShare.UserGetReg_Float(ushort iUserAddress, out float iStatus) 
 

 

參數:  

iUserAddress: 指定變數的 Modbus 位址 (1 ~ 8191) 

iStatus: 取得 short / long integer 或 float 值  

  

範例:  

float float_val 
short short_val 
int long_val 
  

//取得 Modbus 位址 “7” 的 float 變數值。  

UserShare.UserGetReg_float (Convert.ToUInt16(7), out float_val);  
 

//取得 Modbus 位址 “9” 的 long 變數值。 

UserShare.UserGetReg_long (Convert.ToUInt16(9), out long_val); 
 

//取得 Modbus 位址 “11” 的 short 變數值。 

UserShare.UserGetReg_short (Convert.ToUInt16(11), out short_val); 
 

範例程式 :  

WP-8x47 Demo 目錄:   

1. 讀/寫 類比 I/O: \isagraf_winpac_demo\CSharp.net_2008_demo\wp_CSharp02 

2. 讀/寫 internal long integer、Timer 及 Real (浮點數) 的值: 

\isagraf_winpac_demo\CSharp.net_2008_demo\wp_CSharp03  
 

注意: ISaGRAF 專案中，long integer、timer 及 real 變數必需佔用 2 個網路位址編號。  

(參閱 “ISaGRAF 進階使用手冊” - 4.2 節: http://www.icpdas.com/en/download/show.php?num=333) 

 
 

http://www.icpdas.com/en/download/show.php?num=333
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第 11 章  更多實用的功能 

本章節將介紹更多陸續新增且適用於 ISaGRAF WinCE PAC 的實用功能，您可在 “產品問答 (FAQ)” 中

了解實際的用法。 

 
 

11.1 FAQ-167: 在 ISaGRAF WinCE PAC 內開發屬於自己的 C-function 與 

C-function Block 

FAQ-167 提供了範例程式，教導使用者如何開發自訂的 C-function 與 C-function Block。 

詳情請參考 ISaGRAF FAQ: https://www.icpdas.com/en/faq/index.php?kind=280#751 > FAQ-167  

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

https://www.icpdas.com/en/faq/index.php?kind=280#751
http://www.icpdas.com/web/product/download/software/development_tool/isagraf/document/faq/faq167_chinese.pdf
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11.2 FAQ-166: ISaGRAF WinCE PAC 排程控制 (Schedule Control) 

 ISaGRAF WinCE 系列 PAC，支援排程控制功能 (Schedule Control)，只要經過幾個簡單的步驟就 

可以達成一般日、周末日、特別假日、補班，及四季區分… 等複雜的排程控制需求。 
 

 一台 ISaGRAF WinCE 系列 PAC 可控制最多 10 個控制設備 (Target) 的排程 (Schedule)。每個控制

設備 (Target) 可控制 1 個布林 (Boolean)、1 個整數 (Integer)、1 個實數 (Real) 共三個變數。 
 

 請參考 ISaGRAF FAQ: https://www.icpdas.com/en/faq/index.php?kind=280#751 > FAQ-166 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

https://www.icpdas.com/en/faq/index.php?kind=280#751
http://www.icpdas.com/web/product/download/software/development_tool/isagraf/document/faq/faq166_chinese.pdf
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附錄 A 硬體系統與設定 

A.1 使用正確的電源供應器 

請使用供電為 +10V ~ +30V 之間的直流電源供應器 (大於 25W 更佳) 。 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

選購指南:  

電源供應器 (Power Supply):  

http://www.icpdas.com/en/product/guide+Accessories+Power__Supplies+Power__Supply 

 DP-660:  24V/2.5A ，5V/0.5A 電源供應器 (DIN-Rail mounting) 

 DP-1200: 24V/5A 電源供應器 

 

工業型乙太網路轉換器 (Ethernet Switch):  
http://www.icpdas.com/root/product/solutions/industrial_ethernet_switch/switch_selection.html 

 NS-205: 10/100M，5 埠 

 NS-208: 10/100M，8 埠 

 
http://www.icpdas.com/en/product/guide+Industrial__Communication+Ethernet__Communication+Eth
ernet__Switch#787  

 RS-405: 10/100M，5 埠，環狀式 (Ring Switch) 

 RS-408: 10/100M，8 埠，環狀式 (Ring Switch) 

 
 

http://www.icpdas.com/en/product/guide+Accessories+Power__Supplies+Power__Supply
http://www.icpdas.com/root/product/solutions/industrial_ethernet_switch/switch_selection.html
http://www.icpdas.com/en/product/guide+Industrial__Communication+Ethernet__Communication+Ethernet__Switch#787
http://www.icpdas.com/en/product/guide+Industrial__Communication+Ethernet__Communication+Ethernet__Switch#787
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A.2 修改 NET-ID 與 Modbus RTU 連接埠的設定 

使用者可以自行設定 WP-8x47 的 Net-ID (Slave 站號) 為 1 ~ 255 之間。 

 

出貨時預設的 Modbus RTU Slave 埠為 “None”，使用者請依實際應用自行設定需要的埠號。 

(請參考附錄 G 與 E，有更多 Modbus RTU 埠號說明) 。 

 

每次修改設定後，都必需重新啟動 WP-8x47 PAC 讓新的設定生效。 
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A.3 設定 WP-8x47 的 IP 位址 

請執行 WinPAC 上的 [Start] > [Setting] > [Control Panel]，並點選 “Network and Dial-up Connections”，

再一一點選 “LAN1” 與 “LAN2”，設定 WinPAC 的 IP 位址 與 與子網路遮罩 (Subnet Mask) 。 

 

註: ISaGRAF 的應用必需永遠設定為固定 IP，不可使用 DHCP。 

 
 
 
 
 
 
 
 
 
 
 
 

 
 
 

接著，執行 [Start] > [Programs] > [WinPAC Utility]，點選 “Save and Reboot” 以儲存設定。 
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A.4 連接 PC 到 WP-8x47 的乙太網路埠 

使用 Ethernet 埠下載 ISaGRAF 專案到 PAC 之前，必需先設定好 PC 與 WP-8x47 的通訊參數。 

 

WP-8x47 端:   

設定 IP，Mask 與 Gateway 位址。(請參考 “附錄 A.3:  設定 WP-8x47 的 IP 位址”) 

 

PC 端:   

開啟要下載到 WP-8x47 的 ISaGRAF 專案 (此例為 Test)，並點選 "Link Setup" 按鈕。 

 
 
 
 

 
 
 

 
 
 

在 "PC-PLC Link Parameters" 視窗，選擇 "Ethernet" 為通訊埠，並點選 "Setup" 按鈕。 

 
 
 
 
 
 
 
 
 
 
 
 

在 "Ethernet Link Parameters" 視窗，輸入 WP-8x47 的 IP 位址並設定 "Port Number" 為 "502"。 

 
 
 

 
 
 
 
 
 
 
 

輸入完成，點選 "OK" 按鈕，現在 PC 與 WP-8x47 的通訊設定已完成了。    
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A.5 多重連線 與 COM1/COM2/COM3/COM4 的接腳圖  

WP-8x47 的 2 個乙太網路埠都支援 Modbus TCP/IP Slave 通訊協定，來連接 ISaGRAF 及 PC/HMI。 

LAN1 與 LAN2 最多可支援 32 個連線。TCP Port 編號固定是 502。 

 

WP-8xx7 若使用 1 個連線來連接每台 PC/HMI，最多可連接 32 台 PC/HMI; 若使用 2 個連線來連接 

每台 PC/HMI，則最多可連接 16 台 PC/HMI。其他的 PC / HMI 可以連接到 COM1 (RS-232)、COM2 

(RS-485)/COM3 (RS-232/485) 選一 或 COM4 (RS-232) 。(見附錄 G 與 E  Modbus RTU Slave) 。 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

工業型乙太網路轉換器 (Ethernet Switch):  

http://www.icpdas.com/root/product/solutions/industrial_ethernet_switch/switch_selection.html 

 NS-205: 10/100M，5 埠 

 NS-208: 10/100M，8 埠 

 
http://www.icpdas.com/en/product/guide+Industrial__Communication+Ethernet__Communication+Eth
ernet__Switch#787  

 RS-405: 10/100M，5 埠，環狀式 (Ring Switch) 

 RS-408: 10/100M，8 埠，環狀式 (Ring Switch) 

 
 
 
 
 
 
 
 
 

http://www.icpdas.com/root/product/solutions/industrial_ethernet_switch/switch_selection.html
http://www.icpdas.com/en/product/guide+Industrial__Communication+Ethernet__Communication+Ethernet__Switch#787
http://www.icpdas.com/en/product/guide+Industrial__Communication+Ethernet__Communication+Ethernet__Switch#787
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接腳圖 - COM1、COM2、OM3 與 COM4: 

 
WP-8447/8847 

COM1: RS-232 COM2: RS-485 COM3: RS-232/485 COM4: RS-232 

 

 

 
 

  

 
 
WP-8147 

COM1: RS-232 COM2: RS-485 
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A.6 連接 PC 到 WP-8x47 的 COM2 或 COM3 

Modbus RTU Slave port 的預設值是 “None”，使用者可更改為 “COM2: RS-485” 或 “COM3: RS-232/485” 

或 “None” (請參考附錄 “A.2: 修改 NET-ID 與 Modbus RTU 連接埠的設定”，及 附錄 G/E 取得更多

Modbus RTU port 的資料) 。預設的通訊參數是 “19200,8,N,1”。 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

要連接 PC 到 WinPAC 的 COM2 或 COM3 的 RS-485，必需使用一台 I-7520 (RS-232/485 轉換器) 。 

 
 
 
 
 
 
 
 
 
 
 
 

為了使 ISaGRAF Workbench RS-232 通訊正常，只使用 RXD，TXD 與 GND 訊號線。若您 PC 上運行的

硬體設備或軟體程式是使用 CTS 與 DSR 訊號線，請將 RTS-CTS 與 DTR-DSR 訊號線連在一起。 

 
 
 
 
 
 
 
 
 
 
 
 

 

WinPAC (RS-232) 

COM3: RS-232/485 

 
 

WinPAC 

COM2: RS-485 

 
 

COM2 

PC 

9-Pin D-Sub: RS-232 

 

 
RxD 2 
TxD 3 
GND 5 

 
 

 

PC 

9-Pin D-Sub: RS-232 

 

2 RxD 
3 TxD  
5 GND  
 

 

I-7520/7520R 

RS-232 to RS-485 
Converter 

D+ 
D- 

 

WinPAC (RS-485) 

COM2: RS-485 
COM3: RS-232/485 

D+ 
D- 

 

WinPAC (RS-232) 

COM1: RS-232 
COM3: RS-232/485 

RxD 2 
TxD 3 
GND 5 

 

WinPAC 

COM4: RS-232 

RxD 2 
TxD 3 
GND 5 

 

PC/HMI 

9-Pin D-Sub  

RxD 2 
TxD 3 
GND 5 
DTR 4 
DSR 6 
RTS 7 
CTS 8 

 

PC/HMI 

9-Pin D-Sub  

RxD 2 
TxD 3 
GND 5 
DTR 4 
DSR 6 
RTS 7 
CTS 8 

 



快速上手手冊: WP-8147/8447/8847, 2020 年 10 月, 2.0 版                       Ap-8 

A.7 從 WP-8x47 刪除 ISaGRAF 專案 

使用者可能因為某些情況需刪除 WP-8x47  PAC 裡的 ISaGRAF 專案，方法如下。 

 

點選 “Setting” 頁籤後，按下 “Current Application” 的 “Delete” 按鈕即可。 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

若發生軟體毀損導致而 WinCE 停滯或當機時，可使用以下方式刪除 PAC 的 ISaGRAF 程式: 

 

1. 請將 PAC 前面板的旋轉開關切換到位置 1 (安全模式)，然後再次啟動 PAC。 

2. PAC 會以安全模式開啟，接著螢幕跳出一個視窗詢問 “... reboot right now ...”，請回答 “No”。 

3. 滑鼠雙擊 WinCE 桌面的 “My Device”，並點選至目錄 “\System_Disk\isagraf\”，刪除 “ISA11”。 
 

“ISA11” 是 ISaGRAF 目前正在執行的應用程式。若您在\System_Disk\isagraf\ 目錄裡找不到 

“ISA11”，請到 [Explorer] > [View] > [Options] 修改設定。 

 

4. 再將旋轉開關切回到位置 0 (一般模式)，重新啟動 PAC。 

 

之後， ISaGRAF 連線到 PAC 時 (參考 4.3 節)，ISaGRAF 視窗會顯示 “No Application”。 
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A.8 連接 I-7000 和 I-87K 遠程 I/O 模組 

WP-8x47 PAC 系統可使用 COM2 或 COM3 (RS-485) 其中之一來連接泓格科技的 I-7000 與 I-87K 遠程

I/O 模組，這對於需要在整個系統中佈屬分散式遠程 I/O 的應用來說，是非常好用的配置方式。 

 

一台 WP-8x47 最多可連接 255 台 I-7000/I-87K 遠程 I/O 模組 (建議不超過 40 台 I-7000 或 I-87K) 。每

一台 I-7000 與 I-87K 遠程模組必需設定唯一的位址，且與 PAC 相同的 Baud rate 設定。 

 

有關 I-7000 / I-87K 遠程模組詳細的設定與程式資料，請參考 “ISaGRAF 進階使用手冊” 第 6 章 -  

"連接 I-7000 和 I-87K 遠程 I/O 模組"。 
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A.9 連接 HMI 人機介面設備 

WP-8x47 的 COM2 (RS-485) 或 COM3 (RS-232/RS-485) 其中一個埠 (或最多 COM1、4 與 5 ~ 8 中的 

4 個埠，請參考 附錄 G 與 附錄 E) 可以連接人機介面 (HMI) 設備，例如: 觸控螢幕。 

 

請先參考附錄 A.2，選用 Modbus RTU Slave 埠。泓格科技提供全系列的觸控螢幕顯示器，例如: 

"Touch" 系列螢幕，包括 Touch 500、Touch 8000、Touch 6000 等系列螢幕。 

 

詳細使用說明請參考:  

1. ISaGRAF 進階使用手冊 - 第 4.4 節  

http://www.icpdas.com/en/download/show.php?num=333   

2. 觸控螢幕使用手冊 

http://www.icpdas.com/en/download/show.php?num=432   
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

註: Touch 500 系列產品已停產，請參訪網站取得新產品資訊。 

觸控螢幕系列 : http://www.icpdas.com/en/product/guide+Panel__Products+Display+Touch__Monitor  

 
 
 
 
 
 
 
 
 
 
 

http://www.icpdas.com/en/download/show.php?num=333
http://www.icpdas.com/en/download/show.php?num=432
http://www.icpdas.com/en/product/guide+Panel__Products+Display+Touch__Monitor


快速上手手冊: WP-8147/8447/8847, 2020 年 10 月, 2.0 版                       Ap-11 

A.10 連接其他 Modbus 設備 

WP-8x47 的 COM2 (RS-485) 或 COM3 (RS-232/485) (或 COM1，4，COM5 到 COM14，請參考附錄 E)  

支持 Modbus Master 通訊協議，請參考 “ISaGRAF 進階使用手冊” 第 8 章取得詳細說明。 

 
RS-232: 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
RS-485: 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Modbus 設備 WP-8xx7 

RS-232 

RXD  

TXD  

GND  

CTS  

RTS  

COM1, 3 

TXD 2 

RXD 3 

GND 5 

Modbus 設備 WP-8xx7 Modbus 設備 

RS-485 

  485 +  

  485 -  

COM2 或 COM3 

       D + 

       D - 

 

RS-485 

  485 +  

  485 -  
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A.11 控制 LED 指示燈 

WP-8x47 面板上有一個可程式 LED 指示燈 (標示 “RUN”)，您可在 ISaGRAF 軟體中，使用  

“I/O Connection” 內的 “show3led” I/O 功能來控制 LED 燈號:  

 

1. 滑鼠點選 “I/O Connection” 開啟該視窗。 

 
 
 
 
 
 
 
 
 

2. 於 “ I/O Connection” 視窗，滑鼠雙擊任何大於 (或等於) 編號 9 的插槽，並選取 “show3led”  

功能，最後再點選 “Save”。 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

重要注意:   

插槽 1 ~ 8 是留給實體 I/O 卡使用，請設定於插槽 9 (或之後) 的插槽。 

 

3. 請參考第 4.2、4.3 章節來編譯程式，

並將其下載至 PAC 中。 

 

4. 下載完成後，請開啟   

“I/O Connection” 視窗。 

 

您可變更 I/O 的狀態 (FALSE/TRUE) 

並觀察 PAC 面板上 LED 燈號的變化。 

 
 

LED (RUN) 

1. 

2. 

3. 
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附錄 B 更新 ISaGRAF WinPAC 驅動程式 

注意: 

購買 WP-8x47 時，ISaGRAF 驅動程式已安裝在出貨的 PAC 中，無需自行安裝。若需要新版本的驅動

程式時，可依照以下步驟來安裝。 

 

請參訪網站下載最新版的 ISaGRAF 驅動程式: 

https://www.icpdas.com/en/download/show.php?num=368 
 

1. 開啟 ISaGRAF Driver 視窗，並點選 “End Driver” 按鈕來停止運行。 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

2. 設定 WinPAC 的 IP、Mask、FTP 目錄 與 自動執行功能。 

 

A. 在 WinPAC  “\System_Disk” 目錄下，建立一個 “isagraf” 資料夾 (即，\System_Disk\isagraf\) 

 

B. 執行 WinPAC  的 [Start] > [Setting] > [Control Panel]，並滑鼠雙擊 “Network and Dial-up 

Connections”，再各自點選 “LAN1” 與 “LAN2”，一一設定 WinPAC 的 IP 位址，子網路遮罩。 

 

(ISaGRAF 應用請務必使用固定 IP，不可使用 DHCP) 

 
 
 
 
 
 
 
 
 
 
 
 

https://www.icpdas.com/en/download/show.php?num=368
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C. 執行 PAC 桌面上的 WinPAC Utility，在 FTP Setting 頁籤，將三個 FTP 選項都設為 “Enable” 並 

將 FTP 目錄設定為 “\” (根目錄)，並點選 “Setting” 按鈕。 

 
 
  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

D. 在 “Auto Execution” 頁籤，點選 “Browse” 按鈕 選擇檔案的路徑 或 直接輸入 

“\System_Disk\isagraf\isaWinPAC.exe”，並點選 “Setting” 按鈕。 
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E. 設定完成後，必需點選 [File] > [Save and Reboot] 重新啟動。 

 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

3. WinPAC 重新啟動後，請再次停止 ISaGRAF 驅動程式。 

注意: 當 ISaGRAF Driver 執行中，是無法更新檔案的，即使您已完成了更新的程序。 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

4. 接著，需將 PC 上的 WP-8x47 Driver 檔案，下載到 WinPAC 的 “\System_Disk\isagraf\” 目錄中: 

(以下為 1.16 版，請注意不同版本的 ISaGRAF Driver 所包含的檔案可能會有差異。) 

 

isaWinPAC.exe、rs_wphmi.exe 

mscorlib.dll、QuickerNet.dll、 Quicker.dll、login.dll、main.dll、whmi_filter.dll 

isaWinPAC.lnk、isa_el.dll  與 sharedmemory.dll 

 

若您的是 WP-8xx1/8xx9 (沒有預裝 ISaGRAF 的 WinPAC)，還需下載 “license.bin” 檔案。 

 
 



快速上手手冊: WP-8147/8447/8847, 2020 年 10 月, 2.0 版                       Ap-16 

您可在 PC 上使用的 FTP 的方式，來下載這些檔案 : 

 

請開啟網頁瀏覽器，輸入網址 ftp://<IP address>，例如: ftp://192.168.1.178，再將複製的 WP-8x47 

Driver 檔案放入 \System_Disk\isagraf\ 目錄即可。接著，需重新啟動 WinPAC。 

 

開機後，會自動運行新的 ISaGRAF Driver，您可開啟視窗來確認版本號。 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

ftp://192.168.1.178/
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附錄 C 機構圖 

單位: mm 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

WP-8147 

左視圖 前視圖 右視圖 

後視圖 底視圖 上視圖 
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WP-8447 

後視圖 

底視圖 

上視圖 

左視圖 

右視圖 
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WP-8847 

後視圖 

底視圖 

上視圖 

左視圖 

右視圖 
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附錄 D 如何啟動/停止 WP-8x47 的 LAN2 

重要:   

1. 建議使用工業型乙太網轉換器，例如: NS-205/208 或 RS-405/408 (Ring Switch) 。 

2. ISaGRAF 應用時，LAN1 請務必使用固定 IP (若啟動 LAN2 也請使用固定 IP) 。 

 
 

WP-8x47 的 LAN2 Port 預設狀態為 “關閉” (Disable)，使用 LAN2 前需先設為 “啟用” 。 

 

在 PAC 點選 [Start] > [Setting] > [Control Panel]，並滑鼠雙擊 “Network and Dual-up Connections” 圖示 

，滑鼠右鍵點選 LAN2 並設定為 “Enable” (或設為關閉 “Disable”) 。 

 

再點選 [Start] > [Programs] > [WinPAC Utility]，選擇 “Save and Reboot” 儲存設定值並重新啟動。 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

ISaGRAF 的 Ebus 或 備援系統應用，必需使用 WP-8x47 的 LAN2； 而  “以 UDP 或 TCP 傳送訊息” 的 

應用，也可使用 LAN2。 

 

請參考 ISaGRAF 進階使用手冊，取得下列資訊: 

7.5: 編寫 Ebus 資料交換程式 

19.2: 使用 UDP 來傳遞或接收訊息到 PC/HMI 或 設備 

19.3: 使用 TCP/IP Client 功能來傳送/接收/主動回報訊息 

20.2: WP-8xx7 備援系統 

 
 
 
 
 

滑鼠右鍵 

http://www.icpdas.com/web/product/download/software/development_tool/isagraf/document/manual/isagraf_user_manual_tc.pdf
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附錄 E 使用 RS-232/485/422 擴充卡 

客戶可以在 WinPAC 插槽上 (0 ~ 7)，使用下列模組來擴充 16 個以上的 COM 埠。 

 

I-8112iW: 2 埠 隔離式 RS-232 模組 

I-8114iW: 4 埠 隔離式 RS-232 模組 

I-8114W: 4 埠 無隔離式 RS-232 模組 

I-8142iW: 2 埠 隔離式 RS-422/RS-485 模組 

I-8144iW: 4 埠 隔離式 RS-422/RS-485 模組 

 

使用以上模組前，需先以 “WinPAC Utility” 進行設定 (自 2.0.0.6 版起) 。請將模組插入 WinPAC 的 

插槽 0 ~ 7 槽 (最好是 0 ~ 3 槽) 。 

 

1. 執行 WinPAC Utility  並點選 “Multi-serial port wizard” 頁籤。 

2. 在 ISaGRAF 應用中，請確認 “Use MSA/MSBx” 已選取。 

3. 按下 “Slot scan” 按鈕，會自動搜尋插槽上的多序列埠模組，型號會顯示在左欄， 

COM 埠的原始設定會顯示在右欄。 

4. 按下 “Set” 按鈕，會將目前找到的模組顯示在右欄。 

5. 執行 [File] > [Save and Reboot]  會儲存設定 並 重新啟動 WinPAC。 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

5. 
 

1. 
 

2. 
 

3. 
 

4. 
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設定成功後，ISaGRAF 定義擴充卡的 COM 埠編號是 COM5 到 COM20。 
 

WinPAC 與 ISaGRAF 定義的 COM 對應表: 
 

WinPAC ISaGRAF WinPAC ISaGRAF 

MSA1 COM5 MSB1 COM13 

MSA2 COM6 MSB2 COM14 

MSA3 COM7 MSB3 COM15 

MSA4 COM8 MSB4 COM16 

MSA5 COM9 MSB5 COM17 

MSA6 COM10 MSB6 COM18 

MSA7 COM11 MSB7 COM19 

MSA8 COM12 MSB8 COM20 

 

注意: 

1. 請參考 ISaGRAF 進階使用手冊 - 第 8.4 節 multi-ports Modbus Master 相關資料。 

WP-8x47 最多支援 COM1 ~ 14 間的 10 個 Modbus RTU/ASCII Master 埠。 

2. 請參考 ISaGRAF 進階使用手冊 - 附錄 A.4，來使用 COM_OPEN，COM_READ，…等函式， 

讀/寫 COM 埠的資料。 

3. 請參考本手冊附錄 G，來設定 Modbus RTU Slave 埠。 

 

接腳圖: 

I-8112iW: 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

例如: Slot 0: I-8142iW   與 

 Slot 1: I-8144iW 
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I-8114W / I-8114iW: 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
I-8142iW / I-8144iW: 

RS-485: (D+, D-)   ;    RS-422: (TxD+, TxD-, RxD+, RxD-) 
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附錄 F 減慢 ISaGRAF 驅動程式的速度 

減慢 ISaGRAF 驅動程式的原因是:  

當您同時執行 ISaGRAF 與其他 HMI 軟體 (例如: InduSoft 或 VB.net 程式)，CPU 只有一個，所有在

WinPAC 上執行的程式都共用同一個 CPU，當您覺得 HMI 軟體執行不順暢 或 顯得緩慢，您可以 

使用 ISaGRAF Function – “PLC_Mode( )”，來減緩 ISaGRAF 驅動程式的速度。 

 
PLC_Mode 
 

說明: 

Function 改變 ISaGRAF Driver 的速度。 
 

語法: 

    MODE_      integer 可以是  0、1、2 或 3 
 

0: 快速模式，預設值，最小 PLC scan time 約為 2 ~ 3 ms 

1: 稍慢模式，最小 PLC scan time 約為 6 ~ 7 ms 

2: 較慢模式，最小 PLC scan time 約為 9 ~ 11 ms 

3 或其他值: 最慢模式，最小 PLC scan time 約為 19 ~ 21 ms 
 

回傳: 

    Q_ boolean 固定回傳 True。 
 
 
 

注意: 

1. 系統預設值為 "快速模式"。 

2. 使用者可在第一個 PLC scan 裡呼叫 "PLC_mode( )"，來改變 PLC 的速度。 

3. 減慢 PLC 速度是為了改善，同時執行 ISaGRAF 與 HMI 軟體時的系統效能。 

例如: 當 WinPAC 同時執行 ISaGRAF 與 InduSoft 時，可使用此函式改善效能。 
 

範例 :  
 

  (* TMP 宣告為 Boolean internal 變數 *) 

  (* INIT 宣告為 Boolean internal 變數，初始值為 TRUE *) 

  if  INIT  then 

    INIT  :=  False ;   (* 只在第一個 PLC scan 裡呼叫一次 *) 

    TMP  :=  PLC_mode(2) ;   (* 設定 PLC 速度為 2: 較慢模式 *) 

  end_if ; 
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附錄 G 設定更多 Modbus RTU Salve 埠 

WP-8x47 支援最多 5 個 Modbus RTU Slave 埠: COM2 或 COM3 之一 與 COM1 ~ 8 的其中 4 個埠。 

(請參考附錄 E，了解在插槽 0 ~ 3 使用多埠模組來擴充 COM5 ~ 8 的設定方式) 。 
 

注意: WP-8147 沒有 COM3 和 COM4 (只有 WP-8447/8847 有) 。 

 

1. 您可在 PAC 的桌面上，使用滑鼠設定 COM2 或 COM3 之一當作第一個 Modbus RTU Slave 埠。 

(參考附錄 A.2) 。 

2. 您可從 COM1 ~ COM8 來啟用第 2、3、4 或 5 個 Modbus RTU Slave 埠 (不支援其他 COM 埠) 。 

3. 使用此功能之前，請確定上列 COM 埠確實存在，並已規劃設定完成 (參考附錄 E) 。 

4. 您可使用 ISaGRAF 並透過第 2、3、4 或 5 個啟用的 Modbus RTU Slave 埠，來對 PAC 進行除錯、

設值，但是不能用來停止、下載、更新 ISaGRAF 程式。 
 

但是，您仍可透過 PAC 的 Ethernet 埠 或 第一個啟用的 Modbus RTU Slave 埠  (COM2 或 COM3) 來

除錯、設值、停止、下載或更新 ISaGRAF 程式。 

 

如何設定? 

在 “ISaGRAF I/O connection” 視窗，設定 “rtu_slav” 功能，重新編譯專案並透過 Ethernet 埠 (或第 1

個啟用的 Modbus RTU 埠) 下載到 WinPAC。  

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

RTU_Slave_Port2 to 5:  

指定哪個 COM port 已啟用 (1 ~ 8), 0: 表示不啟用。Baud rate 可以是

600, 1200, 2400, 4800, 9600, 19200, 38400, 57600, 115200。 

4 Boolean input:  

顯示指定的 Port 是否有啟用?  (True: 已啟用 ； False: 未啟用) 

1. 
 

2. 
 

3. 
 

4. 
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附錄 H 不同 ISaGRAF 版本產生的編譯錯誤 

自 2003 年起，網站提供的 ISaGRAF 範例程式都是以 3.46 版 ISaGRAF workbench 撰寫的，如果您的

ISaGRAF workbench 是 3.51 版或更新的版本，當您重新編譯程式時，可能會出現錯誤訊息。 

 

請執行 [Make] > [Touch] 一次，來解決因使用不同  ISaGRAF 版本產生的編譯錯誤，，然後重新編譯

範例程式專案。 

 

[Make] > [Touch] 可將所有已編譯的程式重新設定為 “尚未編譯”。 

 
 
 
 
 
 
 
 
 
 
 
 
 

而 [Make] > [Make application] 則可將全部的程式重新編譯。 
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附錄 I 使用 RS-232 序列/USB 觸控螢幕 

WP-8000 系列 支援 3 種型態的 RS-232 序列 或 USB 觸控螢幕。 
 

  “penmount_serial_touch”、“penmount_usb_touch” 或 penmount 之相容觸控螢幕。 

  “elo_serial_touch”、“elo_usb_touch” 或 elo 之相容觸控螢幕。。 

  “egalax_serial_touch”、“egalax_usb_touch” 或 egalax 之相容觸控螢幕。 

 

I.1 觸控螢幕的驅動程式與安裝注意事項  

WP-8000 系列的觸控螢幕驅動程式，放在 PAC 目錄下:  \System_Disk\external_device_driver\  

此目錄有下列驅動程式，您必需選擇正確的驅動程式來執行!   

 

"_vyyyymmdd"的檔名代表版本號和更新日期。 

 
 
 
 
 
 
 
 
 
 
 

注意: 

1. 為了避免硬體上的衝突，請勿同時安裝 USB 與 RS-232 驅動程式。 

2. 若安裝了錯誤的觸控螢幕驅動程式，請執行解除安裝，並重新安裝。 

(請參考 附錄 I.4 來解除安裝) 

3. WinPAC 安裝觸控螢幕驅動程式後，若畫面不正常顯示 (例如: 太大、太小 或 疊紋…等)， 

請參考 附錄 I.5，來調整螢幕頻率。 

 

附錄 I 中的內容，採用 “TPM-4100” 觸控螢幕為例 : 

10.4" 800 x 600 鋁殼電阻式觸控面板，配有 RS-232、USB 與 電源供應器。  

http://www.icpdas.com/en/product/guide+Panel__Products+Display+Touch__Monitor  
 

您也可在 TPM-4100 的下載區 (http://www.icpdas.com/en/download/index.php?model=TPM-4100)  

下載驅動程式 (.cab)，並以 FTP 方式複製檔案到 PAC 目錄下 (\System_Disk\external_device_driver\) 。 

 
 
 
 

http://www.icpdas.com/en/product/guide+Panel__Products+Display+Touch__Monitor
http://www.icpdas.com/en/download/index.php?model=TPM-4100
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I.2 使用 USB 觸控螢幕 

 

1. 相互連接觸控螢幕與 PAC 的 USB port，接著啟動 PAC。WP-8x47 只

有 1 個 USB，在設定觸控螢幕的驅動程式時，可交替使用 USB 或

以 VCEP 遠端設定。 

 

2. 安裝 USB 觸控驅動程式: 滑鼠雙擊 PAC 目錄下 \System_Disk\external_device_driver\ 正確的 

觸控驅動程式，此例，TPM-4100 Driver 是 “PenMount_USB_TOUCH_Vyyyymmdd.CAB”。  

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

3. 螢幕校正: 點選 [開始] >  [Programs] > [USB_TOUCH] > [PenMount] > [Calibration] 呼叫螢幕觸控 

校正功能，依序觸碰螢幕上出現的指標來校正螢幕。接著，同步驟 2，執行 WinPAC Utility 的  

“Save and Reboot”。 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

點選 “OK” 進行安裝。 

滑鼠雙擊 PAC 桌面的  “WinPAC Utility”，並

選擇 “File” > “Save and Reboot” 儲存設定，

並重開機。 

1. 

2. 

3. 

http://www.icpdas.com/products/PAC/winpac/download/winpac_8000/download_utility.htm
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I.3 使用 RS-232 觸控螢幕的步驟 

1. 連接觸控螢幕的 RS-232訊號線到 WP-8x47 的 COM4 (參考 附錄 

A.5 的 COM4 接腳圖)，並在 WP-8x47 裝上 USB 滑鼠 (用來設定

觸控螢幕的驅動程式)，接著啟動 WinPAC。 

 
 

2. 安裝串列觸控驅動程式: 滑鼠雙擊 PAC 目錄下 \System_Disk\external_device_driver\ 正確的觸控

驅動程式。此例，TPM-4100 Driver 是 “PenMount_Serial_TOUCH_Vyyyymmdd(PM6000R).CAB”。 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

3. 螢幕校正: 點選 [開始] >  [Programs] > [USB_TOUCH] > [PenMount] > [Calibration]，並依序觸碰 

螢幕上出現的指標來校正螢幕，並在 WinPAC Utility 執行 “Save and Reboot” (同步驟 2) 。 
 

4. 設定 COM Port: 點選  [開始] >  [Programs] > [Serial_TOUCH] > [PenMount] > [SetCOM]，此例 請設

定 COM Port 為 4，並在 WinPAC Utility 執行 “Save and Reboot”。 

 
 
 
 
 
 
 
 
 
 
 
 
 
 

COM4 

USB 

點選 “OK” 進行安裝。 

滑鼠雙擊 PAC 桌面的  “WinPAC Utility”，並

選擇 “File” > “Save and Reboot” 儲存設定，

並重開機。 

1. 

2. 

3. 



快速上手手冊: WP-8147/8447/8847, 2020 年 10 月, 2.0 版                       Ap-30 

I.4 移除觸控螢幕的驅動程式 

使用者可能因為安裝了錯誤的驅動程式，或需更換螢幕而想要移除目前的驅動程式。請依照下列 

步驟來完成此程序。 

 

1. 開始功能表  [Start] > [Programs] > [USB_TOUCH  或  Serial_TOUCH] > [PenMount] > [Uninstall] 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

2. 確認移除: 在出現的視窗中，點選 “Yes” 按鈕確認解除安裝程式。 

 
 
 
 
 
 
 
 

3. 重新啟動 WinPAC PAC :  

一旦完成移除驅動程式，會出現下列視窗，點選 “Yes”，即可自動重新啟動 PAC 。 

 
 
 
 
 
 
 
 
 
 
 

( USB_TOUCH ) 
 

( Serial_TOUCH ) 
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I.5 調整 WinPAC 的螢幕顯示頻率 

WinPAC 出廠預設的螢幕設定，可能無法支援所有的顯示螢幕，若出現顯示問題，請參考本附錄 

調整螢幕顯示，來解決下列顯示問題: 

1. 疊紋 (Moire) 

2. 無顯示 

3. 不正常顯示 (太大、太小或單向超出) 

 

WinPAC 自下列版本起支援調整螢幕顯示頻率的功能: 

PAC 平台 OS 版本 WinPAC Utility 版本 

WP-8x47 V1.6.1.1 版本起 V2.0.2.7 版本起 
 

注意:   

某些頻率可能導致螢幕無法顯示。因此，調整頻率前請先在 WinPAC-Utility 的 “Auto Execution”  

頁面加入 VCEP 路徑，以便仍可使用 PC 遠端操作 WinPAC。(參考 WinCE5.0 PAC FAQ - w2-001)      

 

您可先按下顯示器的自動調整 (Auto) 按鈕。若自動調整按扭無法解決問題，請依照下列步驟 

調整 WinPAC 的螢幕顯示頻率。 

 

1. 執行 WinPAC 桌面的 WinPAC_Utility，並點選 System Settings 頁面。 

2. 在 Frequency 欄位，更換其他頻率，並點選 “Setting”。 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

3. 點選  [File] > [Save and reboot] 儲存並重啟 WinPAC。 

 

若設定的頻率顯示仍不適用，請重複步驟 1 ~ 3 重新選擇 

適當的頻率。 

 
 

https://www.icpdas.com/en/faq/index.php?type=&model=&fkw=vcep#899
http://www.icpdas.com/web/product/download/pac/wince/document/faq/ce5/how_to_use_vcep_to_remotely_control_wince_pac_en.pdf
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附錄 J 為何執行 ISaGRAF 的 PC 無法正確連接 ISaGRAF PAC? 

本文件也可在 ISaGRAF FAQ 網頁下載:  

https://www.icpdas.com/en/faq/index.php?kind=280#751 > FAQ-104. 
 

使用 PC/ISaGRAF 的 Debug  功能連線到 ISaGRAF PAC 時，有時會出現下列彈跳視窗的訊息:   

“Can not link ...” 或 “Can not download” 或 “Can not find BMP ...” 或 ... 。 
 

解決的步驟如下: 
 

1. 關閉所有 ISaGRAF 視窗，接著按下 “Ctrl” + “Alt” + “Delete” 鍵來開啟 “工作管理員”。 

2. 在 “處理程序” 頁面，停止記憶體為空白的處理程序，再執行 ISaGRAF (PC) 來連接 PAC。  

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

3. 若仍有問題，而您是使用 Ethernet 來連接 PAC，請檢查 PC 與 PAC 是否設定相同的 IP 網域。 

例如，PC (IP/Mask) = (192.168.1.2/255.255.255.0) 無法連上 PAC = (192.168.3.5/255.255.255.0) 。 

但若 PAC = (192.168.1.5，255.255.255.0) 則可正常連接。 

 

4. 若仍有問題，而您是使用 RS-232 來連接 PAC，請檢查 RS-232 線的連接是否正確?  

PC 連接到 PAC 的 RS-232 埠號是否設定正確? 

 

5. 最後的方法就是，重新開啟您的 PC 再試一次。 

 

 

停止記憶體為空白的程序。 

https://www.icpdas.com/en/faq/index.php?kind=280#751
http://www.icpdas.com/web/product/download/software/development_tool/isagraf/document/faq/faq104_chinese.pdf
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附錄 K 啟動 WinPAC 螢幕保護功能 

請依下列步驟，來啟動 WP-8x47 的螢幕保護功能。 

 

1. 點選 [Start] > [Settings] > [Control Panel]，再滑鼠雙擊 Power 圖示。 

2. 在 Schemes 頁面，設定 “Power Scheme” 為 AC power 並將 “…User Ide” 與 “…System Ide” 都設為 

相同的值 (或設定 “System Idle” 大於 “User Idle” 的值) 。 

3. 執行 WinPAC Utility，點選 [File] > [Save and Reboot] 來儲存設定並重新開機。 

 

若 WP-8x47 在指定的時間範圍內沒有任何操作，將會關閉背光並啟定螢幕保護功能。若有觸碰 

螢幕或按鍵，將會開啟背光。 

 
 
 
 
  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

若不想使用螢幕保護功能，請將  “…User Ide” 與 “…System Ide” 設定為 “Never”，並在 WinPAC Utility 

執行 “Save and Reboot”。 

 
 
 
 
 

3. 
 

1. 
 

2. 
 

4. 
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附錄 L 如何偵測雙電池電力狀況與 Ethernet Port 狀態 

注意 : 更換電池前請先關閉 PAC 的電源，以免電池誤觸其他電子零件而造成損毀。 

 

WinPAC 配備有雙電池備援的 512 KB 記憶體，電力中斷時仍可持續保存重要資料。雙電池設計 

可在更換其中一顆電池時，另一電池仍持續供電。 

 

警告: 請勿將兩顆電池同時取下更換，以免造成數據遺失。 
 

名稱 變數型態 屬性 ADR 說  明 

batery1 Integer Internal 9992 偵測電池 1 的電力狀態 

batery2 Integer Internal 9993 偵測電池 2 的電力狀態 

lan1 Binary Internal 9987 偵測 LAN1 的斷線狀態 

Lan2 Binary Internal 9986 偵測 LAN2 的斷線狀態 

 

 在 R_MB_ADR 函式，填入 ADR 編號 9992 或 9993 來讀取電池的電力狀況。 

ADR 編號 9992 與 9993，表示電池 1 與 電池 2 的狀態。  

 

 在 R_MB_ADR 函式，填入 ADR 編號 9987 或 9986 來讀取 Ethernet Port 狀態。 

ADR 編號 9987 與 9986，表示 LAN1 與 LAN2 的狀態。 1: ok ; 0: 斷線。 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

執行程式後的回傳值: 

"99": 表示電力正常，暫時不需要更換電池。  

"0": 表示低電位狀態或電力已耗盡， 

 請盡快更換電池。 

執行程式後的回傳值: 

"1": 表示 Ethernet port 連線正常。 

"0": 表示 Ethernet port 斷線狀態。 


	快速上手手冊: WP-8147/8447/8847
	重要說明
	免責聲明
	商標 與 著作權
	開發軟體
	技術支援
	改版紀錄

	目         錄
	參  考  資  料
	I/O 模組選型
	規格: WP-8147/8447/8847
	第 1 章 典型的工程應用
	1.1 通訊備援 (冗餘) 系統 – 中央與地區控制站
	1.2 備援 (冗餘) 系統 - 搭配 Ethernet I/O
	1.3 備援 (冗餘) 系統 – 搭配 RS-485 I/O
	1.4 Modbus Master: RTU, ASCII, RS-232/485/422
	1.5 Modbus Master: TCP/IP
	1.6 Modbus Slave: RTU/TCP
	1.7 與其他 TCP/IP Server 或 UDP Client/Server 設備通訊
	1.8 多重網路人機介面 (Web HMI) – 隨處監控!
	1.9 傳送攜帶附件檔案的 Email
	1.10 資料記錄器
	1.11 遠程 I/O 應用
	1.12 SMS: 簡訊服務
	1.13 當成遠程 I/O 模組的 Modbus 轉換器
	1.14 運動控制
	1.15 建物應力量測應用
	1.16 快速 FRnet 遠程 I/O
	1.17 整合 CAN/CANopen 設備與傳感器
	1.18 VIP 通訊安全
	1.19 ISaGRAF PAC 連接智能電表
	1.20 ZigBee 無線通訊應用
	1.21 GPS 應用: ISaGRAF PAC 加上 I-87211W 或 GPS-721
	1.22 透過 Ebus 交換資料
	1.23 偵測 I-87K 高卡 I/O 之熱插拔 (Hot-Swap) 狀況
	1.24 資料庫應用
	1.25 HART 解決方案
	1.26 3G/4G 無線傳輸應用
	1.27 連接 DL-100TM485 測量濕度與溫度值

	第 2 章 軟體安裝
	2.1 步驟 1 – 安裝 ISaGRAF
	2.1.1 保護鎖注意事項:
	2.1.2 Window 2000 使用者的注意事項:
	2.1.3 Windows NT使用者的注意事項:
	2.1.4 Windows Vista 或 Windows 7 (32-bit) 使用者的注意事項:
	2.1.5 Windows (64-bit) 使用者的注意事項:
	2.1.6 使用變數陣列 (Variable Arrays) 的注意事項:

	2.2 步驟 2 – 安裝 ICP DAS Utilities For ISaGRAF

	第 3 章 安裝 Web HMI 範例程式
	3.1 Web HMI 範例程式列表
	3.2 安裝 Web HMI 範例程式的步驟
	3.2.1 步驟 1 – 硬體安裝
	3.2.2 步驟 2 – 設定網路選項
	3.2.3 步驟 3 – 下載 ISaGRAF 專案
	3.2.4 步驟4 – 下載網頁到 WinPAC
	3.2.5 步驟 5 – 展示Web HMI


	第 4 章 建立 Web HMI 範例
	4.1 撰寫一個簡單的 ISaGRAF 程式
	4.1.1 啟動 ISaGRAF－專案管理
	4.1.2 建立 ISaGRAF 使用者群組
	4.1.3 建立新的 ISaGRAF 專案
	4.1.4 宣告 ISaGRAF 專案變數
	4.1.5 指定變數的 Modbus 網路位址
	4.1.6 建立 LD 程式 - "LD1"
	4.1.7 編輯 "LD1" 程式
	4.1.8 連接 I/O

	4.2 編譯及模擬程式
	4.3 下載與執行專案
	4.4 設計網頁
	4.4.1 步驟1 – 複製 Web HMI 範例頁面
	4.4.2 步驟2 – 建立Main.htm
	4.4.3 步驟3 – 加入Main.htm 的控制碼
	4.4.4 步驟4 – 下載 Web HMI 頁面到 PAC


	第 5 章 Web HMI 設計基礎
	5.1 Web HMI  的基本檔案
	5.2 Login.htm
	5.3 Menu.htm
	5.4 Main.htm
	5.4.1 一個簡單的 Main.htm 範例
	5.4.2 更多關於 refresh_data( ) 功能與動態資料
	5.4.2.1 顯示動態 Boolean 資料
	5.4.2.2 顯示動態 Float、Word、Timer 資料
	5.4.2.3 顯示動態 Long Integer 資料
	5.4.2.4 顯示動態 String 資料
	5.4.2.5 觸發 Boolean 物件的閃爍動作
	5.4.2.6 Float 值以固定的小數位數顯示

	5.4.3 發送資料到 PAC
	5.4.3.1 發送 Boolean 值到 PAC
	5.4.3.2 發送 Word、Long、Float、Timer 及 String 的值到 PAC


	5.5 多重頁面 (multi-pages)
	5.5.1 Level2 與 Level3 頁面
	5.5.2 切換頁面

	5.6 網路安全防護

	第 6 章 使用 VB.net 2008 程式來讀/寫 ISaGRAF 變數
	6.1 建立新專案
	6.2 加入專案參考
	6.3 編譯應用程式
	6.4 QuickerNET.DLL
	6.4.1 數位 (Digital) 讀/寫 函式
	6.4.2 類比 (Analog) 讀/寫 函式


	第 7 章 使用 EVC++ 程式來讀/寫 ISaGRAF 變數
	第 8 章 使用 InduSoft 專案來讀/寫 ISaGRAF 變數
	第 9 章 範例程式 與 FAQ
	9.1 線上支援
	9.2 安裝 ISaGRAF 程式範例
	9.3 FAQ: 常見問題表

	第 10 章 使用 C#.net 2008 程式來讀/寫 ISaGRAF 變數
	10.1 建立新專案
	10.2 加入專案參考
	10.3 編譯應用程式
	10.4 QuickerNET.DLL
	10.4.1 數位 (Digital) 讀/寫函式
	10.4.2 類比 (Analog) 讀/寫函式


	第 11 章  更多實用的功能
	11.1 FAQ-167: 在 ISaGRAF WinCE PAC 內開發屬於自己的 C-function 與 C-function Block
	11.2 FAQ-166: ISaGRAF WinCE PAC 排程控制 (Schedule Control)

	附錄 A 硬體系統與設定
	A.1 使用正確的電源供應器
	A.2 修改 NET-ID 與 Modbus RTU 連接埠的設定
	A.3 設定 WP-8x47 的 IP 位址
	A.4 連接 PC 到 WP-8x47 的乙太網路埠
	A.5 多重連線 與 COM1/COM2/COM3/COM4 的接腳圖
	A.6 連接 PC 到 WP-8x47 的 COM2 或 COM3
	A.7 從 WP-8x47 刪除 ISaGRAF 專案
	A.8 連接 I-7000 和 I-87K 遠程 I/O 模組
	A.9 連接 HMI 人機介面設備
	A.10 連接其他 Modbus 設備
	A.11 控制 LED 指示燈

	附錄 B 更新 ISaGRAF WinPAC 驅動程式
	附錄 C 機構圖
	附錄 D 如何啟動/停止 WP-8x47 的 LAN2
	附錄 E 使用 RS-232/485/422 擴充卡
	附錄 F 減慢 ISaGRAF 驅動程式的速度
	附錄 G 設定更多 Modbus RTU Salve 埠
	附錄 H 不同 ISaGRAF 版本產生的編譯錯誤
	附錄 I 使用 RS-232 序列/USB 觸控螢幕
	I.1 觸控螢幕的驅動程式與安裝注意事項
	I.2 使用 USB 觸控螢幕
	I.3 使用 RS-232 觸控螢幕的步驟
	I.4 移除觸控螢幕的驅動程式
	I.5 調整 WinPAC 的螢幕顯示頻率

	附錄 J 為何執行 ISaGRAF 的 PC 無法正確連接 ISaGRAF PAC?
	附錄 K 啟動 WinPAC 螢幕保護功能
	附錄 L 如何偵測雙電池電力狀況與 Ethernet Port 狀態

